
 

XPS MultiQuant 
for Windows 

Version 7.83 

User’s Manual 



 

 

 



 

XPS MultiQuant 

User’s Manual 

Budapest • 2024 



 

Copyright © 1999-2024 Miklós Mohai 

XPS MultiQuant is copyright by Miklós Mohai. 

Microsoft, MS-DOS, Windows, Windows Vista, Visual Basic and Excel are registered 

trademarks of Microsoft Corporation. 

Origin is registered trademark of OriginLab Corporation. 

Pentium is registered trademark of Intel Corporation. 

QUASES is trademark of QUASES - Tougaard Inc. 

No part of this document may be reproduced or transmitted in any form or by any 

means, electronic or mechanical, for any purpose, without the express written 

permission of the author. 

Revision: 7.83.05  (12-02-24) 

 



3 

Content 

Introduction 6 

Legal Notes 7 

Installing XPS MultiQuant 8 
Uninstalling 8 
Technical Notes 9 

Using of the Program 12 
Starting XPS MultiQuant 12 
Setting Parameters 13 
Entering and Editing Input Data 13 

Calculator in the Input Windows 15 

Template Files 15 
Importing Data 16 

XPS Reduced Data Exchange Files 16 
Converter Programs 16 
Extracting Data from Various File Types 16 

Managing Results and Charts 19 

Saving and Printing 19 
Exporting Results 20 
Application of Structured Models 22 

Intensity Simulation 24 
Inelastic Mean Free Path 25 

Carbonaceous Contamination 26 
Oxygen Balance 27 

Miscellaneous Remarks 28 

Step by Step 31 

Application Examples 39 

Applied Methods 47 
Homogeneous Model 47 

Cross Sections 48 
Angular Correction 49 

Correction for Elastic Scattering 49 
Inelastic Mean Free Path (IMFP) 49 
Transmission Function 52 
Contamination Correction 53 
Multiline Approach 53 
Normalisation of the Composition Results 54 



4 

Models for Structured Surfaces 56 

Layers-on-Plane Model 58 
Layers-on-Sphere Model 59 
Layers-on-Cylinder Model 61 
Layers-on-Polyhedron Model 62 
Layers-on-Nanotube Model 64 

Island Type Models 67 
Oxide-Layer Model 68 

Library Data 70 
Chemical Elements 70 
Photoelectron Lines 70 

Cross Sections and Sensitivity Factors 70 
Average Scale Factors 71 

Asymmetry Parameters 71 

Number of Valence Electrons 72 
Geometry Correction Factors 72 

Tips and Tricks 73 
Transforming Angles 73 

Layers Inside a Tube 74 
Layers on Domes 76 

Testing Layers 77 
Transposing Cells 78 
Exporting Comparison Chart 79 

Relative Path for Transmission Files 79 
Subsequent Calculations 80 

Program References 82 
Menu Commands 82 

File Menu 82 
Edit Menu 84 

View Menu 85 
Tools Menu 86 

Windows Menu 88 
Help Menu 88 
File Menu (Notes window) 89 

Edit Menu (Notes window) 89 
Format Menu (Notes window) 90 

Help Menu (Notes window) 90 
Pop-up Menu (input windows) 91 
Pop-up Menu (result windows) 92 

Pop-up Menu (Chart window) 92 
Pop-up Menu (Model Layout window) 93 

Windows 94 
Elements 94 

Intensity 96 
IMFP & Contamination 97 
Composition 98 
Chart 99 



5 

Model 100 

Model Summary 102 
IMFP & Contamination of Structured Models 102 
Layer Thickness 103 
Layer Calculation 104 
Model Layout 105 

Parameters 107 
Parameter Summary 122 
Polyhedron Editor 123 
Intensity Simulation 124 
Print 125 

Print Options 126 
Split Intensity 127 
Notes 128 

Data Wizard 129 
Open – Save As 130 

Status Bar 130 
Keyboard Commands 131 

Shortcut Keys 131 
Editing Keys 131 

Menu Access Keys 131 
Messages 132 

Error Collections 144 

Pending Errors 144 

Release Notes 145 

Specifications 150 

Literature 151 

Contact 154 

Index 155 



6 

Introduction 

Quantitative evaluation of XP spectra is a major issue in surface characterisation. Numerous 

methods, models and data sets were developed and published but usually only the simplest 

ones are built into the commercial data systems used for the everyday work. The aim of 

developing the XPS MultiQuant program was to give a practical and universal tool to the 

surface chemists for obtaining the correct analytical results in most of the cases. 

The program applies the „classic‟ approach of the quantitative calculations, requiring the input 

of the integrated intensity of the measured XPS lines. All of the usual factors and correction 

methods, including calculated and experimental cross section values from several sources, 

asymmetry parameter, analyser transmission, IMFP, contamination of the adventitious 

carbon, can be applied and controlled independently. The necessary basic data for calculations 

(for elements, XPS lines, etc.) are integrated into the main library. 

Calculation of several samples or experimental data sets (e.g., series of ion bombardments or 

heat treatments, etc.) can be done together. Results can be presented in various forms, like 

atomic %, atomic ratio, oxide molar ratio, etc., and can be printed and charted. 

The sample geometry model can be selected from several options: beside the frequently 

applied „infinitely thick homogeneous sample‟ model other ones for layered structures (both 

on flat and curved surfaces) are also available. 
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Legal Notes 

XPS MultiQuant is Copyright © 1999-2024 by Miklós Mohai. All rights reserved. 

Copyright 

 The software, library, help files, install program and its source code are a property of 

Miklós Mohai. 

Disclaimer of Warranty 

 This software is provided „as is‟. The author makes no representations or warranties, 

express or implied. By way of example, but not limitation, the author makes no 

representations or warranties of merchantability or fitness for any particular 

purpose or that the use of the licensed software components or documentation will 

not infringe any patents, copyrights, trademarks or other rights. The author shall not 

be held liable for any liability nor for any direct, indirect, or consequential damages with 

respect to any claim by the user or distributor of the software or any third party on account 

of or arising from this agreement or the use or distribution of the software.  

Grant of License 
Permission to use, copy, and distribute this software and its documentation is hereby granted, 

provided that: 

1. the use, copying, or distribution is not done for direct commercial advantage; 

2. any distribution of the software is on the same terms as in this License Agreement, and 

each copy contains the copyright notices and the license agreement that appear in this 

software and supporting documentation; and 

3. any documentation or other materials related to such distribution or use acknowledge that 

the software was developed by Miklós Mohai. 

To copy and distribute this software and its documentation in binary forms AS PART OF 

ANOTHER PRODUCT for commercial advantage is allowed only with the written permission of 

the author. 
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Installing XPS MultiQuant 

XPS MultiQuant can be used under Windows 2000, XP, Vista, 7, 8 and 10 operating systems. 

Although it is not tested on Windows 98, ME and NT; it is expected to run on these systems 

as well. 

You cannot simply copy the files from the distribution media to your hard disk. You must use 

the Setup program to decompress and install files into the correct folders. Before running 

setup, remove any previous installations of XPS MultiQuant. 

To install XPS MultiQuant on your computer: 

 Download the XPS MultiQuant distribution kit from the Internet 

 Decompress the downloaded ZIP archive into an empty folder 

 Run the Setup.exe program from this folder 

 Follow the instructions of the setup program. 

 If an appropriate Service Update is also available (with the same major version number), 

download and decompress the archive and follow the instructions of the attached  

Read Me file. 

Uninstalling 

If you, for any reason, do not want to use XPS MultiQuant any more, you can fully remove it 

easily. 

To uninstall XPS MultiQuant from your computer: 

 Press Start button 

 Select Settings \ Control Panel 

 Double click the Add / Remove Programs icon 

 Select XPS MultiQuant from the list 

 Press the Add / Remove button 

Follow the instructions of the removal program. The names of the Control Panel items may 

vary in the different versions of the operating system. 

If the program cannot be removed automatically, e.g., the St6unst.log file was accidentally 

deleted, remove the files and registry entries listed in the next chapter. If you are not familiar 

with the registry editing, do not tamper it; ask your system manager. After improper registry 

manipulation, your computer may become non-functional. 

If you have programs using the same shared programming components (the files installed into 

the \Windows\System folder) do not remove them. 
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Technical Notes 

Files Installed 

File Folder Description 

XMQ.exe \Program Files\XMQ XPS MultiQuant application 

XMQ.lib \Program Files\XMQ XPS MultiQuant Library 

XMQ.chm \Program Files\XMQ XPS MultiQuant Help 

XMQ.mqw \Program Files\XMQ XPS MultiQuant Workspace 

*.mtr \Program Files\XMQ Transmission files 

St6unst.log \Program Files\XMQ Uninstall log file 

Al-Layers.mqd \Program Files\XMQ\Samples Example data file 

Al-Oxide.mqd \Program Files\XMQ\Samples Example data file 

Cermet.mqd \Program Files\XMQ\Samples Example data file 

C-nanotube.mqd \Program Files\XMQ\Samples Example data file 

Contact.mqd \Program Files\XMQ\Samples Example data file 

CuAgAu.mqd \Program Files\XMQ\Samples Example data file 

LB-film.mqd \Program Files\XMQ\Samples Example data file 

NaCl-multiline.mqd \Program Files\XMQ\Samples Example data file 

NaCl-scaling.mqd \Program Files\XMQ\Samples Example data file 

PET-contam.mqd \Program Files\XMQ\Samples Example data file 

Si-ARXPS.mqd \Program Files\XMQ\Samples Example data file 

SiN-powder.mqd \Program Files\XMQ\Samples Example data file 

SiO2-contam.mqd \Program Files\XMQ\Samples Example data file 

SiO2-simulation.mqd \Program Files\XMQ\Samples Example data file 

Si-wafer.mqd \Program Files\XMQ\Samples Example data file 

Cermet.mqt \Program Files\XMQ\Samples Example template file 

Si-SiO2-CH.mqt \Program Files\XMQ\Samples Example template file 

Cermet.mqx \Program Files\XMQ\Samples Reduced Data Exchange file 

CuAgAu.mtr \Program Files\XMQ\Samples Transmission file 

Exponential.mtr \Program Files\XMQ\Samples Transmission file 

Polynom.mtr \Program Files\XMQ\Samples Transmission file 

Rational.mtr \Program Files\XMQ\Samples Transmission file 

Combined.mtr \Program Files\XMQ\Samples Transmission file 

ContactProfile.xls \Program Files\XMQ\Samples Excel 2007workbook 

CermetDocument.doc \Program Files\XMQ\Samples Word 2007 document 

ComCtl32.ocx \Windows\System Common Controls 

Comdlg32.ocx \Windows\System Common Dialog Control 

Graph32.ocx \Windows\System Graph Control 

Gsw32.exe \Windows\System Graphic server 

Gswag32.dll \Windows\System AutoGraph 

Gswdll32.dll \Windows\System Graphic server library 

MSflxgrd32.ocx \Windows\System FlexGrid Control 

MSvbvm60.dll \Windows\System Visual Basic Virtual Machine 

Sysinfo.ocx \Windows\System Sysinfo Control 

Tabctl32.ocx \Windows\System Tabbed Dialog Control 

St6unst.exe \Windows Uninstall program 
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Registry Entries 
The first two entries store the default and initial settings of the program. The subsequent 

entries describe the XPS MultiQuant data, transmission and templates file types and also the 

XPS Reduced Exchange files (name, icon and associated program). 

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\XMQ\Defaults 

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\XMQ\Ini 

HKEY_CLASSES_ROOT\.mqd 

HKEY_CLASSES_ROOT\MQDfile 

HKEY_CLASSES_ROOT\.mtr 

HKEY_CLASSES_ROOT\MTRfile 

HKEY_CLASSES_ROOT\.mqt 

HKEY_CLASSES_ROOT\MQTfile 

HKEY_CLASSES_ROOT\.mqx 

HKEY_CLASSES_ROOT\MQXfile 

Data, template and exchange files are associated with the XPS MultiQuant application while 

transmission files with Notepad. 

Hardware Requirements 
There is no special requirement; any computer

 1
 with x86-compatible processor is satisfactory. 

If the operating system can run with tolerable speed, XPS MultiQuant will run as well. The 

program occupies 2-8 Mbytes of hard disk space
 2

 (depending on components already 

installed). Printer is recommended. 

 

 
1 Computers in the future may weigh no more than 1.5 tons. (Popular Mechanics, 1949) 

2 640K ought to be enough for anybody. (Bill Gates, 1981) 
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Miscellaneous Remarks 

 In Windows NT-based operating systems (NT, 2000, XP, Vista, 7, 8, 10) user may have to 

own administrative privileges to install some system components. 

 The name of the Windows and Windows\System folders, where the shared components are 

located, may be slightly different (e.g., WinNT, and WinNT\System32) in the various 

versions of the operating system. 

 In 64-bit operating systems the 32-bit applications, like XPS MultiQuant, are installed into 

the Program Files (x86) folder. 

 From Windows Vista and above, the workspace file may be stored in the 

C:\Users\[username]\AppData\Local\VirtualStore\Program Files\XMQ folder, depending  

on the User Access Control (UAC) settings. 

 XPS MultiQuant data files (*.mqd) can be stored on any drive in any folder.  

 Although the language of XPS MultiQuant is always English, it applies the locale settings 

of your system (in the Control Panel Regional Setting or Region and Language), as 

different decimal and thousand separators, date formats, etc. (except in the analyser 

transmission files). 

 XPS MultiQuant data are stored in binary files. Texts in the file (e.g., title, experiment 

labels, element symbols, notes) are stored in original forms thus the content of the file can 

be searched by the operating system or external programs. 
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Using of the Program 

This chapter describes the first steps of using XPS MultiQuant. The basic knowledge of X-ray 

photoelectron spectroscopy and Microsoft Windows is assumed. 

Starting XPS MultiQuant 
The program can be started by several ways as usual in Windows. 

 Press the Start button and select XPS MultiQuant from the Programs folder. 

 Put a shortcut to the desktop and double click it. 

 Double click the icon of any XPS MultiQuant data file (with .mqd extension). 

 Previously processed XPS MultiQuant data files are also available in the list of the 

Start button / Documents. 

When the program is running the main window may look like this: 

 

Main window 

Subwindows 

Status bar 

Menu bar 

Chart subwindow 
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When the program is started by clicking a data file or from the Start button / Documents the 

file is loaded and the results are calculated and displayed automatically. 

The main window can be resized and repositioned as usual in Windows. At the top of the 

window, you can find the customary menu bar. At the bottom, the status bar shows the title of 

the calculation, the name of the current data file (if any), the pending page and the status of 

the NUMLOCK key. 

If you are unfamiliar with XPS MultiQuant, invoke the Data Wizard (on the Tools menu). It 

gives you step-by-step instructions to setup a quantitative calculation. 

Setting Parameters 
It is a good practice before entering the input data for your quantitative calculations to set all 

of the parameters required, especially, when you start XPS MultiQuant at the first time. Most 

of the parameters have to be set only once unless you are lucky to have more than one 

spectrometer (or one with several operating modes). Perform the View / Parameters 

command and scan through the tabs and set or select the following items:  

 Model type; usually Homogeneous. 

 Excitation source. 

 Cross section or sensitivity factor set. Usually let the Enable library lookup and Splitting 

features enabled. 

 Method of inelastic mean free path correction. Try a simple exponential approach first. 

 Angular correction and the excitation-analyser angle of the instrument. 

 Method of contamination correction. For general use, selection of Mohai is suggested. 

 Transmission function of the spectrometer. 

 The typical labels you want to attach to the experiments 

Every setting can be overwritten later as necessary. When all the parameters are set, select the 

File / Save Defaults command to store your preferred settings in the registry.  

Entering and Editing Input Data 
First of all, specify the elements you want to use in the calculation. Click the File / New or the 

View / Elements command to invoke the Elements window and fill the table. You can 

navigate in the table with the arrow keys or mouse clicks (see chapter “Keyboard 

Commands”). Type the symbol of the elements and the name of the selected lines. The “2p”, 

“4f”, etc. notations mean the whole doublet lines, while the “2p3/2” or “4f7” the doublet 

components. The program corrects the improper capitalisation of the element symbols and 

transition names. The “/2” tag is optional for the components. You can type either decimal 

point or decimal comma; always the current one is entered, as set in Windows. It is practical if 

you use two languages applying different symbols (e.g., English and German). You can enter 

the line notations simply by double clicking the cells. The program inserts the notations of the 

lines actually available for the selected cross section data set, and rotates them in increasing 

binding energy order. 

After selecting the elements, click the Tool / Library Lookup command to fill all the fields 

left of the table from the library of XPS MultiQuant. Of course, you can type in your own data 

manually or you can overwrite any particular fields filled from the library. Use the State 
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column to distinguish between different chemical states of the same element; e.g., your 

sample contains carbon in carbonate form and has hydrocarbon contaminant on it. If the 

automatic contamination control (Mohai) is selected, the State of the contaminant C1s line 

must be left empty. 

To improve the reliability of the calculations, you can apply more than one spectral line to 

quantify the same element. To switch on the Multiline approach feature, select the Average 

(simple average) or the Ebel (weighted average) method on the Model tab of the Parameters 

window. If the element calculated by multiple lines is present in more than one chemical 

states, you must provide data for all lines and all states for this element. E.g., if you measure 

the Si2s and Si2p lines of oxidised silicon, either you can calculate the total Si concentration 

(by the Si2s(total) and Si2p(total) lines) or both lines must be decomposed into Si
0
 and Si

4+
 

chemical states (by the Si2s(0), Si2p(0), Si2s(4+) and Si2p(4+) lines). 

The binding energy values of the library, used for calculating the analyser transmission and 

IMFP correction, are approximate values (usually for elemental state). However, you can 

enter the exact value to emphasise the chemical state. The number of the elements is counted 

automatically so do not leave empty lines between them. 

Finishing with the Element window, close it by clicking the close button or by the View / 

Elements command. The values entered to the table are checked and you will get an error 

message if some of them are unrealistic. 

When all element data are typed in, invoke the Intensity window by the View / Intensity 

command. Get the integral peak intensity data from your XPS data processing software after 

the usual pre-processing (correction for acquisition time, number of sweeps, background 

removal, etc.) and enter them into the table of Intensity window. In case of your data are also 

corrected for analyser transmission, set this feature to None in the Parameter window. The 

program distinguishes the empty and zero cells so you can use zero value to emphasise the 

absence of an element while an empty cell may simply mean „not measured‟. If your data 

system is able to provide intensity data in tabulated form, as specified in chapter “Program 

References, Edit Menu”, you can enter all of the data in one step, using the Edit / Paste Table 

command. 

Type the labels for your experiments. Labels hold auxiliary data, like sample name, tilt angle, 

temperature, time, etc. 

If you apply more sophisticated IMFP or contamination correction, you have to fill the 

corresponding fields in the IMFP & Contamination window as well. 

The content of any input window can be changed later at any time. To edit a cell, double click 

it. To insert or remove an element use the Edit / Insert Row or Edit / Delete Rows 

commands in the Elements window; to insert or remove experiments use the same commands 

in the Intensity window. The deleted rows can be recovered only once by the 

Undo Delete Rows command. If you want to add elements or experiments to the end of the 

tables, simply fill the last empty line.  

Content of the cells can be simply copied and pasted within XPS MultiQuant or between 

external programs by the pop-up menu commands invoked by right mouse click. 

The order of elements or experiments can be easily rearranged. Just drag and drop by the right 

mouse button the sequence number of the desired element (in the Elements window) or 

experiment (in the Intensity window) into the required new position. During the drag and drop 

operation, the mouse cursor is changing, indicating the action in progress. 
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Calculator in the Input Windows 

Instead of numbers, simple arithmetic expressions may also be entered into the cells of the 

input windows (Elements, Intensity, IMFP & Contamination, Model). These may be used 

conveniently, e.g., for summing up the intensity of the components of a doublet line. 

The expression consists of two numbers connected with an arithmetic operator. Valid 

operators are: addition (+), subtraction (–), multiplication (*) and division (/). Numbers may 

have sign, decimal separator (dot or comma, according to the locale settings of the operating 

system), exponent sign (e or E) and one or two-digit exponent with optional sign. 

The expression is parsed and calculated immediately, when the ENTER or an ARROW key is 

pressed, and replaced with the result. If the expression is invalid, either syntactically or 

semantically (e.g., division by zero), the result is not shown and a warning tone is sounded. 

The following table shows some examples for valid and invalid expressions. 

Valid expressions Invalid expressions 

123 + 123 = 246 123 + 12ee12 Two exponent signs 
–123 + 456 = 333 –12e1.2 * 12 Digit separator in exponent 

–12.3 + –123 = –135.3 –12..34 + 12 Two digit separators 

–456 / –12 = 38 12e–+12 * 12 Two signs in exponent 

123.4 * 1.5 = 185.1 123 / Right hand operand missing 

12.3e+12 / 4e+10 = 307.5 12e+ /12 Digit in exponent missing 

2.46E12 / 1.23E12 = 2 123 ** 123 Two operators 

–1.2e–12 * –2e12 = 2.4 / 123 Left hand operand missing 

Template Files 

XPS MultiQuant template files make the work easy if you frequently perform the same 

quantification on similar sample series. Template files, as data files, store all basic data, 

model definition, title and notes but do not save intensity values, labels and results (for the 

structured models). To save the current data set as template file, invoke the File / Save as… 

command and select the XPS MultiQuant Template Files (*.mqt) file type. You can open the 

template files as data files either by the File / Open… command or by drag and drop the file 

into the main window or by double click it. When a template file is loaded, the Intensity 

window appears immediately. 

Template files can also be used to save various parameter sets beside the default one, stored in 

the registry. Select the required parameters in the Parameters window and create a template 

file without specifying elements. 
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Importing Data 
Most time consuming task when using of XPS MultiQuant, is to type element and intensity 

data of the experiments. Transferring large amount of data by this way is tedious and may be 

the source of potential errors. The following chapter surveys the recommended methods of 

importing data. 

XPS Reduced Data Exchange Files 

XPS Reduced Data Exchange files are designed to transfer reduced data (peak position, 

FWHM, integral intensity, etc.) from spectral processing programs to other programs, e.g., for 

looking up line positions in a database, calculating IMFP for the determined energies, or 

performing advanced quantification. 

The XPS Reduced Data Exchange files are unformatted character files with defined structure. 

They can be prepared on various computers under DOS, Windows, Unix, Linux and 

Macintosh operating systems and can be read without any previous conversion. 

Interpreting of version 1.1 XPS Reduced Data Exchange files is fully implemented in 

XPS MultiQuant. Files can be opened like the standard data files by the File / Open… menu 

command or the source application can invoke XPS MultiQuant directly and pass the file as a 

parameter. Transferring of data can be routinely applied for simple quantification, ion etch 

depth profile, etc. and it gives immediate results. The advanced features (layer thickness 

calculation on flat or curved surfaces) cannot be addressed directly because these features 

require deeper user interaction anyway. 

Converter Programs 

Although using of XPS Reduced Data Exchange files is recommended for importing data, this 

format is not yet widely applied. Another possible solution may be, to interpret the 

quantification reports provided by most of the XPS data processing systems. These reports 

can usually be saved as simple text files. The files can be converted to 

XPS Reduced Data Exchange files, which can be read by XPS MultiQuant. Converter 

programs are available on the homepage of XPS MultiQuant. This way is convenient for 

regular use. 

Extracting Data from Various File Types 

The spectrum processing programs produce tabulated output in various file formats. To write 

a program to read of all file variants is unrealistic and not really necessary. Fortunately, the 

following procedure can help in most of the cases as follows. Open the file with its native (or 

similar) reader program, copy the required part of the file (row, column or matrix of numbers) 

and paste it into XPS MultiQuant. 

The major cases are the followings: 

 Cell-structured data files includes Excel workbooks (*.xls, *.xlsx), Data Interchange 

Format (*.dif) files, Origin (*.opj, *.opju) projects, tables in Word (*.doc, *.docx) and 

Rich Text Format (*.rtf) documents. Cells can be easily selected in any direction (row, 

column, matrix). When copied, cells are separated by TAB characters. 



17 

 The simple text (*.txt, *.csv) files does not contain real cell information. Tabulated items 

in these files are usually saved as delimiter separated text. Typical example is the comma-

separated values (CSV) file, which can be generated by several programs. Text can be 

usually selected in rows only but some programs allows column selection as well. 

 The items of tables in files prepared for human reading, e.g., printed to file (*.txt, *.prn, 

*.pdf, *.htm, *.html, etc.), are usually delimited by spaces. 

XPS MultiQuant is ready to accept various types of delimited text for pasting without 

previous conversion. Delimiters includes comma, semicolon, tabulator, consecutive spaces or 

any other character selected in Windows. The line terminator characters can be carriage return 

(CR), line feed (LF) or both (CRLF) thus text can be pasted directly from files prepared on 

different computer systems. 

The next table summarises the allowed combinations of various decimal symbols and list 

separators. As you see, most kinds of delimited text can be pasted, even when the number 

format is not changed in Windows. If you still had to alter the format settings, restart 

XPS MultiQuant. 

In the copied text  Windows decimal symbol 

List separator Decimal symbol  Point Comma 

Tab 

Point  OK OK 

Comma   OK
 1
 OK 

None  OK OK 

Comma 

Point  OK OK 

Comma   Not allowed Not allowed 

None  OK  OK
 2
 

Semicolon 

Point  OK OK 

Comma   OK
 1
 OK 

None  OK OK 

Spaces 

Point  OK OK 

Comma   OK
 2
 OK 

None  OK OK 

Other
 3

 

Point  OK OK 

Comma   OK
 1
 OK 

None  OK OK 

1
 If column or single data item is copied, press SHIFT key during pasting. 

2
 Press SHIFT key during pasting. 

3
 Set the proper list separator character in Windows. 

Spaces are normally served as item separators. If your data contain spaces (e.g., labels), they 

are split into two or more cells when pasted. To avoid it, press the SHIFT key during pasting. 

Space-containing data and space delimiters are usually cannot be combined. In that special 

case, copy your data column by column. 

Depending on the actual combination of decimal symbol and list separator characters in the 

copied text, the SHIFT key either disables spaces as list separator or swaps the denotation of 

comma (e.g., list separator instead of decimal symbol or vice versa). 
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You need not memorize the above table; just use the Paste command. If the appearance of 

your pasted data differs from the expected, try the SHIFT + Paste variant. 

The following examples illustrate that several decimal symbol and list separator combinations 

( represents TAB character) can produce the same result without customizing the number 

format in Windows (decimal symbol is set to point). 

    
 

1001.9 1002.9 1003.9

2001.9 2002.9 2003.9

3001.9 3002.9 3003.9

4001.9 4002.9 4003.9

1001.9;1002.9;1003.9

2001.9;2002.9;2003.9

3001.9;3002.9;3003.9

4001.9;4002.9;4003.9

1001,9;1002,9;1003,9

2001,9;2002,9;2003,9

3001,9;3002,9;3003,9

4001,9;4002,9;4003,9

1001.91002.91003.9

2001.92002.92003.9

3001.93002.93003.9

4001.94002.94003.9

1001,91002,91003,9

2001,92002,92003,9

3001,93002,93003,9

4001,94002,94003,9

1002   1003   1004

2002   2003   2004

3002   3003   3004

4002   4003   4004

1002;1003;1004

2002;2003;2004

3002;3003;3004

4002;4003;4004

1002  1003  1004

2002  2003  2004

3002  3003  3004

4002  4003  4004

1002,1003,1004

2002,2003,2004

3002,3003,3004

4002,4003,4004

1001,9,1002,9,1003,9

2001,9,2002,9,2003,9

3001,9,3002,9,3003,9

4001,9,4002,9,4003,9

1001,9 1002,9 1003,9

2001,9 2002,9 2003,9

3001,9 3002,9 3003,9

4001,9 4002,9 4003,9

 

List separator characters (e.g., semicolon) usually cannot be pasted directly. If you want to 

include it, e.g., in label text, use the CTRL + Paste command. This command is valid only for 

single cells or columns. 
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Managing Results and Charts 
Display the Composition window by the View / Results command. Results can be presented 

in eight different forms: Atomic %, Atomic ratio, Oxide molar %, Oxide molar ratio, Mass %, 

Mass ratio, Oxide mass % or Oxide mass ratio. If you select one of these forms from the 

dropdown list, the data in the table are recalculated immediately. When the percentage type 

results are selected, you can omit any element from the 100 % sum; just double click the 

element symbol. The omitted element can be brought back by double clicking again. When 

ratio type results are selected, the „basis‟ element of the calculation can be set by double 

clicks as well. If the concentration of the selected basis element is zero for some experiments, 

the previous non-zero basis is kept for these experiments. The number of atoms of the basis 

element can be set in the Number textbox by clicking the arrow buttons. If you enter an 

element in more than one chemical state, the different states of the same element can be 

summed up by selecting the Merge chemical states check box. In this case the double clicks 

the element symbols will not work. This option is not available when oxide type results are 

selected because it makes no sense to add the quantity of different compounds. In these latter 

cases, the Oxygen balance is calculated and displayed in the last column of the window, 

which shows the ratio of measured and calculated (required by the applied chemical formula) 

oxygen. If it is less than 1, the surface is deficient in oxygen; if it is greater than 1, there is 

oxygen surplus. 

Results can be demonstrated in graphical form in the Chart window (View / Chart 

command). It co-operates with the Composition window. Results are presented as line chart or 

as pie chart if only one experiment entered. When you change the Composition window, it is 

reflected in the Chart window (immediately or after clicking it). The X (category) axis of the 

line chart is taken from the Labels tab of the Parameters window. It can be altered easily by 

double clicking the label column headers. Sequence number as X-axis can be selected only in 

the Parameters window. Numeric labels (Time, Tilt, Temperature, etc.) are treated as 

numbers while text labels are simply enumerated. The Y (value) axis is chosen according to 

the result type in the Composition window. Elements omitted from percentage calculation are 

also omitted from the chart even if the result type is changed to ratio. If you have unnecessary 

data points, i.e., experiments in your series (e.g., a 60° tilt experiment in an ion etch series) 

you may omit them from the chart by double clicking the sequence number of the experiment. 

The number is changed to X showing that this experiment is switched off temporarily. 

Feel free playing with different settings and find the best form of presentation, which suits 

your requirements. While you analyse your results, open the Notes window (View / Notes 

command), record your comments and store together with the respective data. 

Saving and Printing 
After entering data, you may want to save them for documentation, for further analysis or for 

extending later with new data. To save your work, select the File / Save As command. A 

standard Windows dialog box is shown to set or select the folder and file name. The default 

extension is .mqd. The file is binary thus do not tamper it with other programs. When you 

save the data for the first time, the file becomes the current file and its name is displayed in 

the status bar. Then you can save the data into the current file by the File / Save command or 

by the CTRL+S shortcut. Saved files can be loaded by the File / Open command. You can 

open files on mapped network drives as well but you must have writing permission to that 
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drive (full access type). Files can also be opened by drag and drop the data file from the 

Windows Explorer to the main window of XPS MultiQuant. 

If you want to suspend your work and to continue it later, you can select the File / 

Save Workspace command. Once selected, the name of the current data file, the position, 

size and settings of the open windows are saved on exit. Next time, when you started the 

program without command line parameter (i.e., not by double clicking on a filename), the 

data file, registered in the workspace, is loaded and the layout of all windows are restored. 

Results can be printed on any local or network printer connected to your computer. Perform 

the File / Print command. To start with, press the Options button and select the required 

printer, page orientation, font type and size. Return to the Print window, select items to be 

printed and press the Print button to print. Results are printed with the last selected settings 

(type, basis element, merging, etc.). Pages are spooled and printed only when physically full. 

A small page icon is appearing in the status bar indicating the pending page. To print the 

pending, unfinished page, press the Eject Page button in the Print window or double click the 

page icon. Settings of the Print and Print Options windows are also stored in the registry 

when File / Save Defaults executed. You can also print the content of any window 

immediately. Just select the File / Print Current command or press CTRL+P to print the 

content of the active window. The logically connecting parts of the printout, like header and 

rows of a table, are kept together; take it into account when selecting the margin and font 

sizes. Large tables, which cannot be printed to one page, are tiled. A sample page of 

XPS MultiQuant output is illustrated on the next page. For printing the content of Notes and 

Parameters, use the Print command or button of these windows. 

Exporting Results 
Although the printed output of XPS MultiQuant is satisfactory in most of the cases, you may 

want to insert the results into your documents. The content of any window (except 

Parameters and Chart) can be copied to the clipboard by the Edit / Copy Table command 

and pasted into any Windows application. Two subcommands are available: apply the Edit / 

Copy Table / ASCII command to paste data into text files, Excel worksheets, etc. and the 

Edit / Copy Table / MS Word to paste into Word documents and create Word tables. Only 

whole tables with column headings can be exported. If you want to exchange data between 

two instances of XPS MultiQuant, press SHIFT key and use the Edit / Copy Table / ASCII 

and Edit / Paste Table commands to copy tables without headings. 

To copy text from or paste into the Notes window, use the commands of the pop-up menu 

(right click). The graphics of the Chart and Model Layout windows can also be transferred to 

other applications by the Copy command of the pop-up menu of these windows. 

To produce high quality graphs, e.g., depth profiles, export the results into Excel, Origin or 

any other charting program. 
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XPS MultiQuant  7.80 Thursday, 26 April, 2018 

Cr-O-Si cermet film © 1999-2018 M. Mohai  

 

Parameters 

Model: Homogeneous 

Multiline approach: None 

Excitation: Mg K  (1253 .6 eV) 

Cross sections: Scofield 

IMFP correction: method: Exponential 

 exponent: 0.5 

Angular correction: method: Reilman 

 analyser-excitation: 65.0 ° 

Transmission: type: FRR, CRR 

Contamination correction:  method: Mohai 

 

Elements 

Line State B. E. Cross s. Asymm. At. w. Val. Ox.  

O 1s  531.0 0.6240 2.0000 16.000 2 0  

Cr 2p  574.0 2.3400 1.4590 52.000 3 3  

C 1s  285.0 0.2250 2.0000 12.010 4 0  

Si 2p  99.0 0.2300 1.1060 28.090 4 2  

 

Intensity 

 Time (min) O Cr C Si   

1 0 837624 669910 41853 213533   

2 10 467572 936964 20378 296118   

3 20 436508 936100 21494 293938   

4 30 422376 938868 15150 302254   

5 40 424544 955776 16565 290347   

6 50 417772 942724 13359 292522   

 

Atomic % 

 Time (min) O Cr C Si   

1 0 64.8 14.5  20.6   

2 10 42.5 23.9  33.6   

3 20 41.0 24.6  34.4   

4 30 39.7 24.8  35.5   

5 40 40.2 25.4  34.4   

6 50 39.9 25.2  34.9   

 

Oxide molar % 

 Time (min) O Cr2O3 C SiO2 O bal.  

1 0  26.0  74.0 1.03  

2 10  26.2  73.8 0.41  

3 20  26.3  73.7 0.39  

4 30  25.9  74.1 0.37  

5 40  27.0  73.0 0.38  

6 50  26.6  73.4 0.37  

 

Notes 

Cr-O-Si cermet film prepared by RF-sputtering of a Cr:O:Si target with a nominal atomic ratio of 

1:1:1 onto thermally oxidised silicon wafers. Ion bombardments were performed by 2 keV Ar ions. 
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Application of Structured Models 
When the surface of the sample is covered by one or more overlayers and you know (or, at 

least, assume) the composition of the layers the thickness of the layers can be estimated from 

the photoelectron intensity ratios. The shape of the sample can be flat (e.g., thin layers, 

coatings, etc.), spherical (coated powder particles, e.g., paints, fillers, supported catalysts), 

cylindrical, including nanotubes (e.g., coated fibres for composites), or rough, modelled by 

polyhedrons (e.g., grooved, knurled surface, surface covered by individual crystallites). The 

program can handle as many as five layers; it is usually more than enough for the practice. 

Layers-on-Sphere

Layers-on-Cylinder

Layers-on-Polyhedron

Islands-on-Sphere

Islands-on-Cylinder

Layers-on-Plane Islands-on-Plane

Islands-on- Polyhedron

Layers-on-Nanotube Islands-on-Nanotube  

First, enter the elements and intensity data as usual and select the model type in the Model tab 

of the Parameters window. Invoke the Model window by the View / Model command 

(available only when the model type is not Homogeneous). Give a descriptive name for each 

layer and the bulk material. You declare the presence of a layer by naming it thus the name is 

obligatory. Fill in the table, according to chapter “Model” in “Program References”. 
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Temporarily switch to Homogeneous model and study the overall composition of the 

underlying layers; this helps to estimate the layer thickness, and then switch back to the 

required structured model. Close the Model window and open the Layer Thickness. The Layer 

Thickness window shows the thickness of the overlayers for the experiments. The table is 

empty when first invoked, because the layer thickness values are not calculated automatically. 

For the same reason, the calculated thickness values are stored in XPS MultiQuant data files. 

To calculate the layer thickness, double click the sequence number of the selected experiment. 

The Layer Calculation window is displayed. Select a basis element for the relative intensity 

comparison by double clicking the element symbol in the upper panel. Estimate and enter the 

thickness of each layer to the small table below and press ENTER. When the last number is 

entered the relative intensity is calculated and displayed. The Diff % column shows the 

percentage difference between the calculated and measured intensity; while the Qsum row 

shows the sum of the squares of the differences. The Chart window let you compare the 

intensity values graphically (see chapter “Layer Calculation”). You can enter the next 

estimation immediately; intensity values are recalculated and displayed. The results of the 

previous calculations (the last two ones) are also displayed for comparison. If you do not enter 

thickness to a cell but press ENTER the previous value is retained. Vary the thickness of the 

layers until calculated intensity values are the closest to the measured ones, i.e., perform a 

manual least square fitting or press the Autofit button to calculate the parameters 

automatically. Then press the OK button or select the next or previous experiment. The results 

of the calculation are summarised in the Layer Thickness window. 

The geometric scheme of the applied model can be displayed in the Model Layout window. 

There are some other characteristics to help defining more complex models. If you have some 

„a priori‟ knowledge on the relation of the different layers, you may declare the thickness of 

different layers to be equal: double click the cells in the Link to row in the Model window 

until the number of the target layer appears. Furthermore, if you know that the layers are 

repeated on the sample, it is enough to define the „unit‟ and to select the number of the 

repetitions in the Multilayers box in the Model tab of the Parameters window. The typical 

application of these features is the study of Langmuir-Blodgett type films. 

If you record the spectra of a planar sample at several take-off angles (angle dependent XPS, 

„ARXPS‟), the thickness of the layers can be calculated using all of the experiments together 

with the Layers-on-Plain and Islands-on-Plain models. 

d

d*

e-

θ

d

e-
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This technique increases the number of independent variables (i.e., the “elements”) and you 

may calculate systems, which is ill defined when measured at one take-off angle only (typical 

example is single element islands on a single element substrate). 

To use this feature select the Angle dependent experiment set check box in the Model tab and 

select the Tilt labels in the Label tab of the Parameters window. The calculation set (and also 

the data file) must contain the related angle dependent experiments only. 

In the simplest case, when a metal is covered with its (native) oxide and the two chemical 

states of the metal can be resolved, the Oxide-Layer model can be applied. The thickness of 

the overlayer is calculated directly, based on the intensity of the metal lines originated from 

the bulk and from the oxide layer. The layer must be defined in the Model window, as 

described previously (composition, molecular weight, density, IMFP). The two chemical 

states of the main element must be denoted as Me (metal) and Ox (oxide) in the Elements 

window. For inserting the special state information quickly (rotating text in the Me – Ox – 

empty order), you can double click the appropriate cells of the State column. 

Intensity Simulation 
For several reasons (theoretical studies, test purposes, etc.) it is useful if the usual quantitative 

calculations can be done “backwards”, i.e., from the layout and the predicted composition of 

the sample the integrated photoelectron intensity values can be obtained. Actually, the 

program always solves this inverse task (i.e., intensity from layer thickness) and eventual 

thickness data can be reached only by parameter fitting. Just adding a new “data flow” to the 

program was necessary. 

To prepare simulated data, select the required elements and set up a structured model as 

described in the previous chapter. Invoke the Intensity Simulation window by the Tools / 

Simulation… command. If the intensity data set is not completely empty (i.e., all zero), a 

message warns the user that further actions may destroy the previously entered (either 

experimental or simulated) intensity data. 

Select an experiment to store simulated intensity. New experiments can be added only to the 

end of the data set but any previously calculated experiment can be recalculated later. Enter 

the thickness of the layers (and optionally the coverage for the island-type models) and press 

the Calculate button. The inverse of the corrections selected in the Parameters window (cross 

section, IMFP, transmission, angle) are applied. Surface contamination can be implemented 

by defining a carbonaceous top layer. 

You can assign a name, which is stored as the Name label of the selected experiment. If it 

were empty, the word “Simulated” is inserted. These automatically entered labels can be 

changed later in the Intensity window. Other labels, like Time, Tilt, etc., can also be added. 

To calculate angle dependent experiments, enter the tilt angle values for each experiment as 

Tilt labels in the Intensity window before the simulation; and enter any number as intensity at 

least into each experiment, unless the automatic counting will delete it.  If you want to create 

an angle dependent set, do not select the Angle dependent experiment set checkbox in the 

Model tab of the Parameters window during the simulation. 

For the first time, it seems that the simulation can be used only for layered structures. 

However, intensity data of a homogeneous sample can be calculated as well. Define the 

required composition as the bulk of the model; define one, any kind of layer and set its 

thickness to zero. Again, surface contamination can be realized by a carbonaceous layer. 

The simulated intensity values can also be perturbed by noise, within a given relative level. 
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Inelastic Mean Free Path 
The inelastic mean free path values are one of the most important parameters of the 

quantitative XPS calculations, thus they should be selected very carefully. The recommended 

sources of IMFP data are (in this hierarchy): 

 measured values from the reliable literature and databases 

 experimentally based calculated values from the literature and databases 

 values calculated by predictive formulae [9] 

 values calculated by predictive formulae within XPS MultiQuant 

The application of the IMFP values is slightly different for the homogeneous and the 

structured model calculations. For the homogeneous model, when the relative composition of 

the sample is calculated, instead of the absolute IMFP values, numbers proportional to the 

IMFP values can be used. Consequently, several straightforward methods are available, like 

the simple exponential approach or Jablonski‟s [7] method. Obviously, the actual IMFP 

values can also be used (Explicit method). XPS MultiQuant applies the selected method „on 

the fly‟ for the calculations. 

Conversely, for the structured models, when the thickness of the overlayers is calculated, 

knowledge of the actual IMFP values is essential. For these types of calculations, always the 

„explicit‟ values are used. All other selectable methods [8-11] are applied to compute the 

IMFP values prior the layer thickness calculation. 

Although there is only one location to set the IMFP correction method (i.e., the IMFP tab of 

the Parameters window), two different method names, one for the homogeneous and one for 

the structured models, are maintained. Only the methods associated with the model can be 

selected. The following table enumerates the selectable methods for each model type and also 

shows the source (the names of the windows in the program) of the IMFP data or the 

parameters to calculate them. 

Models and methods 
Location of  

IMFP data 

Location of parameters  

to calculate IMFP 

Homogeneous model   

None – – 

Explicit IMFP & Contamination – 

Exponential – Parameters 

Jablonski – IMFP & Contamination 
*
 

Seah-Dench – IMFP & Contamination 
*
 

Gries – IMFP & Contamination 
*
 

Structured models   

Explicit Model – 

Seah-Dench Model IMFP & Contamination 

Tanuma-Powell-Penn Model IMFP & Contamination 

Gries Model IMFP & Contamination 

Cumpson-Seah 
**

 Model Model 
*
 When the same parameters are used for all experiments, values can be set in IMFP tab 

of Parameters window as well. 
**

 Attenuation length. 
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Carbonaceous Contamination 
Presence of carbonaceous contaminant is typical on the surface of materials handled or stored 

in ordinary ambient. The effect of this layer on the composition of the otherwise 

homogeneous samples can be taken into account during the calculation. See the scientific 

background of the various methods in chapter “Contamination Correction”. 

In most of the cases the bulk of the sample does not contain any carbon thus C concentration 

should be omitted from the 100 % sum of the percentage type composition results. 

Accordingly, when the selected correction method is Evans, Mohai or Explicit, C is omitted 

automatically. Although you can switch it back (by double clicking the symbol C), these 

composition values usually make no sense (even though it gives some estimate on the level of 

carbon contamination). 

Correction methods can also be applied for carbon containing materials when the signal from 

the constituent carbon (e.g., carbonate or carbide types) can be separated by decomposition 

from the hydrocarbon type contamination (use different State settings). These correction 

methods cannot be applied to samples containing hydrocarbon type constituents, like most 

polymers. When the intensity of the adventitious carbon of an experiment is zero, no 

contamination correction is applied for that experiment.  

As a generally applicable default contamination correction, method of Mohai [15] is 

suggested. It can be applied from clean to highly contaminated samples (up to approximately 

5 nm hydrocarbon layer). See the changes of the atomic ratio of the otherwise stoichiometric 

samples in the following table. 

Sample Correction c factor Na Cl 

NaCl None 0.0 1.00 0.96 

clean Evans 14.3 1.00 0.98 

 Mohai 0.0 1.00 0.96 

NaCl None 0.0 1.00 0.90 

highly Evans 14.3 1.00 0.92 

contaminated Mohai 64.6 1.00 1.01 

Sample Correction c factor Si O 

SiO2  None 0.0 1.00 2.01 

slightly Evans 14.3 1.00 2.25 

contaminated Mohai 4.3 1.00 2.08 

SiO2  None 0.0 1.00 1.31 

highly Evans 14.3 1.00 1.46 

contaminated Mohai 50.6 1.00 1.94 

Such simple correction cannot be used for the structured models. Instead, you can explicitly 

define a hydrocarbon type contaminant layer on the top of the sample. Application of a layer 

with CH2 composition, density of 0.8 g/cm
3
 and Polymer material class is usually suitable. 

You can use ≈ 7.5 eV bandgap energy for the Tanuma-Powell-Penn IMFP calculations. 
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Oxygen Balance 

When the surface composition is calculated by the Homogeneous model, and one of the 

oxide-type normalisation (Oxide molar %, Oxide molar ratio, Oxide mass % or 

Oxide mass ratio) is selected, the oxygen balance is also displayed. The oxygen balance is the 

ratio of the measured and calculated (required by the elements at the given stoichiometry and 

oxidation states) oxygen concentrations. If the oxygen balance is less than 1, the surface is 

deficient in oxygen; while it is greater than 1, it indicates oxygen surplus, e.g., presence of 

OH groups on the surface. 

Usually, the actual valences (oxidation state) of the elements can be used. Oxygen containing 

salts can be considered as complex oxides of the cation and anion forming elements. For 

elements not connected to oxygen, set the number of their oxygen atoms to zero. In some 

special cases, instead of the real valences “virtual” values have to be applied to describe the 

actual stoichiometry, as illustrated in the next table. When the oxidation state is not integer, 

like in U3O8, it should be treated similar to oxosalts. 

Compound 
Cation Anion 

Valence Oxygens Valence Oxygens 

Sodium sulfide, Na2S 1 0 2 0 

Sodium sulfite, Na2SO3 1 1 4 2 

Sodium thiosulfate, Na2S2O3 1 1 4, 0 2, 0 

Sodium sulfate, Na2SO4 1 1 6 3 

Sodium peroxodisulfate, Na2S2O8 1 1 7 7 

Sodium peroxomonosulfate, Na2SO5 1 1 8 4 

Titanium sulfate, Ti(SO4)2 4 2 6 3 

Titanyl sulfate, TiOSO4 2 1 8 4 

Triuranium octoxide, U3O8 4, 6 2, 3   

The same approach can be used for organic compounds and functional groups. Some typical 

examples are enumerated in the following table. 

Functional group Valence Oxygens 

Carbon, hydrocarbon C−C−C C 0 0 

Ether, epoxy C−O−C C2O 1 1 

Carbonyl, alcohol C=O, C−OH CO 2 1 

Anhydride O=C−O−C=O C2O3 3 3 

Carboxyl, acid O=C−OH CO2 4 2 

Omitted elements, including oxygen, are excluded from the oxygen balance calculation. Thus 

the balance of selected group of elements can also be tested. 
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Miscellaneous Remarks 

Mixing of Methods and Data 
Every term of the sensitivity factors can be controlled independently; however, the user is 

responsible for the reliability of mixing the different methods and data. It is important to 

consider whether a sensitivity factor or your input data already contain correction for a 

phenomenon; do not apply any correction twice. Switch off all unnecessary features, e.g., if 

your instrument has „magic angle‟ arrangement (54.73° excitation-analyser angle, where the 

term 
3
/2 cos

2
φ-

1
/2 is zero), do not apply angular correction. 

Cross Section Correction 
Evans‟ original cross section data [3] are measured with 90° excitation-analyser angle and this 

factor was not separated from the cross section values. Before angular correction, data are 

converted to the 4π sr solid angle but only when the Data set item in the Cross section tab of 

the Parameter window is set to Evans. 

Wagner‟s sensitivity factors for the secondary lines are multiplied by 0.9 for Mg Kα and by 

1.1 for Al Kα excitation, as suggested in [1], when the above item is set to Wagner. Thus, this 

item controls not only the library search but the correction of library data as well. If you use 

manually entered sensitivity factors, make sure to set this item to Explicit. 

Raw Composition 
Determination of some terms of the sensitivity factors to calculate the chemical composition 

by the Homogeneous model requires the chemical composition itself. These are: 

 Angular and elastic scattering correction by the Reilman-Ebel method, 

 IMFP by the Seah-Dench method with the Calculate mean atomic weight option, 

 IMFP by the Gries method, 

 Contamination correction by the Mohai method. 

The preliminary “raw composition” is calculated by simplified way, as listed in the last 

column of the next table. Then the composition calculated by the selected methods, with 

parameters based on the raw composition. 

Correction Selected method “Raw” method 

Angular None None 

Reilman 

Reilman-Ebel 
Reilman 

IMFP None None 

Exponential Exponential 

Explicit 

Jablonski 

Seah-Dench 

Gries 

Jablonski 

Contamination any None 

Multiline approach any Average 
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IMFP for Homogeneous Model 
For the homogeneous model, instead of the absolute IMFP values, only their ratios are 

relevant. When the IMFP values are calculated by predictive formulae, like formula of Seah 

and Dench [8] or Gries [11], even at altering the  parameters (mean atomic weight, density) in 

a wide range, the ratio of the different IMFP values remain almost unchanged and 

accordingly no differences can be observed in the composition results. 

Thus for homogeneous model calculations precise knowledge of these parameters are not 

essential. However, for the structured models, knowledge of the actual IMFP values is 

fundamental. 

Angle of Emission 
If you perform a series of angle dependent („tilt‟) experiments

 3
, where the angle of emission 

(take-off angle, the angle between the sample surface normal and the analyser axis) is other 

than zero (i.e., not perpendicular), select the Tilt label set and enter the angle values there. In 

the case of the Homogeneous model, it can be applied only as X-axis set. (However, if your 

data are depending on the tilt angle, it clearly proves that the sample is not homogeneous.) 

When one of the planar type structured models is applied, the angle values are taken into 

account in the equations (marked by θ) shown in chapter “Applied Methods”. In case of 

curved surfaces, only the perpendicular view is permitted thus the angle values are not used. 

When you select the Angle dependent experiment set check box in the Model tab of the 

Parameters window, all of the experiments recorded at various angles are linked and the 

calculation of the layer thickness performed together. 

Automatic and Manual Fitting of Layer Thickness 
When you perform Autofit during layer thickness calculation, you may encounter that the Qsum 

value becomes larger than previously reached manually. This can be caused by several factors 

and does not mean that the fit become worse. 

 The Autofit procedure is more complex, not simply the least squares are minimised. 

 The actual numeric value of Qsum is depending on selection of the basis element. It is not 

necessarily the same at the manual and the automatic calculation. 

 At manual calculation, Qsum contains the contribution of all elements, including the 

omitted ones. During automatic calculation, omitted elements are neglected. 

The fitting procedure „knows‟ the mathematics only (i.e., not restricted by any physical 

consideration); results should be always revised by the experienced surface analyst. 

Calculation of Coverage 
Be careful when the coverage is calculated automatically in case of „island‟ type models. 

Small changes in coverage may cause significant changes in the calculated intensity. The 

fitting procedure may be frequently trapped in „local‟ minima. Always try to continue the 

calculation (click Autofit again) until there is no change in the results. Repeat the calculation 

with different starting values. 

Always check whether a layer is really discontinuous. When the number of independent 

parameters is increased by the coverage, the numeric value of the fit may seem to be better 

but it does not necessary mean that it really is. 

 
3 It is also called „angle resolved‟ XPS (ARXPS) but it is better to reserve this name for those experiments where the angle 

between the analyser and the excitation source is varied. 
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Density of Layers 
A layer, deposited or developed on the surface of a substrate (e.g., a native oxide layer grown 

on a metal surface), may be far less dense than its bulk density. Using the latter value may 

decrease the calculated layer thickness significantly, as compared to the thickness measured 

by scanning probe microscopy or by optical methods. 

Using of Undo Commands 
The undo commands, as in other programs, are used to restore the accidentally changed data. 

There are two undo subsystems in XPS MultiQuant: one for cell and one for row editing. Cell 

editing commands, including Cut Cells, Paste Cells and DELETE key, have several levels of 

undo. The row editing commands, Insert Row and Delete Rows, have only one level. The 

table editing commands, Paste Table and Clear Table, use both subsystems at the same time 

thus they also have one level. Undo is also available to revoke the results of layer thickness, 

intensity simulation and intensity split calculations. 

Due to the complex data structure of XPS MultiQuant, using of the undo commands is limited 

occasionally (e.g., when an element deleted, all corresponding intensity data will also be 

deleted). If the number of elements or experiments is changed or rearranged since the editing 

step to be undone, the program warns the user because the restored data may be placed into 

wrong locations (depending on the relative position of the items).  

The best practice is to perform the necessary undo as soon as possible after the unwanted 

action (especially for the row and table editing) and avoid mixing of undoing the row and cell 

editing commands. 
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Step by Step 

This chapter gives quick „how to‟ instructions for some common tasks of XPS MultiQuant. 

Consult the chapter “Using of the Program” for hints and the chapter “Applied Methods” for 

the theoretical background. The Data wizard (activated by the Tools / Data wizard 

command) may also give short step-by-step instructions online. 

Setting and Saving Default Parameters 

1. On the View menu, click Parameters. 

2. Click the Cross Section tab. Select the preferred cross section or sensitivity factor set. Set 

Splitting and Scaling to None. 

3. Click the IMFP tab. Select the preferred inelastic mean free path correction method and 

fill the required (not greyed) parameters (for common use Exponential method with an 

exponent between 0.5 and 0.7 is suggested). 

4. Click the Angular tab. Select the angular correction method (Reilman) if necessary. Enter 

the angle between the electron analyser and the X-ray source of the spectrometer. 

5. Click the Transmission tab. Select the transmission type of the spectrometer and enter the 

necessary data. 

6. Click the Contamination tab. Select the preferred contamination correction method (for 

common use Mohai is suggested). 

7. Click the Model tab. Select the applied model (for common use Homogeneous is 

suggested). Set Multiline approach to None. 

8. Click the Labels tab. Select the labels routinely used (e.g., Name or Time); select also the 

measure units. 

9. Click the General tab. Select the routinely applied X-ray excitation source. If Other is 

selected, enter also the source energy. Select the Enable library lookup check box. 

10. Click the OK button. 

11. On the File menu, click Save Defaults. 

Notes 

 When the program is started at the first time, none of these parameters is set, i.e., numeric 

values are zeros and methods are None, etc. 

 The default parameters are applied when a new calculation is started. Any of these 

parameters can be changed later at any stage of the calculation. 



32 

Setting up Simple Quantification 

1. On the File menu, click New. 

2. In the Elements window type the chemical symbols and line notations (into separate 

columns) of the elements involved in quantification (e.g., C 1s, O 1s, Cu 2p, etc.). 

3. On the Tools menu, click Library Lookup. 

4. On the View menu, click Intensity. Enter the integrated intensity (peak area) data for each 

experiment. Type the experiment labels (name, etch time, etc.) as well. 

5. On the View menu, click Results. 

6. On the View menu, click Parameters. Click the General tab or 

double click the Title (leftmost) panel of the status bar. 

Enter a descriptive title for the calculation and click the OK button. 

7. On the File menu, click Save As… Enter a filename for the calculation and click the Save 

button. 

Setting up Multiline Calculation 

1. Setup simple quantification as described previously. Enter more than one photoelectron 

lines, if available, for each element (or as many, as possible, e.g., S2s and S2p, Cu2p and 

Cu3p and Cu3s, etc.). 

2. On the View menu, click Parameters. Click the Model tab and select the required 

Multiline approach method (Average for good quality data, Ebel when the weak lines are 

less reliable). 

Notes 

 If the element calculated by multiple lines is present in more than one chemical states, 

data must be provided for all lines and all states (e.g., S2s and S2p for both S
2-

 and S
6+

, 

i.e., totally four lines for sulfur).  

Presenting Results in Various Forms 

1. On the View menu, click Results. 

2. Select the required result type in the dropdown list of the Composition window. 

3. To omit an element from the 100 % sum of the „percentage‟ results, double click the 

chemical symbol or right click the chemical symbol and check Omit. 

4. To select a basis element of the „ratio‟ results, double click the chemical symbol. 

5. Click the up and down arrows of the Number box to change the quantity of basis atoms 

(for „ratio‟ results). 

6. Select the Merge chemical states check box to sum the concentration of different 

chemical states of the same elements. 
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Presenting Results Graphically 

1. On the View menu, click Results. 

2. On the View menu, click Chart. 

3. In the Composition window, double click the label column headers to set X-axis. 

4. In the Composition window, double click the sequence number of any experiment (point) 

to omit it from the chart or right click the sequence number and unselect Visible. 

5. In the Composition window, right click any chemical symbol and unselect Visible to 

remove the element (series) from the chart. 

Printing Reports 

1. On the File menu, click Print…  

2. Select the required data items to be printed. 

3. Click the OK button. 

4. If required, select other result type. On the File menu, click Print Current. 

5. Double click the Pending Page icon on the status bar or  

on the File menu click Print… and click the Eject Page button. 

Notes 

 Selection of items to be printed can be saved by the Save Defaults command. 

 For the first occasion click the Option… button, set the preferred print options (printer, 

page orientation, font) and save them by the Save Defaults command. 

Editing Elements and Experiments 

1. On the View menu, click Elements. 

2. Click the sequence number of the element to highlight a row. 

3. On the Edit menu, click Delete Rows to remove the selected element from the 

calculation. 

4. On the Edit menu, click Insert Row to add a new empty element line above the selected 

row. Fill the line immediately. 

5. On the View menu, click Intensity. 

6. Click the sequence number of the experiment to highlight a row. 

7. On the Edit menu, click Delete Rows to remove the selected experiment from the 

calculation. 

8. On the Edit menu, click Insert Row to add a new empty experiment line above the 

selected row. Fill the line immediately. 
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Notes 

 More than one elements or experiments can be highlighted in order to delete them 

simultaneously. 

 To add a new element or experiment to the end of the calculation set, just fill the last 

empty line in the Elements or Intensity window. 

 The Delete Rows can be revoked by an immediate Undo Delete Rows command. 

Editing Content of Cells 

1. Double click the cell to be edited. 

2. Edit the cell. Use the arrow keys or the mouse to move the text cursor. 

3. Click any other cell in the same window to leave cell edit mode. 

Notes 

 Cell editing is available in the Elements, Intensity, IMFP & Contamination and Model 

windows. 

 Cell editing can be revoked by the Undo command. 

Rearranging Elements and Experiments 

1. On the View menu, click Elements. 

2. Right click the sequence number of the element to be moved and drag the cursor to the 

sequence number of the destination position and release mouse button. 

3. On the View menu, click Intensity. 

4. Right click the sequence number of the experiment to be moved and drag the cursor to the 

sequence number of the destination position and release mouse button. 

Notes 

 During the drag and drop rearranging, the shape of the mouse cursor is changing, to 

indicate the operation in progress. 

Setting up Structured Model 

1. On the View menu, click Parameters. 

2. Click the General tab. Select the Measurement unit as preferred.  

3. Click the Model tab. Select the required model (other than Homogeneous). Set the Sphere 

or Cylinder radius to 0, set the Multilayers to 1. Click the OK button. 

4. On the View menu, click Model. 

5. Enter a descriptive name for each layer (Layer 1 is the topmost one) and the bulk. 

6. Enter the density (g/cm
3
) for each layer and the bulk. 
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7. Specify the composition of the layers: enter the number of atoms for each element 

representing the atomic ratio (like the stoichiometric coefficients) for each layer, including 

hydrogen atoms, starting from the “0 No. H” row. Values can be integers or real numbers. 

8. On the Tools menu click Model / Calculate Molecular Weight. 

9. On the Tools menu click Model / Mark Unused IMFPs. 

10. Enter IMFP values for each layer and the bulk for the kinetic energy of the lines of the 

elements, starting from the “1 IMFP” row. Fill all unmarked cells. 

11. On the Tools menu click Model / Test Model. Correct the listed errors, if any. 

Notes 

 When the Layers-on-Nanotube model is used, both the Sphere or cylinder radius and the 

Tube inner radius must be entered. 

 The geometry correction factors of the Layers-on-Polyhedron model should also be 

defined, as described later. 

Calculating IMFP for Structured Models 

1. On the View menu, click Parameters. 

2. Click the IMFP tab. Select the required Method (Seah-Dench, Tanuma-Powell-Penn, 

Gries, Cumpson-Seah). Click the OK button. 

3. On the View menu, click IMFP & Contamination. 

4. Double click the Material class row for each layer and the bulk until the proper class is 

displayed or enter the first letter of the class names (e, i, p). 

5. Enter the Bandgap energy values for each layer and the bulk (for the Tanuma-Powell-

Penn method only). 

6. On the Tools menu click Model / Calculate Valence Electrons (for the Tanuma-Powell-

Penn method only). 

7. Click the Model window. 

8. On the Tools menu click Model / Calculate IMFPs. 

Notes 

 The Density and Molecular weight rows are the same as in the Model window. 

Calculating Layer Thickness 

1. On the View menu, click Results. 

2. On the View menu, click Chart. 

3. In the Layer Thickness window, double click the number of experiment to be calculated. 

4. In the Layer Calculation window, double click the element symbol selected as basis 

element (an element of the bulk is suggested). 
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5. Type the estimated thickness of the first layer and press ENTER. Repeat with the remaining 

layers and optionally the coverage. After the last ENTER, the calculated intensity values 

are displayed and compared to the measured ones. 

6. Repeat point 5 until reasonable Qsum is achieved. To reuse a previously typed thickness 

value, press ENTER. 

7. Click the Autofit button. 

8. Click the OK button. 

Notes 

 To neglect an element during the automatic calculation, double click the Omit column in 

the Model window (an X appears). 

 To neglect a layer during the automatic calculation (i.e., to keep the manually entered 

value) double click the Link to row in the Model window until Fixed appears. 

Defining Islands 

1. On the View menu click Parameters 

2. Click the Model tab. Select the Islands check box. 

3. Select the Fit coverage automatically check box (if required). 

4. Setup the model as described previously. 

5. In the Model window, double click the Type row to mark layers as Layer or Island. 

Notes 

 To calculate the coverage automatically, one layer in the islands must have at least two 

independent elements. 

Defining Repeated Layer Structures 

1. On the View menu click Parameters 

2. Click the Model tab. Select one of the required „layer‟ model types. 

3. Click Multilayers and select the required repetition number. 

4. Click the OK button. 

5. Setup the model as described previously. Define one unit of the repetitive structure. 

Defining Layers with Equal Thickness 

1. Setup the model as described previously. 

2. Double click the Link to row in the Model window until the sequence number of the 

layer to be linked appears. 
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Defining Angle Dependent Experiment Set 

1. On the View menu click Parameters 

2. Click the Model tab. Select one of the required „planar‟ model types. 

3. Select the Angle dependent experiment set check box. 

4. Click the Labels tab. Click Tilt. Select the required angle unit. 

5. Click the OK button. 

6. Setup the model as described previously. 

7. Calculate layer thickness as described previously. 

Notes 

 The data file must contain one set of corresponding experiments only. 

 When the Angle dependent experiment set is selected, the results are displayed only in the 

first row of the Layer Thickness window. 

Defining Polyhedral Surface Geometry 

1. On the View menu click Parameters 

2. Click the Model tab. Select the Layers-on-Polyhedron model. 

3. Click the Edit button. The Polyhedron Editor window appears. 

4. Select the required angles of polyhedron facets by the slider and enter the projected area 

for each type (as percentage value). 

5. Click the OK button. 

Notes 

 To check or set the 100 % sum of the area values, click the Normalise button. 

 To remove previously entered data, click the Clear button. 

Setting up Oxide-Layer Model 

1. On the View menu, click Parameters. Click the Model tab. Select the Oxide-Layer 

model. Click the OK button. 

2. In the Elements window, type the chemical symbol and line notation (e.g., Si 2p) of the 

main constituent element of the bulk and the layer. 

3. Copy the element to the next row. 

4. Type “Me” and “Ox” into the State column or double click the cells of the State column 

to denote the different chemical states of the same element (metal and oxide, 

respectively). 

5. Enter intensity data, as described previously. 
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6. Set up structured model, as described previously. Define one layer only. 

7. On the View menu, click Results. 

Notes 

 Results are calculated and displayed automatically. 

Setting up Intensity Simulation 

1. Setup a structured model, as described previously. 

2. On the Tools menu, click Simulation. 

3. In the Intensity Simulation window, select the experiment number where results to be 

stored. 

4. Enter the thickness of the layers and the coverage. 

5. Click the Calculate button. 

6. Repeat points 3 – 5 to calculate further experiments. 

7. To study the composition results, calculated by the Homogeneous model, select the Show 

homogeneous composition check box. 

8. Click the OK button to finish simulation. 

Notes 

 If the status of the selected experiment is not Empty, previously entered intensity data will 

be overwritten. 

A photon checks into a hotel and the 

bellhop asks him if he has any 

luggage. The photon replies:  

―No, I’m traveling light‖. 
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Application Examples 

This chapter describes and gives hints on the sample XPS MultiQuant data files included in 

the distribution kit. These files are usually located in the \Program Files\XMQ\Samples 

folder. These examples illustrate the various features of the program. A brief description is 

also included into the Notes text of each file. Example files have some „magic‟ when opened 

by the Open Example… command. The Notes window and other subwindows are activated 

automatically and the result format is set, as appropriate for the selected data. 

Contact  (Contact.mqd) 

These XPS spectra were recorded on an electrical contact prepared on a silicon wafer from 

titanium and silver. The sample was heat treated causing diffusion of the components. The 

upper layers were oxidised and the top surface was contaminated by carbon. Ion etch series 

were performed by 2 keV Ar
+
 ions in 2 min steps. 
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The ion etch depth profile reflects the changes seen on the previous figure. Beside the 

intensity (height) changes of the lines, consider alterations in FWHM as well; this explains 

the shallower concentration differences visible in the Ti profile. The reduction of the system 

can be seen from not only the chemical shift changes but the decreasing oxygen balance, as 

well. 
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This example illustrates of the simple handling and fast calculation of large data sets. Test the 

different results formats. When ratio types are used, be careful of the zero intensity data. The 

printed depth profile was prepared by Microsoft Excel as demonstrated by the 

ContactProfile.xls file. 

NaCl – Simple Multiline  (NaCl-multiline.mqd) 

Spectra were measured on a freshly cleaved NaCl single crystal with low level of carbon and 

without oxygen impurities. 

The concentration of sodium is calculated using either the 1s or 2s line; or both lines. In the 

latter case, the average of the raw results is calculated for all lines of matching elements and 

chemical states. The intensity and basic data are reliable for both sodium lines thus almost no 

difference can be observed when the multiline approach method is changed from Average to 

Ebel, as shown in the next table (atomic ratio). 

 Na Cl C 

Na1s only 0.95 1.00 0.04 

Na2s only 1.00 1.00 0.04 

Both (Average) 0.97 1.00 0.04 

Both (Ebel) 0.97 1.00 0.04 
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Cu-Ag-Au Alloy – Weighted Multiline  (CuAgAu.mqd) 

A ternary Cu-Ag-Au alloy was prepared by grinding. XPS spectra were measured after 10 s 

Ar
+
 ion sputtering, which removed majority of carbonaceous contamination. Intensity and all 

basic data, including cross sections, asymmetry parameters and transmission function, were 

obtained from the literature [6]. The measured Cu3p (MgKα1,2) line was superimposed with 

the Au4f (MgKα3,4) X-ray satellite; thus, the intensity of the Cu3p line was corrected by 10 % 

of the Au4f intensity (“Sat corr”). 

There are significant differences between the concentrations calculated with different lines 

(multiline approach method is set to None), thus application of weighted average (Ebel) is 

advisable. 

The concentrations (mass %) calculated by the authors [6] and by XPS MultiQuant (satellite 

corrected), shown in the next table, are in good agreement. 

 Cu Ag Au 

Chemical analysis 40.0 50.0 10.0 

No satellite correction 39.4 50.4 10.2 

Satellite correction 39.2 50.6 10.2 

XPS MultiQuant (Ebel) 40.7 49.5 9.8 

XPS MultiQuant (Average) 37.6 51.4 10.9 

NaCl – Scaling of Na1s Cross Section  (NaCl-scaling.mqd) 

Spectra were measured on a freshly cleaved NaCl single crystal. It was practically free from 

contamination with a low level of C and O impurities only. 

This example illustrates of using of the scaling feature. The cross section data set of Evans 

does not contain data for the Na1s line. However, switching on scaling, rough results can be 

obtained. Compare the two scaling methods to the results calculated from the Na2s line. 

Oxidised Si  (Si-wafer.mqd) 

Spectra were measured on a silicon wafer covered with a native oxide and a hydrocarbon 

contaminant layers. 

The Layers-on-Plane model was applied to calculate the thickness of the layers. The 

composition of the layers was assumed to be SiO2 and CHx. For checking purposes, the layer 

thickness values were also calculated after the decomposition of the Si2p line into 

components representing the elemental and oxidised chemical states. Both calculations 

produced realistic and comparable results. 

Calculation method d SiO2
 (nm) d CHx

 (nm) 

from total intensity 1.39 2.27 

from decomposed Si2p intensity 1.36 1.90 

For details about how to perform of the calculations, see chapters “Application of Structured 

Models” and “Layer Calculation”. 
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SiO2 contamination  (SiO2-contam.mqd) 

XPS data were measured on a thermally oxidised Si wafer. The sample was totally oxidised 

and no elemental silicon could be detected. It was treated by low-pressure oxygen plasma to 

remove residual carbon and reach the stoichiometric Si:O = 1:2 ratio. After measuring the 

clean state of the sample, hydrocarbon contamination of increasing thickness was deposited 

by casting of polystyrene from benzene solution in subsequent steps. The compositions of the 

samples (atomic ratio) were calculated with different contamination correction methods. 

Correction 

method 
Sample treatment Si O C 

Difference 

from SiO2 

None  As is 1.00 1.76 0.43 -13.6 % 

  O plasma 1.00 2.02 0.20 1.0 % 

  Polymer 1 1.00 1.66 2.95 -20.5 % 

  Polymer 2 1.00 1.49 3.81 -34.2 % 

  Polymer 3 1.00 1.31 6.01 -52.7 % 

Evans  As is 1.00 1.97 0.44 -1.5 % 

  O plasma 1.00 2.26 0.21 11.5 % 

  Polymer 1 1.00 1.85 3.07 -8.1 % 

  Polymer 2 1.00 1.66 3.96 -20.5 % 

  Polymer 3 1.00 1.46 6.25 -37.0 % 

Mohai  As is 1.00 1.89 0.44 -5.8 % 

  O plasma 1.00 2.08 0.20 3.8 % 

  Polymer 1 1.00 2.18 3.24 8.3 % 

  Polymer 2 1.00 2.04 4.26 2.0 % 

  Polymer 3 1.00 1.91 6.85 -4.7 % 

This example illustrates of application of the different contamination correction methods. Try 

to change methods in the Contamination tab in the Parameters window and compare the 

results. 

Contaminated PET textile  (PET-contam.mqd) 

XPS data measured on poly(ethylene terephthalate) textile. The surface is contaminated, as 

can be seen from the comparison the measured data and the theoretical composition. 

Correction for the contamination (Mohai method) would be required but the intensity 

contribution of the hydrocarbon component and the adventitious carbon cannot be separated. 

As the theoretical composition is known, intensity of hydrocarbon can be split (using the Split 

Intensity window) between the hydrocarbon of the molecule and the contamination, until the 

composition is getting as close as possible to the theoretical one. 
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Cr-O-Si Cermet Film  (Cermet.mqd) 

Cr-O-Si cermet films are widely applied in microelectronics devices. Such layers were 

prepared by RF-sputtering of a Cr:O:Si target with a nominal atomic ratio of 1:1:1 onto 

thermally oxidised silicon wafers. 

XP spectra of the characteristic lines (Cr2p, Si2p, O1s, C1s) were recorded. Ion 

bombardments were performed by 2 keV Ar
+
 ions. Composition, expressed in Oxide molar 

ratio, was calculated for assumed combinations: Cr2O3+SiO2, Cr2O3+Si and Cr+SiO. The 

Oxygen balance values of the different settings are depicted on the figure as a function of the 

bombardment time. 

The chart revealed that the top surface is totally oxidised, i.e., Oobs/Ocal ≈ 1 for the assumed 

Cr2O3+SiO2 compounds. After 10 min bombardment, the top layer is removed and the former 

composition gives unrealistic oxygen deficiency. The new composition of the layer is close to 

either of the Cr2O3+Si or Cr+SiO (or also CrO+Si) supposed structures.  
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Further bombardment does not change the composition. Chemical shifts of the photoelectron 

lines will determine the correct chemical structure but this method can reduce the choice, 

discard unrealistic combinations and by this backs the peak decomposition procedure. 

To calculate the Oxygen balance for the above assumed compositions (in three separate runs), 

set the Valence and Oxygens columns in the Elements window as follows: 

 Cr Valence Cr Oxygens Si Valence Si Oxygens 

Cr2O3 + SiO2 3 3 4 2 

Cr2O3 + Si 3 3 0 0 

Cr + SiO 0 0 2 1 

Data of this sample are used to illustrate of pasting XPS MultiQuant data into Microsoft Word 

documents (see the CermetDocument.doc file). 
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Al2O3 on Aluminium  (Al-Layers.mqd, Al-Oxide.mqd) 

XPS data recorded at 0 and 60 degrees take-off angles on rolled aluminium foil covered with 

oxide layer and carbonaceous contamination. 

Thickness of the alumina layer was calculated both by the Layer-on-Plane model with various 

settings (with and without oxygen, as angle dependent set) and by the Oxide-Layer model. 

To calculate the experiments together, select the Angle dependent experiment set check box in 

the Model tab of the Parameters window. To include and exclude oxygen, double click the 

"O" row of the Omit column in the Model window. 

The results of the calculations are slightly different due to the oxygen surplus (OH groups) 

and the low intensity of metallic Al at 60° angle. The thickness values calculated by the 

Oxide-Layer model are the same as calculated by the Layers-on-Plane model without using of 

the oxygen. 

Model 

Tilt angle d CHx
 (Å) d Al2O3

 (Å) 

Layers-on-Plane 0° 14.29 67.01 

(with oxygen) 60° 14.21 57.54 

 ARXPS 14.27 67.02 

Layers-on-Plane 0° 17.53 61.95 

(without oxygen) 60 15.63 55.83 

 ARXPS 16.41 63.26 

Oxide-Layer 0° – 61.95 

 60° – 55.83 

Angle Dependent Set on Silicon Single Crystal  (Si-ARXPS.mqd) 

XPS data were recorded at various take-off angles (0°, 30°, 60°) on a silicon wafer covered 

with a native oxide and a hydrocarbon contaminant layers. The Si2p lines were decomposed 

to SiOx and Si components. 
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Thicknesses of the oxide and contaminant layers were calculated by the Layers-on-Plane 

model with the Angle dependent experiment set feature. 

The surface of the sample showed oxygen surplus, thus the composition of the oxide layer 

was selected as SiO2·SiO(OH)2. Applying of SiO2 layer composition gives practically the 

same results but the differences between the measured and calculated oxygen intensity values 

are larger. 

When Angle dependent experiment set is selected, all experiments calculated together and the 

results are displayed only in the first row of the Layer Thickness window. 

Si3N4 Powder  (SiN-powder.mqd) 

XPS data were recorded on silicon nitride powder samples prepared by various 

manufacturers. These powders consisted of nearly spherical particles. The structure of the 

particles was assumed as follows: a core of Si3N4 is surrounded by a SiO2 layer and a 

carbonaceous (CHx) contaminant layer. Application of the Layers-on-Sphere model gives 

realistic results, while the Layers-on-Plane model overestimates the thickness of the layers 

providing higher, usually improbable values. 

Sample 
Spherical model Planar model 

d CHx
 (Å) d SiO2

 (Å) d CHx
 (Å) d SiO2

 (Å) 

A 10.83 1.84 16.92 2.36 

B 3.95 16.51 6.73 23.50 

C 4.82 8.39 8.06 12.12 

D 5.06 1.56 8.46 2.27 

E 7.32 19.16 11.88 26.14 

F 6.89 3.75 11.23 5.28 

G 12.74 2.51 19.59 3.19 

Some hints to perform these calculations: First switch to Homogeneous model to estimate 

quantity of the different components. Higher oxygen content means higher SiO2 layer 

thickness, etc. Then switch back to the Layers-on-Sphere model; estimate the layer thickness 

and step by step refine the fitting, minimising the Qsum value. 

Simulation of Angle Dependent Set  (SiO2-simulation.mqd) 

The assumed sample is a silicon wafer covered by silicon dioxide and carbonaceous 

contamination layers, measured at various tilt angles. The example file is ready for the angle 

dependent intensity simulation. Angle values are already entered into the Tilt label set in the 

Intensity window before the calculation. The intensity of oxygen (or any other element) is set 

to 1 (or any other number larger than zero) to prevent deleting of empty (all zero) experiments 

by the automatic counting. During the simulation, do not select the Angle dependent 

experiment set checkbox in the Model tab of the Parameters window. 

Invoke the Intensity Simulation window and enter identical set of thickness values for each 

experiment. (Keep in mind that these are corresponding experiments on the same sample.) 

When the calculations are ready, the Angle dependent experiment set checkbox can be 

selected to calculate the layer thickness based on all experiments. 



46 

Surface Modified Carbon Nanotube  (C-nanotube.mqd) 

Commercial, thin multi-wall carbon nanotubes, with 9.5 nm external and 7 nm internal 

diameters were treated in low pressure RF plasma in N2 flow. Negative DC bias of 50 V was 

applied through the sample holder. 

The upper layers of the tube wall were converted into N-containing layer thus the Modified 

tube layer variant of the Layers-on-Nanotube model was applied to calculate the layer 

thickness. 

The composition of the formed CNx layer was selected as C3N2, based on measurements on 

similarly treated, freshly cleaved highly oriented pyrolytic graphite sample. The penetration 

depth of the N
+
 ions with 25 eV energy in carbon was calculated by the SRIM 2006 program. 

The calculated depth (sum of the projected ion range & straggle) is 0.6 nm, which is very 

close to the layer thickness calculated from the intensity data of the XPS measurement 

(0.66 nm), confirming by this the validity of the calculation.  

Langmuir-Blodgett film  (LB-film.mqd) 

Cadmium arachidate, Cd(C19H39COO)2, Langmuir-Blodgett (LB) film with four 

monomolecular layers were deposited on trimethyl-silylated glass substrates
 4

. 

The Layers-on-Plane model was applied with the following arrangement: the Cd-arachidate 

monolayer was considered as two sublayers due to the dissimilar nature of the two parts of the 

molecule. The physical constants (molecular mass, density, IMFP) of the octadecane (C18H38) 

and the cadmium acetate (Cd(COOCH3)2) were used for the hydrocarbon chain and the 

hydrophilic part of the molecule, respectively. In the program a double arachidate layer was 

implemented by three sublayers, as shown in the figure; and two of these structures were 

applied for the calculation of the 4L samples, setting the Multilayers attribute to 2. 
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Although the calculated monolayer thickness (26.7 Å) is less than the proper value (28 Å) 

reported in the literature
5
, it can be explained by the tilted position of the molecules

4
. 

 
4  M. Mohai, É. Kiss, A. Tóth, J. Szalma, I. Bertóti: Preparation and Characterisation of Langmuir-Blodgett Type 

Arachidate Films, Surf. Interface Anal. 34 (2002) 772. 

5  M. Sastry, P. Ganguly, S. Badrinarayanan, A. B. Mandale, S. R. Sainkar, D. V. Paranjape, K. R. Patil, S. K. Chaudhary: 

Attenuation length measurements in lead arachidate Langmuir Blodgett films, J. Appl. Phys. 70 (1991) 7073. 
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Applied Methods 

This chapter summarises all calculation methods and formulae built into the XPS MultiQuant. 

All of the methods are described in details in the referred papers. 

Homogeneous Model 

0

x



e-

h
φ -θπ

2

 

The intensity of the photoelectron line excited from the infinitesimal thin layer of an infinitely 

thick sample is described by Equation (1): 

 dxcosθx-ΦσNkexpdI λ  (1) 

where I is the intensity, Φ is the X-ray flux, σ is the photoionisation cross section, N is the 

number of atoms per unit area, k is an instrument factor, λ is the inelastic mean free path 

(IMFP), θ is the angle between the exiting electrons and the surface normal and x is the 

distance perpendicularly below the sample surface [1, 2]. Integrating the above by x from 0 to 

infinity, the total intensity can be determined: 

cosθΦσNkI λ  (2) 

If the sample is covered with an overlayer of d thickness, e.g., surface contamination; 

Equation (1) must be integrated from 0 to d and from d to infinity to get the intensity from the 

surface layer (3) and the bulk (4): 

  θd1θΦσNkI s cosexpcos λλ   (3) 

 cosθdexpΦσNkλcosθI b λ  (4) 
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In the practice, instead of absolute intensity, intensity ratios are used thus the constant, i.e., 

energy independent parts of the equations (Φkcosθ) can be neglected. The measured intensity 

should also be corrected by the transmission function of the analyser (and also detector 

sensitivity), by the cross section (which accounts for electrons exited into every directions, 

i.e., 4π sr solid angle) and for the angle of detection. Thus, the relative concentration of atom i 

in an infinitely thick homogeneous sample covered by surface contamination can be 

calculated from the total intensity by the following equations: 

i

i
i

F

I
N   (5) 

   iiiiiii cTβφ,LσF λλ  exp  (6) 

where Ii is the measured integral intensity of element i and Fi is the sensitivity factor which 

consist of the following terms: σi is the relative photoionisation cross section (function of 

photoelectron transition), L(φ,βi) is the angular correction factor (function of the asymmetry 

parameter, β and the direction of observation, φ), λi is the IMFP (function of the matter and 

kinetic energy), Ti the transmission correction (function of the kinetic energy) and c is the 

correction for surface contamination (proportional to the layer thickness). 

Each term of the sensitivity factors can be controlled independently. When None is selected in 

the program for any of the above terms, the corresponding value is set to 1. 

Cross Sections 

Experimental cross section data of Evans [3] were measured with 90° excitation-analyser 

angle. To correct it to the 4π sr solid angle the Equation (7) is applied, which is derived from 

Equation (11) for 90° angle. 

 4β1

1
σσ E


  (7) 

where σ is the total relative photoionisation cross-section, σE is Evans‟ cross-section and β is 

the asymmetry parameter. 

Wagner‟s sensitivity factors for the secondary lines are multiplied by 0.9 for Mg Kα and by 

1.1 for Al Kα excitation [1]. The primary lines are the strongest ones while secondary lines 

are the 2s, 3p, 4p, 4d (except from Dy to Lu) and 5d lines. 

When the experimental cross section or sensitivity factors are used, some data may be missing 

from the data set. In these cases, for rough approximation, splitting and scaling of 

experimental data are implemented in the program. 

Cross section of the doublet lines of the experimental data can be split to its components, e.g., 

3d to 3d3/2 and 3d5/2, using the corresponding theoretical ratio (Equation 8) or by the nominal 

ratio values (1:2 for p lines, 2:3 for d lines, etc.). 

th
2

th
1

th
iex

sum
ex
i

σσ

σ
σσ 


  (8) 

where σi
ex

 is the (split) experimental cross section of either doublet component, σi
th

 is the 

theoretical cross section of the same doublet component and σ ex
sum the experimental cross 

section of the doublet line. 
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When the data for a required line is not included in the experimental data set, the user may try 

to scale the available theoretical data to the applied set. This can be done by the ratio of the 

closest line (Equation 9) or by an average factor (Equation 10). 

th
j

ex
jth

i
ex
i

σ

σ
σσ   (9) 


j

th
j

ex
jth

i
ex
i

σ

σ

j

1
σσ  (10) 

Although splitting usually provides reliable data, scaling is considered as a rough estimation 

only. Use scaled data only when there is no other possibility and restrict use for minor 

components. The „closest‟ line can be as far as 1000 eV from the „basis‟ line, so try both 

scaling methods and choose the more probable one. 

Angular Correction 

This correction is calculated by the method of Reilman et al. [4] using Equation (11): 



















2

1
φ

2

3

2

β
1

4

1
L 2cos

π
 (11) 

where β is the asymmetry parameter and φ is the angle between the excitation source and the 

analyser entrance slit. 

Correction for Elastic Scattering 

This correction is calculated by the method of Ebel et al. [5, 6] using Equation (12): 

 A0.00933561.0205ββ *  exp  (12) 

where β
*
 is the effective asymmetry parameter and A is the atomic weight for elements or the 

effective atomic weight for compounds: 


j

jjef f Ax
100

1
A  (13) 

xj is the atomic percent of element j. First xj is calculated without correction. The effect of this 

factor is usually about a few percent or less. 

Inelastic Mean Free Path (IMFP) 

Beside the known and explicitly given inelastic mean free path values of the material 

examined, the IMFP can also be calculated by several methods. 

The program expresses the calculated inelastic mean free path in Å or nm unit, as selected by 

the user (except the first two methods, where a proportional number is estimated instead of 

the proper  IMFP value). 
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Exponential 

A simple exponential function can be used, which is proportional to IMFP. 

aE λ  (14) 

where E is the kinetic energy (eV). The exponent a, being usually between 0.5 and 0.9, can be 

freely selected by the user. 

Jablonski 

Jablonski [7] also uses exponential approximation with pre-set exponents for three material 

classes, enumerated in the next table. 

Material class Exponent 

Element 0.7283 

Inorganic compound 0.7234 

Polymer 0.7665 

Seah-Dench 

Seah and Dench [8] also calculate the IMFP for the three above classes using Equations (15)-

(17) for elements, inorganic materials and polymers, respectively. 

  21

2
aE0.41

E

538
 λ  [monolayers] (15) 

  21

2
aE0.72

E

2170
 λ  [monolayers] (16) 

21
2

E0.11
E

49
 λ  [mg∙m

-2
] (17) 

where E is the kinetic energy (eV) and a is the average monolayer thickness in nm calculated 

by Equation (18). 

3
602

M
a 




ρ
 (18) 

where M is the mean molecular weight and ρ is the density in g∙cm
-3

 unit. The numerical 

factor is derived from Avogadro‟s constant. 

Gries 

Gries [9, 11] developed the following G-1 Equations (19)-(21) for the prediction of the IMFP: 

   2

*

a1 kEEZVk10  logλ  (19) 

where Va is the atomic volume (cm
3
∙mol

-1
), Z

*
 is a parameter found empirically equal to Z

1/2
, 

Z is the atomic number, k1 and k2 are parameters. The terms Va and Z
*
 are generalised to apply 

for compounds, ApBq…Cr: 
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   rqpZrZqZpZ 1/2
C

1/2
B

1/2
A

*    (20) 

   rqpMrMqMpV CBAa   ρ  (21) 

where p, q, … r are the stoichiometric coefficients of elements A, B, … C, respectively, M is 

the atomic weight, ρ is the density (g∙cm
-3

). The values of the k parameters for the different 

material classes are listed in the next table. 

Material class k1 k2 

Elements 3d (Ti-Cu) 0.0020 1.30 

 4d (Zr-Ag) 0.0019 1.35 

 5d (Hf-Au) 0.0019 1.45 

 other (also Y) 0.0014 1.10 

Inorganic compounds 0.0019 1.30 

Organic compounds 0.0018 1.00 

For the Seah-Dench and Gries methods, if a material is actually an element, IMFP is always 

calculated with parameters of the Element class, despite of the selected one. While the 

material, selected to be as Element, is being in fact a compound (i.e., contains more than one 

element), parameters of the Inorganic class is applied. The significance of the calculations, 

according to the real and the selected material classes are summarised in the next table. 

Selection of 

Material class 

Calculated IMFP when the material is 

Element Inorganic Polymer 

Element OK acceptable erroneous 

Inorganic acceptable OK erroneous 

Polymer acceptable erroneous OK 

Tanuma-Powell-Penn 

Tanuma, Powell and Penn [9, 10] proposed the following equations for calculating the IMFP 

as a function of electron kinetic energy and various material parameters. Equations (22)-(28) 

are collectively known as TPP-2M formula. 

][ )(D/E(C/E)E)(E

E

p

22 γβ
λ




ln
 (22) 

where E is the kinetic energy (eV), Ep is the free-electron plasmon energy (eV) and 

  0.1212
g

2
p 0.069EE0.9440.10 ρβ   (23) 

0.500.191  ργ  (24) 

U0.911.97C   (25) 

U20.853.4D   (26) 
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829.4EMNU 2

pv  ρ  (27) 

  21
vp MN28.8E ρ  (28) 

where ρ is the density (g∙cm
-3

), Nv is the number of the valence electrons per atom or 

molecule, M is the molecular weight, Eg is the bandgap energy (eV). 

For assessing of the uncertainties of the IMFP values calculated by the two latter methods, see 

literature [9] and the references therein. 

Cumpson-Seah 

Cumpson and Seah [12] developed the CS2 semi-empirical Equation (29) to calculate 

attenuation length in any solid over the energy range 100–2000 eV. These equations take 

account of the correct low-energy elastic scattering behaviour of large Z elements. 

   















 4

327EZ

E
a0.316

0.45

23
AL

ln
λ  (29) 

where a is the lattice parameter (or monolayer thickness), calculated by Equation (18), E is 

the kinetic energy, Z is the average atomic number. 

Transmission Function 

In the first approximation, the analyser transmission (T) is proportional to a function of the 

kinetic energy. This function is usually exponential. 

aET   (30) 

where a can be selected by the user or is pre-set for some frequent cases. 

More precise approximation of the analyser transmission function can be applied by 

exponential, polynomial or rational [13] functions or the combinations of the above [14], 

optionally with different coefficient sets for different kinetic energy ranges. In the latter cases, 

transmission is calculated by Equations (31) – (34). 
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210   (34) 

For the last two equations ε is calculated by: 

  10001000Eε   (35) 

The coefficients of the equations with the corresponding limits of energy ranges are stored in 

separate files. See chapter “Structure of the Transmission Files” in “Program References”. 
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When the transmission function is not available analytically, it can be provided in tabular 

form as well. The actual transmission factors are calculated by linear interpolation.  

There is no separate term in the program to describe the detector sensitivity as the function of 

the kinetic energy. If this factor cannot be neglected (e.g., in the case of fixed retarding ratio 

analyser mode), it should be incorporated into the transmission function. 

Contamination Correction 

The surface contamination of the samples, which usually consists of carbonaceous material, 

can be taken into account by various methods. Evans [3] uses the  

 0.5Ec exp  (36) 

factor with a constant c = 14.3 value. It can be applied for most of the cases when the sample 

is stored in ambient and a „saturated‟ level of contamination (≈ 1 nm thick) is developed. 

For clean, practically carbon free, e.g., freshly cleaved or ion etched samples, or on the 

contrary, for strongly contaminated ones this factor does not provide proper correction. In 

these cases method of Mohai [15] can be applied where c is a function of the normalised 

carbon concentration: 

  bCac at%   (37) 

Factors are calculated in two-step iteration. First [Cat%] is calculated with c = 0; next [Cat%] 

values are used to calculate c factors by Equation (37). This method is applicable up to ≈ 5 nm 

thickness of the contaminant layer. 

To avoid the numerical misfit of the factors due to the various IMFP calculation methods, 

providing either the absolute or a proportional value, in the contamination correction term of 

Equation (6) instead of the applied IMFP, a value relative to the carbon is used (38). 

  Ciii cF λλ exp  (38) 

where λC is the inelastic mean free path of the C1s photoelectron line in the sample. 

The user can also set the correction factors manually, i.e., enter values proportional to the 

thickness of the contaminant layer for each experiment. 

Multiline Approach 

The influences of statistical and systematic errors of XPS quantification can be reduced by 

introducing as many photoelectron lines as possible for each element and calculating the 

average of the results evaluated separately. 

It can be done by simple averaging the unnormalised results for all lines of each element, as 

shown by Equation (39). 

 
k

k
ii N

k

1
N  (39) 

where Ni is the average unnormalised concentration of element i, Ni
k
 is the unnormalised 

concentration of element i calculated from line k. 

When applying the method of Ebel et al. [6], data points are weighted by the square root of 

the intensity, representing the strong signals by heavier weight as compared to weak ones. To 
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find the optimal unnormalised concentration, the weighted error quantity, shown by Equation 

(40), is minimised for each element. 
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where I is the measured integral intensity, F is the sensitivity factor, N is the unnormalised 

concentration. The i index stands for the elements and the k for the lines of that particular 

element. 

Averaging can be ignored, even with multiple lines, by selecting the Main method: 

composition is calculated using only the main (most intensive) lines of the elements. The 

presence of elements with multiple lines and the selected Multiline approach method must be 

corresponding, as shown in the next table. 

Multiline approach  

method 

Elements with multiple lines  

Not present  One or more present 

None 

Normal calculation Percentage results are meaningless, 

although the discrepancies among 

lines due to intensity uncertainties can 

be revealed. 

Average,  

Ebel  

No error, the calculated 

composition is accurate. 

Average composition is calculated, as 

selected. 

Main 
No error, the calculated 

composition is accurate. 

Composition is calculated using the 

most intensive lines only. 

Normalisation of the Composition Results 

The applied quantification gives relative concentrations thus the results should be normalised. 

The results can be displayed in various forms as required by the further applications. The 

meanings of R variables in the following equations are the same (i.e., normalised 

concentration), although their numeric values are different. 

Atomic % 

100
N

N
R 

j
j

i
i 


 (41) 

where Ni is the relative concentration of element i (from Equation 5) and Ri is the normalised 

relative concentration. The j index is varied from 1 to the number of elements. 

Atomic Ratio 

b
b

i
i n

N

N
R   (42) 

where Nb is the relative concentration and nb is the number of atoms of the selected „basis‟ 

element. This mode supplies the coefficients of the stoichiometric formula. 
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Oxide Molar % 

100
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jj

ii
i 


 (43) 

where oi is the number of atoms i in one oxide molecule, calculated as oi = 2 ni / vi, where ni is 

the number of oxygen atoms and vi is the valence. 

Oxide Molar Ratio 
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  (45) 

where wi is the atomic weight of element i. 

Mass Ratio 

b
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
  (46) 

Oxide Mass % 
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 (47) 

where wo is the atomic weight of oxygen. 

Oxide Mass Ratio 

 
  b

obbb

oiii
i n

2wvwN

2wvwN
R 




  (48) 

When one of the „percentage‟ forms is selected, any element can be omitted from the 100 % 

sum, and the remaining elements are re-normalised to 100 %. For the „ratio‟ type results any 

element can be selected as basis. 

Oxygen Balance 

When one of the oxide-type normalisation is selected, the oxygen balance, the ratio of the 

measured and calculated oxygen concentrations, is displayed. If it is less than 1, the surface is 

deficient in oxygen; if it is greater than 1, there is oxygen surplus. The omitted elements, 

including oxygen, are excluded from the oxygen balance calculation. 
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Models for Structured Surfaces 
When the surface of the sample is covered by one or more thin overlayers (the whole structure 

should be thinner than the information depth of the XPS measurement) and the compositions 

of these layers are known, the thickness of the layers can be estimated from the photoelectron 

intensity. The program solves the inverse task: the relative intensity values are calculated 

from the layer thickness.  

The measured intensity data are corrected for cross section, angular distribution and analyser 

transmission using Equation (5) with the following sensitivity factor: 

  iiii Tβφ,LσF   (49) 

The number of atoms per unit volume (Ni) is calculated by the following formula: 

M
nN ii

ρ
  (50) 

where ni is the stoichiometric coefficient of atom i, M is the molecular weight and ρ is the 

density in g∙cm
-3

. 

Molecular weight and density values should be supplied for each layer, also stoichiometric 

coefficients and explicit IMFP values for each layer and element (i.e., kinetic energy). 

Contamination correction can be implemented by defining an explicit contaminant layer. 

1 to 5 layers and the bulk can be defined in the program but for materials with repeated 

structure, the defined layer system can be multiplied also by a factor from 1 to 5. 

The calculated intensity ratios can be fitted to the experimental ones either manually, by 

interactive iterations; or automatically by, least square fitting procedure. To help finding the 

best fit of the intensity, the difference (Diff %) between the calculated (Icalc) and measured 

(Iobs) intensity and the sum of the squares of the differences (Qsum) are also calculated: 

100
I

II
%Diff

obs

obscalc 


  (51) 

 
i

2
obscalcsum IIQ  (52) 

where the i index stands for the elements. Diff% is displayed only when smaller than ±100 %. 

Graphic tools are also available (see chapter “Model” in “Program References”). 

The actual number of the applied equations calculating intensity depends on the number and 

distribution of the elements in the layers. For a definite system, where the number of 

independent equations is equal or greater than the number of variables, at least one 

independent element per layer is necessary (n+1 elements for n layers and bulk). For Island 

type models one more elements is necessary in one of the islands to calculate coverage. 

Intensity data of elements being present in more than one layers are summed unless its spectra 

can be decomposed into different chemical states (use the State column settings in the 

Elements window). Sometimes the system cannot be well defined, e.g., single element islands 

on a single element substrate. In these cases, consider applications of different calculation 

methods, like Tougaard‟s QUASES program, or record spectra at more than one take-off 

angles. 
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The Autofit procedure minimizes the sum of the squares of m non-linear functions (number of 

layers) in n variables (number of elements, m ≤ n) by a modification of the Levenberg-

Marquardt algorithm [16]. The Jacobian matrix is calculated by a forward-difference 

approximation. The procedure is called repeatedly with decreasing tolerance limits until the 

best fit is achieved. Unless the model system is converging very slowly, this method supplies 

the optimal fit in one step. 

If the convergence is slow, Autofit may stop due to reaching the allowed maximum number of 

iterations without obtaining a solution to the accuracy specified. Try to invoke Autofit some 

more times. The slow convergence may indicate that the model does not describe properly the 

examined system. 

When the Modified tube layer variant of the Layers-on-Nanotube model is used, the above 

iterations are nested into an external cycle, which iterates the wall thickness of nanotube. As 

this model can be applied only for one layer, the convergence is usually not slower than in 

simple cases. 

There are some other characteristics to assist defining more complex models. If there is some 

„a priori‟ knowledge on the relation of the various layers, thickness of the different layers may 

be declared to be equal or can be kept constant. Elements or layers can be excluded from the 

automatic fit calculation, if necessary. 

When a set of layers is repeated in sequence on the sample, it is enough to define one 

repeating unit and to set the number of the repetitions. E.g., two layers are defined in the 

Model window and the Multilayers attribute is set to 3 in the Model tab of the Parameters 

window, then a six-layer system is calculated, as illustrated in the next figure. 

  

 Defined Calculated 

The fitting routine is not restricted by the physical meaning of the parameters. When any of 

the results seems to be unrealistic (e.g., a negative or too large layer thickness) a warning 

message is displayed. 
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Layers-on-Plane Model 
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The photoelectron intensity emitted from a flat, infinitely thick sample covered with 

overlayers of d1, d2 … thickness can be calculated by equations similar to (1)-(4). 

For example, intensity of elements i, j and k from a flat bulk sample (B) covered by two 

overlayers (S1 and S2) are expressed by: 
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where λi
S1 means the inelastic mean free path of the electron emitted from element i in the 

matrix S1, etc. Other symbols are defined at Equations (1)-(4). 
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Layers-on-Sphere Model 
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The calculation of photoelectron intensity excited from a spherical surface covered by 

overlayers is similar to the calculation of flat samples. However, the effective thickness of the 

layers (the virtual thickness seen from the direction of electron analyser) is varying from point 

to point along the sphere. Thus the intensity, originating from the various zones of the sample, 

should be weighted by a geometry correction factor, taking into account the projected areas 

corresponding to different thickness. 

The integral describing the intensity of emission from a hemisphere cannot be solved 

analytically therefore the latter is divided into 9 segments of 10° [17, 18]. Every segment is 

represented its middle angle (5°, 15°, 25°, etc.). If the radius of the sphere is large enough 

(R > 1000 d), it can be neglected from the Equation (56) describing the effective d eff
. 

αcos

ief f
i

d
d   (56) 

If the radius of the sphere is smaller (but still R >> 3λ), it must be supplied by the user and 

d eff
 is calculated by Equation (57). 
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where R is the total radius (bulk plus layers) and the term R-Σdj stands for the radius of the 

core under the current layer. If the radius is even smaller, i.e., R ≈ 3λ, this model cannot be 

applied because there is no „bulk-like‟ material. 

After intensity values being calculated for every segment, they are weighted by the 

corresponding geometry correction factors (G1, G2, etc.; see the previous figure) describing 

the projected area of the spherical zones. 

The flattened surface of powder samples is similar to the closest packed plane of the 

hexagonal lattice. The specific feature of this section is that some parts of the second and third 

rows of spheres below the top one are also visible partially, as illustrated in the following 

figure. The geometry correction factors (Gi) also include these contributions. 

 

If the sample consists of relatively large spheres (e.g., small balls) arranged in one row, the 

latter correction can be turned off. In this case, the material of the sample holder is visible 

among the spheres, thus it should not contain any element of the sample, including the 

possible contaminations (carbon, oxygen, etc.). Using a piece of gold foil is usually advisable. 

 

When this model is applied, the angle of emission (take-off angle) cannot be varied, i.e., the 

sample must be observed from the direction of the surface normal (θ is zero and cosθ = 1). 
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Layers-on-Cylinder Model 
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The description of photoelectron intensity from a cylindrical surface covered by overlayers is 

similar to the spherical ones [18]. In this case, the shapes of the projected surfaces are 

rectangles instead of annuli for spheres (see the figure above) and in closely packed 

arrangement the lower rows are not visible partially; even in the case of crossing cylinders.  

 

Thus, the way of the calculation for spheres and cylinders, performed by the program, are 

similar but the values of the geometry correction factors are different. This kind of sample 

must also be observed from the direction of the surface normal. 
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Layers-on-Polyhedron Model 
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Rough surfaces with macroscopic or microscopic structures can usually be modelled by small 

planar units at different angles, i.e., facets of one or several types of polyhedra. The Layers-

on-Polyhedron model [19] allows defining various surface geometry. From the point of view 

of quantification, only the relative sizes of the projected areas and the tilt angles of the 

different facets (measured from the base plane normal) are relevant. (The projection plane is 

the virtual base plane of the sample supporting the polyhedra. 

The calculation of photoelectron intensity values excited from a polyhedral surface covered 

by overlayers is similar to the calculation of other structured models but while in case of 

spherical and cylindrical models the geometry correction factors are predefined, here the 

factors should be defined by the user. The effective thickness of the layers is varying from 

facet to facet positioned at different angles. Thus the intensity data, originating from the 

various facets of the sample, are weighted by a geometry correction factor, accounting for the 

projected areas. Similarly to the other structured models, the size of the surface features must 

be greater than thickness of the layers. 
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The surface should be inspected by naked eye or by microscope and the tilt angles of the 

facets together with their corresponding relative area should be measured (e.g., by optical 

methods, goniometer or image analysis, etc.) or estimated.  

The above example shows a grooved surface with roof-shaped features. The projected areas 

could be derived from the top view while the tilt angles from the side view. The relative 

projected area data to be included into the model are shown in the next table. 

 

When angle dependent experiments are performed, the model geometry must be redefined, as 

the effect of tilt on the different features are unpredictable, in general. It is strongly depending 

on relation of tilt direction with the position of facets, on the self-shading effects of the 

features, etc. 

Facet tilt angle 
Projected area at sample tilt 

 0° 60° 

0° 33.3 % 66.6 % 

30° 16.7 % 16.7 % 

60° 50.0 % 16.7 % 

As shown in the above table, the relationship between the projected areas and the original 

surface is quite different at various sample tilt angles. 



64 

Layers-on-Nanotube Model 
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The description of intensity of photoelectrons emitted from cylindrical surfaces covered by 

overlayers, despite the simplicity of the shape, cannot be applied directly for nanotubes [20]. 

In this latter case, the diameter of the nanotubes and the thickness of the tube wall are 

commensurable with the thickness of the layers. This means that there is no “bulk like”, i.e., 

infinitely thick, material, the electrons are emitted from the bottom part of the nanotubes, and 

they can be emerged from several rows of tubes and passing through the top one. The 

algorithm of the calculation, used for the cylindrical model, cannot be applied either. In that 

case, the cross section of the tube is divided into segments of equal angles. When this division 

is applied to nanotubes, the matching effective thickness values, originated from the layers 

and the tube wall (read at the middle angle of segments), are misaligned, as shown in the next 

figure, and would give erroneous results. Thus, tubes must be divided into segments of equal 

width instead of equal angle. 
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The size of the tube cannot be neglected, as well. Both the outer (R) and inner (r) radii must 

be known. They are usually determined by transmission electron microscopy. For nanofibres, 

the inner radius may be set to zero. In case of carbon nanotubes, their given absolute outer 

radius [21] and wall thickness [22] are also tested. 

The effective thickness values of the layers and the wall for each segment are calculated by 

Pythagorean Equations (58)-(60): 
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where R is the outer and r is the inner radius of the nanotube, d is the layer thickness, d’, b’ 

and h’ are the effective thickness values of the layer, wall and the hole of the tube, 

respectively. s is the number of segments (9) and i is the index of the actual segment (varying 

from 1 to s). The triangles used for these calculations are illustrated in the next figure. 
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The most characteristic arrangement of the randomly piled nanotubes is not the parallel but 

the crossing position at various angles. When two tubes are in such position, all segments of 

the two tubes are overlapping with each other. The projected areas of the overlapped segments 

are equivalent and their ratio is invariant to the crossing angle of the tubes, as illustrated in the 

next figure. The further underlying tube rows are supposed to be parallel with the 

corresponding upper rows (1
st
 with 3

rd
, 2

nd
 with 4

th
, etc.). The latter assumption does not 

really affect the accuracy of the calculations because the contribution of the lower rows is 

usually less than one percent.  

 

The segments are situated symetrically on both sides of the tubes, thus only one quadrant of 

the crossing tubes (9×9 segments; only 3×3 shown) needs to be calculated. 

When the layer on the nanotubes is prepared by modification of the tube material (e.g., by 

plasma or chemical treatment), the overall original diameter of the tube is unchanged but the 

thickness of the undisturbed tube wall is decreasing with the increasing thickness of the 

modified part; their sum is equal with the original thickness of the tube wall. 

R-d

d
d

R
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During this type of calculations, the total thickness is kept constant and the actual wall 

thickness is also iterated. This latter variant of the model can be applied for one layer only. 

The number of rows of nanotubes to be involved in the calculation (nrow) is determined by the 

following empirical Equation (61). 

 





 


0.75λd3.4n
0.4

wwrow
max  (61) 

where dw is the thickness of the nanotube wall and λw
max  is the largest IMFP in the material of 

the wall. The formula (intentionally) overestimates the number of necessary rows, nrow, which 

falls between 1 and 6. 

Island Type Models 
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Frequently, one or more of the surface layers covering the surface are not continuous, forms 

„islands‟ on the bulk material. An additional parameter, the coverage (Θ), varying from 0 to 1, 

describes the relative area of the islands. Any of the overlayers can be present as island 

(marked by I i in the figure) but the coverage must be the same for all of them. In addition to 

the islands, continuous layers may also be present (L i). The intensity calculations, using the 

same equations as those applied for the Layers type models, are performed in two steps. The 

„island‟ and „non-island‟ parts are computed separately then weighted by Θ and (1-Θ), 

respectively. The corresponding intensity values of the two calculations are summed. 

The same method is used for the curved surfaces (Islands-on-Sphere, Islands-on-Cylinder, 

Islands-on-Polyhedron) thus the following restrictions are assumed: the islands are relatively 

thin and small comparing to the radius of the surface and uniformly distributed on the spheres 

or cylinders, i.e., the same amount of „island‟ and „non-island‟ areas are present on any part of 

the surface. The sidewalls of the islands, getting visible on the high-angle segments of the 

curved surfaces (or at tilting of the planar samples), are left out of consideration. When the 

islands are thin enough, as compared to their area, this effect is usually negligible. In case of 

the Islands-on-Plane model, the angle of emission (Tilt) is applied. 



68 

Since a new independent variable is introduced to the calculations, the system may be ill-

defined (the number of independent equations is less than the number of variables, e.g., both 

the island and the substrate contain single element only). In this case, either the island 

thickness or the coverage should be supplied from other measurements. 

A few examples for some of the possible arrangements are given in the following table. 

Type of the overlayers 

 

1: Island 

1: Layer 

2: Island 

1: Island 

2: Island 

3: Layer 

 

Islands on a substrate. 

Islands on a substrate, 

covered by a contaminant 

layer. 

Substrate is covered by a 

continuous layer and  

two-layer islands. 

 

Oxide-Layer Model 
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In the simplest cases, when the layer and the bulk contain the same element in different 

chemical states, the layer thickness (d) can be expressed analytically [23, 24]. A typical 

example is a metal surface covered with a single and uniform layer of its (native) oxide; and 

the intensity of the photoelectron peaks of the metallic (Ime) and oxidic (Iox) chemical states of 

the same metal (element) can be resolved, the intensity ratio can be written as: 

 
 θd1

θd

N

N

I

I

ox

ox

oxox

meme

ox

me

cos/exp

cos/exp

λ

λ

λ

λ




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where N is the number of atoms per unit volume, λ is the inelastic mean free path, d is the 

layer thickness, and θ is the tilt angle (from the surface normal). Indexes me and ox refer to 

the bulk (metal) and layer (oxide), respectively. 

Solving Equation (62) for the layer thickness, it can be calculated directly: 
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
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Parameters of the model should be defined similarly to the other structured models but here 

only one layer is permitted. As the involved intensity originated from the same element, 

practically at same binding energy, no corrections are required for cross section, transmission 

or contamination. The number of atoms per unit volume (Nme and Nox) is calculated by 

Equation (50) as in the case of other structured models. 

Unlike the other models, no parameter fitting is required, thus results are calculated and 

displayed immediately. 
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Library Data 

The library of XPS MultiQuant includes all necessary basic data for the calculations (data for 

elements, photoelectron lines, angular correction, etc.). Any data extracted from the library 

can be overwritten manually. 

Chemical Elements 

The atomic number, element symbol, name, atomic weight (1981 Table of Standard Atomic 

Weights), density and valence data of the elements were extracted from the literature [25]. 

The valence and number of oxygen atoms refer to the most common, usually the most stable, 

oxide. 

Photoelectron Lines 

The kinetic energy of the photoelectron lines were taken from Reference [26] and converted 

to binding energy. Some data were taken from Reference [27]. 

The energy of the doublet lines is the mean of the two components, weighted by their nominal 

intensity ratio (1:2, 2:3 and 3:4 for the p, d and f lines, respectively), as shown by Equation 

(64). 

ba
ba

ba EI
II

EE
E 




mean  (64) 

where E is the binding energy, I is the nominal intensity, indexes a and b refer to the higher 

(p1/2, d3/2, f5/2) and lower (p3/2, d5/2, f7/2) binding energy components, respectively. This 

approach provides proper base for the IMFP and transmission corrections. 

The values, although usually refers to elemental states, are precise enough only for 

transmission and IMFP approximation. Never use them for chemical state determination. 

Cross Sections and Sensitivity Factors 

Five different theoretical and experimental data sets are available in the library for most of the 

elements and photoelectron lines. Any other cross section or sensitivity factor values can be 

entered manually. All data are based on peak areas and not peak heights. 

Scofield 

The data of Scofield [28] are theoretically calculated cross sections (using relativistic single-

potential Hartree-Slater atomic model). Separate sets are available for Mg Kα and Al Kα 
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excitation sources. Data are relative to C1s = 1 (22200 barn and 13600 barn, respectively). 

XPS MultiQuant chooses the data set according to the selected excitation source. When the 

source energy is specified by the user, the Al Kα set is selected. 

Lines from 1s to 4f (when applicable) are included in the library. If experimental data are 

available (from Hg to U), the 5d lines are also included. 

Evans  

The data of Evans et al. [3] are experimentally based relative differential cross sections 

relative to F1s = 1. Data were measured with Mg Kα radiation, fixed retard ratio (FRR, CRR) 

analyser mode and at 90° analyser-excitation angle. The angular dependency of data was not 

eliminated (see Equation 7). Cross sections were calculated using  E
1/2

 IMFP and  E 

transmission dependency.  

Wagner  

The data of Wagner et al. [1, 29] are experimentally based relative sensitivity factors. 

Measurements were performed with Mg Kα and Al Kα radiation, fixed analyser transmission 

mode (FAT, CAE), at 84° analyser-excitation angle (and also with CMA analyser). Values are 

average for Mg and Al radiation; the strongest lines are insensitive to the excitation while 

secondary lines should be corrected by factors of 0.9 and 1.1 for Mg Kα and Al Kα, 

respectively. The secondary lines include the 2s, 3p, 4p, 4d (except from dysprosium to 

lutetium) and 5d lines. 

Nefedov  

The data of Nefedov et al. [30, 31] are experimentally based relative sensitivity factors 

relative to Na1s = 1. Data were recorded with Al Kα radiation, fixed analyser transmission 

mode (FAT, CAE). 

Average Scale Factors 

The four average scale factors (Evans/Scofield Mg, Wagner/Scofield Mg, Wagner/Scofield Al 

and Nefedov/Scofield Al), for scaling the cross sections or sensitivity factors, are calculated as 

the average of the ratio of all available corresponding photoelectron line pairs (158, 200 and 

57 items, respectively; see Equation 10). 

Asymmetry Parameters 

The theoretically calculated asymmetry parameters of Reilman et al. are given in reference [4] 

in tabulated form for the different transitions in five atomic number steps. Polynomials with 

order of 6 were fitted to every asymmetry parameter set and the coefficients together with the 

transition names and the ranges of validity (atomic numbers) are stored in the library. 

Separate data set are available for Mg Kα and Al Kα excitation sources. 
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Number of Valence Electrons 

The numbers of valence electrons of the elements recommended by Powell et al. for the 

TPP-2 formula are extracted from the literature [9, 25]. The contributions of the 4f electrons 

of the rare earth elements are excluded, as suggested [9]. 

Geometry Correction Factors 
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The geometry correction factors, for calculating photoelectron intensity values from layer 

thickness on curved surfaces, were calculated by Varsányi et al. [17, 18] for sphere and by 

Mohai for cylinder [18]. These factors are based on pure geometry considerations. 

An atom says to his friend,  

―Man, I think I’ve lost an electron.‖  

The friend says ―Are you sure?‖  

He answers:  I’m positive! 
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Tips and Tricks 

Transforming Angles 

Commercial photoelectron spectrometers are manufactured with various geometry. For the 

quantitative evaluation of the spectra, the angles between the axis of the excitation source and 

the axis of the analyser (φ) must be known. The emission angle (θ), i.e., the angle between the 

sample surface normal and the analyser is also very important, especially for ordinary samples 

possessing in-depth inhomogeneities near to the surface. 

Sometimes these angles can hardly be recognised unless the axis of the excitation and the 

analyser and the sample normal are in one plane. If this is not the case, these angles can be 

derived, however, from other angles measured (or specified by the manufacturer) on the 

instrument. 
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δ
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ω γ
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In the figure, the sample surface is in the X-Y plane of the coordinate system, which is 

horizontal; the Y axis is the tilt axis of the sample (being perpendicular to the sample normal). 

The direction of the excitation source is defined by its elevation (α) and azimuthal (β) angles, 

while the direction of the analyser also by its elevation (γ) and azimuthal (δ) angles. 

Measuring these angles, the excitation − analyser angle (φ) can be calculated by 

Equation (65). 

2AB

EBA 222 
 arccosφ  (65) 

where 

αsin1/A   (66) 

γsin1/B   (67) 

αtan1/C   (68) 

γtan1/D   (69) 

 βδ  cos2CDDCE 222  (70) 

The emission angle (θ) can also be calculated from the above data and the sample tilt angle 

(ω, measured on axis Y) by Equation (71). 

2AB

EBA 222 
 arccosθ  (71) 

where 

γsin1/A   (72) 

ωcos1/B   (73) 

γtan1/C   (74) 

ωtan1/D   (75) 

δcos2CDDCE 222   (76) 

The equations are similar; differences are due to the different definitions of angles (elevation 

angles are measured from the horizontal plane, azimuthal angles from axis X, tilt angle from 

axis Z).  

Layers Inside a Tube 

Sometimes layers on (or in) a tubular sample have to be measured, e.g., on an inside-coated 

tube, on a fluorescent lamp or on an inside-coated medicinal ampoule. Although the sample is 

cylindrical, the Layers-on-Cylinder model cannot be applied because it takes into account 

whole cylinders, while in a practical case of bulky samples only a part of a cylinder (usually a 
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third or a quarter) is cut out for measurement. Fortunately, application of the Layers-on-

Polyhedron model may help. The geometry correction factors (the relative sizes of the 

projected areas of the facets at different angles) in the Layers-on-Polyhedron model, set by 

the user, can be applied to describe any kind of non-planar surface (see chapter “Layers-on-

Polyhedron Model” for details). 

The geometry correction factors of the tube segment can be calculated by Equation (77), 

   βαβαα  sinsintubeG  (77) 

where Gα is the geometry correction factors for facet at angle α, while β is the half of the 

angle increment between facets (β is 5° in XPS MultiQuant), as illustrated in the next figure. 

α-β

α+β

α

Gα G0Gn  

Due to the symmetry of the tube section, only half of it should be taken into account. For the 

same reason, the first factor (G0) is calculated from 0 to β, while the last one (Gn) from α-β to 

α+β or from α-β to α, depending on how the angle increment (2β) can be fit into the central 

angle (ρ) of the segment. 

The central angle (ρ) of the tube section can be easily calculated from its width (d) and height 

(h) by Equation (78), as illustrated in the next figure. The width (d) of the segment is 

delimited either by the sample size itself when spot size of the instrument is larger than the 

size of the sample or by the field of view of the spectrometer (for small spot size instruments). 

ρ

h

d  
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  22 h2d
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
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The required geometry correction factors for the most common cases, when the tube is cut 

into three, four or six parts are enumerated in the next table (normalised to 100 %). These 

numbers can be simply entered into the Polyhedron Editor window. 

Facet tilt 

angle    
120° 90° 60° 

0° 10.1 % 12.3 % 17.4 % 

10° 19.8 % 24.3 % 34.3 % 

20° 18.9 % 23.2 % 32.8 % 

30° 17.4 % 21.3 % 15.5 % 

40° 15.4 % 18.9 %  

50° 12.9 %   

60° 5.4 %   

Layers on Domes 

Similar evaluation can be performed when the inside or outside of a part of spherical samples 

(domes) are measured, like coated optical lenses, small light bulbs, round bottom of 

ampoules, etc. The way of calculation is the same; the values of the geometry correction 

factors are, however, different. The central angle (ρ) of the dome can also be calculated from 

its width (d) and height (h) by Equation (78), as illustrated in the next figure. 

 

The geometry correction factors of the spherical segment can be calculated by Equation (79), 

   βαβαα  22G sinsindome
 (79) 

where Gα is the geometry correction factors for facet at angle α and β is the half of the angle 

increment between facets (5°), as defined in case of tubes. Here the user should apply all 

symmetry considerations listed in case of tube sections. 
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The geometry correction factors for the most common cases, when the central angle of the 

sphere section is 120, 90 or 60° are enumerated in the next table (normalised to 100 %). 

Facet tilt 

angle    
120° 90° 60° 

0° 1.0 % 1.5 % 3.0 % 

10° 7.9 % 11.9 % 23.8 % 

20° 14.9 % 22.3 % 44.6 % 

30° 20.1 % 30.1 % 28.6 % 

40° 22.8 % 34.2 %  

50° 22.8 %   

60° 10.5 %   

 

Testing Layers 

Evaluating measured intensities for a sample allegedly having one or more overlayers, while 

composition and even sequence of those are not exactly known, the user can easily test 

several potential layers and compositions. 

To simplify and speed up the trials, a number of test layers with their estimated composition 

and sequence can be defined at the same time. To neglect unnecessary ones, declare it Fixed 

(in the Link to row of the Model window) and set its thickness to zero (in the Layer 

Calculation window). This layer will be “invisible” for the calculations. 

In the next figure, example is shown of calculating A-B then B-A layer sequences. 
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Transposing Cells 

If input data of the quantification, e.g., peak area values, are available as structured text, like 

an Excel or Origin file, a table in Word document or comma delimited file, arrangement of 

items can be transposed thus a row can be pasted as a column, or a column as a row. Table of 

data (matrix) cannot be transposed by this way. 

 

Copy the group of cells in the source program, then select a range in the wanted direction in 

any input window of XPS MultiQuant and perform the Paste command. 
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Exporting Comparison Chart 

During layer thickness calculation the Chart window displays a bar graph, comparing the 

measured and calculated relative intensity values of the elements. When the Chart window is 

clicked after the calculation, the content is switching back to the regular chart. However, if 

you want to save the bar graph, e.g., to illustrate the quality of the fit, it can be done by the 

following way: after closing the Layer Calculation window, immediately right click the Chart 

window and select the Copy Chart command.  

 

The bar graph is copied to the clipboard as Windows Metafile and can be pasted into 

documents, as illustrated above. Do not left click or do not try to move or resize the Chart 

window. 

Relative Path for Transmission Files 

Although XPS MultiQuant stores the full (absolute) path of the transmission files in the data 

files, user can remove or edit the path in Transmission tab of the Parameters window. Using a 

relative path may be useful if the data file is moved together with the transmission file. Some 

examples of denoting the relative path of the different transmission files for the DataFile.mqd 

are illustrated in the next figure. 

 

..\TransFile-4.mtr 

 

TransFile-1.mtr 

.\SubFolder\TransFile-2.mtr  

..\TransFolder\TransFile-3.mtr 
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Subsequent Calculations 

Sometimes input intensity data of the quantification are not accessible, only the composition 

results, calculated by the infinitely thick homogeneous sample model. Composition is taken 

from the literature, input data are measured by someone else or just vanished (e.g., after a 

computer crash). Several kind of calculations still can be carried out using the surface 

composition results as input for the further steps. 

 

The composition results are already corrected for cross section, angular distribution, analyser 

transmission, IMFP and perhaps for surface contamination. All corrections should be applied 

only once thus for subsequent calculations they must be switched off by selecting None in the 

Parameters window. In some cases IMFP must be applied directly during the new 

calculation, therefore the previous correction for IMFP must be revoked from the composition 

results: according to Equations (5) and (6), data should be multiplied by the involved 

homogeneous IMFP. Ideally, the same values should be revoked those were applied at the 

original calculation. If they are not known, as typical, select the method of Jablonski or Gries. 

Use the same method for the further computations. For subsequent layer thickness 

calculations, estimate IMFP by the methods of Tannuma-Powell-Penn or Gries. 

Intensity data in the program are rounded to integer thus to avoid loss of precision, it is 

advisable to multiply all values by 100 or 1000. 

 

The homogeneous IMFP data to be revoked can be copied from the Applied IMFP window, 

invoked by the Show... command in the IMFP tab of the Parameters window. 
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Changing Composition Result Type 
When the surface composition is given just in one form (e.g., atomic %), it is easy to convert 

them to other forms, like atomic ratio or mass %. Although these calculations are not 

complicated, it is straightforward to perform by XPS MultiQuant. 

 Setup calculation with the required elements. Set Valence and Oxygens data as well. 

 Set all corrections to None. 

 Multiply input composition data by 100 and paste to the Intensity window. 

 Select result type in the Composition window as necessary. 

Applying Contamination Correction 
If the composition of a sample contains hydrocarbon type carbon but it is supposed to be just 

contaminant, the correction for the adventitious carbon can be performed afterwards from the 

results by the methods of Evans [3] or Mohai [15], as follows. 

Correcting by method of Evans 

 Setup calculation with the required elements. 

 Set all corrections to None. 

 Multiply input composition data by 100 and paste to the Intensity window. 

 Set contamination correction to Evans. 

Correcting by method of Mohai 

 Setup calculation with the required elements. 

 Set all corrections to None, except IMFP. Select the method of Jablonski or Gries. 

 Get IMFP data from the Applied IMFP window. 

 Multiply input composition data by the IMFP values and by 100 and paste to the  

Intensity window. 

 Set contamination correction to Mohai. 

Calculating layer thickness 
Even the layer thickness can be computed from the homogeneous composition data. 

 Setup calculation with the required elements. Select the Homogeneous model. 

 Set all corrections to None, except IMFP. Select the method of Jablonski or Gries. 

 Get IMFP data from the Applied IMFP window. 

 Multiply input composition data by the IMFP values and by 100 and paste to the  

Intensity window. 

 Select the required structured model (e.g., Layers-on-Plane) and define layers.  

If adventitious carbon is present, define a CH2 top layer. 

 Set the IMFP method to Tannuma-Powell-Penn or Gries and calculate IMFP. 

 Calculate layer thickness as usual. 
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Program References 

Menu Commands 
Use menu commands to control XPS MultiQuant. Click the menus or press ALT and type the 

access key (underlined) or press the shortcut key to perform some commands directly. 

File Menu 

 

New 
Deletes all previously entered data from all windows and displays the Elements window. 

Prints any pending page. Settings of the parameters are unchanged, except Title. 

Open… 
Invokes the Open Data dialog box for selecting previously saved XPS MultiQuant data files, 

XPS MultiQuant template files or XPS Reduced Data Exchange files. 



83 

Open Example… 
Invokes the Open Example Data dialog box for selecting example XPS MultiQuant data files, 

XPS MultiQuant template files or XPS Reduced Data Exchange files. The Notes window and 

other subwindows are opened automatically and the result format is set, as appropriate for the 

selected file. 

Save 
Saves data in the current XPS MultiQuant data file (shown in the status bar). If data are not 

yet saved, the Save Data As dialog box will be invoked. 

Save As… 
Invokes the Save Data As dialog box for entering name for a new XPS MultiQuant data file or 

XPS MultiQuant template file. When an example file is saved, it loses its „magic‟ and acts as 

an ordinary data file. 

Save Defaults 
Saves the initial settings of the Parameters (except Title), Print and Print Options windows in 

the registry. 

Save Workspace 
When selected, the name of the current data file, the position, size and other attributes of all 

open windows are saved on exit. Next, when the program started without command line 

(filename) parameter, the file is loaded and the layout of all windows are restored. 

Print… 
Invokes the Print window for selecting items to be printed, forcing printing of the pending 

page and setting printing options. If no printer is installed to the computer when the program 

is started, this item is not available. 

Print Current 
Prints the active window to the printer. If no printer is installed to the computer, this item is 

not available (including shortcut). The content of the Chart or Model Layout windows is 

printed immediately (not spooled) on a separate page; the previously printed pending page is 

printed before the figure. 

Exit 
Quits XPS MultiQuant. Pending page is printed. The current size and position of the main 

window is saved in the registry. 
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Edit Menu 

 

Insert Row 
Inserts one empty row into the active input windows (Elements or Intensity) before the 

selected (coloured) line. To select a row click the sequence number of elements or 

experiments. The blank row should be filled immediately. 

Delete Rows 
Deletes one or more selected rows from the active input windows (Elements or Intensity). 

Remainder lines are closed up. To select rows click the sequence number of the first row then 

drag or SHIFT+click the last one. 

Undo Delete Rows 
Revokes the last Delete Row command. There is only one level of undo either for elements or 

for experiments. When the number of elements or experiments was changed since the last 

delete, a warning message is displayed, because undo may corrupt the last entered data. 

Copy Table ► 
Copies the content of the active window to the clipboard, including row and column headers. 

If the SHIFT key is pressed, tables are copied without heading.  

ASCII 

To paste data into an ASCII file (e.g., Notepad) or Excel worksheet, select the ASCII 

subcommand. Data items are separated by tabulator (TAB) characters, lines are terminated by 

carriage return – line feed (CRLF) characters. 

MS Word 

To paste data into a Microsoft Word document, converting it to a table, select the MS Word 

subcommand. Data items are separated by TAB characters, lines are terminated by vertical 

tabulator (VT) characters (manual line break) and table is terminated by CRLF  characters. 
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Paste Table 
Pastes the content of the clipboard to the active input window (Elements, Intensity, IMFP & 

Contamination or Model). The original content of the table can be recovered by an immediate 

Undo command of the pop-up menu. 

Paste Table 
Pastes the content of the clipboard to the active input window (Elements, Intensity, IMFP & 

Contamination or Model). The original content of the table can be recovered by an immediate 

Undo command of the pop-up menu. 

Clear Table 
Clears the whole content of the active input window (Elements, Intensity, 

IMFP & Contamination or Model) or the results of the structured model calculations. Cleared 

windows can be recovered by an immediate Undo command of the pop-up menu. 

View Menu 

 

Elements 
Displays or hides the Elements window. 

Intensity 
Displays or hides the Intensity window. Available only if elements are already entered into the 

Elements window. 

IMFP & Contamination 
Displays or hides the IMFP & Contamination window. Available only if elements are already 

entered into the Elements window. 
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Results 
Displays or hides the Composition or Layer Thickness windows. Available only if elements 

and intensity data are already entered. 

Chart 
Displays or hides the Chart window. Available only if the Composition or the Layer 

Thickness window is displayed. 

Model 
Displays or hides the Model window. Available only if the selected model type is one of the 

structured ones (the Model textbox in the General tab of the Parameters window). 

Model Layout 
Displays or hides the Model Layout window. 

Parameters… 
Displays the Parameters window. 

Notes… 
Displays the Notes window. 

Tools Menu 

 

Library Lookup 
Searches XPS MultiQuant‟s library for element and photoelectron line data for the elements 

given in the Elements window according to the settings in the Parameters window. Library 

must be enabled. Search can be performed either for the whole content of the window or for 

selected elements only. To select elements, click the line number of the first line then drag or 

SHIFT+click the last one. This command works only when invoked from the Elements 

window. 
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Model ► 
This menu contains tools, which help and automate filling of the structured model data. These 

commands usually work only when invoked from the Model window. 

Test Model 

Performs the model data consistency tests and displays the results and possible error messages 

in the Model Summary window. These tests are normally performed only at closing of the 

Model window. 

Mark Unused IMFPs 

Marks the positions in the IMFP matrix of the Model window, which are unnecessary for 

calculating of the specified layer structure. 

Calculate Molecular Weight 

Calculates and fills the molecular weight values of the layers according to atomic weights 

given in the Element window and stoichiometric coefficients given in the atom location 

matrix of the Model window. This command can be invoked either from the Model or from 

the IMFP & Contamination window. 

Calculate Valence Electrons 

Calculates the number of the valence electrons for the TPP-2M formula according to the 

composition given in the Model window. This command must be invoked from the 

IMFP & Contamination window. 

Calculate IMFPs 

Calculates the IMFP values using the method selected in the Parameters window. Results are 

put into the IMFP matrix of the Model window. Parameters of the calculation are taken from 

the IMFP & Contamination window. Calculation can be performed for all layers and the bulk 

or only for a selected single layer. To select a layer, click its column header. 

Simulation… 
Displays the Intensity Simulation window.  

Create Depth Scale 
Calculates a depth scale from the Time labels and the Sputter rate value from the Labels tab of 

the Parameters window. Depth values are permanently stored in the Other Numeric label set. 

Warning message is displayed when the Other Numeric labels are not empty or the sputter 

rate and time data are not entered. It works only when performed from the Composition 

window. 

Split Intensity… 
Displays the Split Intensity window. 

Data Wizard… 
Invokes the Data Wizard window. The Data Wizard helps to enter data for a simple 

XPS MultiQuant calculation by giving step-by-step instructions. To leave the wizard perform 

this command again or press the close button. 
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Windows Menu 

 

Cascade 
Arranges the open windows in cascade form. 

Tile Horizontally 
Arranges the open windows horizontally tiled. 

Tile Vertically 
Arranges the open windows vertically tiled. 

Home 
Moves the active window to the home position (upper left corner of the main window). 

Help Menu 

 

Help Topics 
Displays the table of content of XPS MultiQuant Help. 

Context Help 
Displays context sensitive help. 
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What’s This? 
Changes the mouse pointer to “What‟s This” pointer (question mark). Click an item to display 

its context sensitive help in a pop-up window. 

About XPS MultiQuant… 
Displays the program‟s About box. It shows the version numbers of the program, library and 

data files. 

File Menu (Notes window) 

 

Print 
Prints the notes text and saves the last editing.  

Exit 
Closes the Notes window after prompting to save any unsaved editing. To permanently save 

notes, use the File / Save command to save the current XPS MultiQuant data file. 

Edit Menu (Notes window) 

 

Undo 
Revokes the last editing action. There is only one level of undo. 



90 

Cut, Copy, Paste, Delete 
These commands provide standard editing functions to cut, copy, paste, or delete text. They 

can also be accessed via pop-up menu (right click).  

Select All 
Highlights the entire Notes text. 

Format Menu (Notes window) 

 

Word Wrap 
Wraps text to the width of the Notes window. It does not affect the way text appears when it is 

printed. A check mark appears when word wrap is turned on. 

Font… 
Changes the font style and size of the Notes window. An example of how the selected font 

will look appears in Sample. The selected font and its size are stored with the default 

parameters while other elements (style, colour, etc.) are not retained. 

Help Menu (Notes window) 

 

Help 
Invokes the help topic of the Notes window. 



91 

Pop-up Menu (input windows) 

 

A pop-up menu, activated by a right mouse click, is available in the input windows (Elements, 

Intensity, IMFP & Contamination, Model) to cut, copy and paste the content of the active cell 

or range of cells to or from the clipboard. Data can be exchanged within XPS MultiQuant or 

between other Windows applications. 

When the pop-up menu commands are invoked in one of the mentioned windows, only the 

selected cells are affected. Multiple rows and columns can be selected by clicking one of the 

corners and dragging to the opposite corner or by pressing the SHIFT + ARROW keys. 

If there are more cells in the selected range than are in the clipboard, the remaining cells are 

cleared. If there are more cells in the clipboard than in the selected range, the unused portion 

of the clipboard is ignored. 

The structure of the clipboard text is described at the Copy Table command. 

Cut Cells 
The content of the active cell or the selected range is copied to the clipboard then the selected 

region is cleared. When the entire content of two (or more) lines of the Elements or Intensity 

windows are cleared by the Cut Cells command, the content of the underlying lines may be 

lost because of the automatic counting of elements and experiments. 

Copy Cells 
The content of the active cell or the selected range is copied to the clipboard. The selected 

region remains unchanged. This command is also available in the Composition and Layer 

Thickness windows. 

Paste Cells 
The content of the clipboard is pasted to the active cell or to the selected range. The selected 

range is overwritten. Available only when the clipboard contains text data. Alphabetic text 

pasted into the numeric cells is treated as zero. Direction of cells can be transposed thus a row 

can be pasted as a column, or a column as a row. If the cells to be pasted contain space 

characters (i.e., spaces are not item separators), press the SHIFT key during pasting. 

Undo 
Revokes the last cell- or table-editing command (DELETE, Cut Cells, Paste Cells, 

Paste Table and Clear Table). The name of the next undo action is indicated in parenthesis. 

When the number of elements or experiments changed since the last editing command, a 

warning message is displayed, because undo may corrupt the recently entered data. If the 

destination cell of the undo command is non-existing due to removed elements, another 

warning message is displayed and the command cannot be performed. There are ample levels 

of undo. This command is available in the Layer Thickness window as well. 
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Pop-up Menu (result windows) 

 

This pop-up menu, activated by a right mouse click in the column header (element symbols) 

or in the row header (experiment sequence numbers), is available in the Composition and 

Layer Thickness windows. 

Omit 
When selected, the element is omitted from the 100 % sum of the percentage composition 

(and also from the oxygen balance), while the remaining elements are re-normalised. Omit is 

enabled only for „percentage‟ results. The effect of the command is the same, as double 

clicking the element symbol. 

Visible 
Controls the visibility of elements or experiments in the Chart window. If unselected, the 

element (series) or experiment (points) disappears from the composition chart. When this 

menu is activated on the element symbols, it affects the elements; when activated on the 

sequence numbers of experiments, the experiments. (Invisible elements, unlike in case of the 

Omit command, are still included in the 100 % sum.) 

Reset All 
When the menu is activated on the element symbols, it resets the Omit and Visible items of all 

elements to default (Omit off, Visible on). When activated on the sequence numbers of 

experiments, it resets the all the data points (experiments) omitted from composition chart. 

Pop-up Menu (Chart window) 

 

This pop-up menu, activated by a right mouse click, is available in the Chart window. 

Copy Chart 
Copies the content of the Chart window to the clipboard in Windows Metafile (WMF) 

format. 

Colours 
Switches on or off the colours of the chart. 
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Pop-up Menu (Model Layout window) 

 

This pop-up menu, activated by a right mouse click, is available in the Model Layout window. 

Copy Figure 
Copies the content of the Model Layout window to the clipboard in device independent 

bitmap (DIB) format. To obtain the best quality (higher resolution) picture, adjust the size of 

the Model Layout window before copying. 

Colours 
Switches on or off the colours of the model layout figure. 

Legend 
Switches on or off the legend text (layer names) of the model layout figure. 
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Windows 
Users enter input data and also get results in different windows. Windows can be invoked by 

the View menu command. Data can be entered into the textboxes, alternatives can be selected 

from the drop down lists and can be set by check boxes or option buttons. When large amount 

of data is necessary for the calculation, enter them into the tables. User can navigate in the 

tables by the arrow keys or mouse clicks. The BACKSPACE key deletes the last character in a 

cell while the DELETE key deletes the whole content of a cell. To edit flexibly the content of a 

cell in a table, double click it. In this mode the arrow keys moves the text cursor within the 

cell. To leave the edit mode, click any other cell in the same window. 

In numeric cells, either point or comma typed, always the current decimal mark is entered, as 

set in Windows. Where a number is expected in a table, two numbers, connected with an 

arithmetic operator, can also be used. The numbers may have sign, decimal separator and 

exponent with optional sign. 

Windows can be repositioned and resized within the main window. XPS MultiQuant adjusts 

the optimal size of each window when they are opened and resize them when it is necessary 

(e.g., when elements are inserted or deleted, Oxygen Balance column is displayed, etc.). 

However, when the user resizes any window manually, it will keep its new size and will not 

be resized automatically until it is closed and reopened again. 

Elements 

 

Enter element symbols and photoelectron line assignations of the elements required for the 

calculations. Use the 2p, 3d, 4f, etc. notation for the doublet lines and the 2p3, 3d5, 4f7, etc. 

for the 2p3/2, 3d5/2, 4f7/2 components, respectively. Capitalisation errors of the element 

symbols are corrected automatically. Use the State column to distinguish the different 

chemical states of the same element. Data can be extracted from the library by the Tools / 

Library Lookup command or can be entered manually. Data taken from the library can also 

be overwritten. The Valence column is the valence of the element at the given chemical state 

and the Oxygens column is the number of oxygen atoms in a mol of such oxide. When the 

window is left or closed, the data in the table are checked and a message may be displayed 

about possible errors. The number of elements is determined automatically thus empty lines 

are not allowed in the table. 
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If cross sections are entered in barn units, due to their large values, it is recommended to 

divide them by 10,000 for proper displaying. 

Special cases of the State entries: 

 The C1s line of carbon contamination must be left empty when the automatic 

contamination correction (Mohai) is selected. 

 The two chemical states of the main constituent element must be Ox (oxide, oxidic, 

oxidised, oxidized) and Me (met, metal, metallic) when the Oxide-Layer model is used. 

(Only the first two characters are significant.) 

Clicking some cells in the Element window assists in entering data conveniently. Double 

clicking a cell of the Line column inserts the notation of the lines actually available in the 

selected cross section data set, rotating transitions in increasing binding energy order. By 

double clicking the cells of the State column, one can enter the standard chemical state types 

for the Oxide-Layer model (Me, Ox, empty). 

Double clicking the B. E. column header, the energy scale will be temporarily switched to 

kinetic energy. The K.E. values cannot be edited. The values are changing back automatically 

to binding energy when any mouse or keyboard action is taken. 

 

The order of the elements can be rearranged by right clicking the sequence number of the 

element to be moved, then dragging the cursor to the required new position (sequence 

number). During the drag and drop the cursor is changed, as illustrated in the next figure (e.g., 

moving Si to position 1), and the number of source element is marked by a dotted frame. 

 

Elements cannot be moved to empty positions and empty lines cannot be inserted this way.  

Destination 

Source 
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Intensity 

 

Enter the integral photoelectron line intensity data into this table, as supplied by the spectrum 

processing software. XPS MultiQuant distinguishes the empty and zero cells so zero value 

can be used to emphasise the lack of an element. Data of several experiments can be entered 

and calculated simultaneously. The „experiment‟ may be an item in a series, e.g., ion 

bombardment, heat treatment, time dependence or simply a different (but usually similar) 

sample. The number of the experiments is determined automatically thus empty lines are not 

allowed in the table.  

Labels for the experiments can also be entered into this table. Labels are used either to 

identify experiments or to supply additional information, e.g., the treatment time or tilt angle, 

etc. They also act as a source of X-axis values for charts. Select or define the required type of 

labels in the Labels tab of the Parameters window. 

The content of the header row (chemical symbol, line assignation and chemical state) may 

vary, according to the actual elements and lines. 

The order of the experiments can be rearranged by right clicking the sequence number of the 

experiment to be moved, then dragging the cursor to the required new position (sequence 

number). During the drag and drop the cursor is changed, as illustrated in the next figure, and 

the source experiment is marked by a dotted frame. Experiments cannot be moved to empty 

positions and empty lines cannot be inserted this way. 

 

The Undo command of the pop-up menu in the this window, beside restoring accidentally 

changed data, can also be applied to revoke the results of intensity simulation and intensity 

split calculations. 

Destination 

Source 
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IMFP & Contamination 

 

Data from the IMFP & Contamination window are applied when separate values are used for 

each experiment to calculate the IMFP. The layout of the window is depending on the 

selected calculation method.  

Enter the inelastic mean free path data into the columns marked by element symbols for 

Explicit values into the above table. Parameters for the Jablonski, Seah-Dench or Gries 

methods (material class, density (g/cm
3
) and mean atomic weight) can be entered into the next 

style table.  

 

Also, enter contamination correction factors for Explicit type correction. Data from this table 

are used only when the corresponding calculation methods are selected in the Parameters 

window. Although these data are not always used, all data are always preserved and stored in 

data files. Labels cannot be edited in this window. 

The content of the header row (chemical symbol, line assignation and chemical state) may 

vary, according to the actual elements and lines. If the header seems to be improper, double 

click the table. 
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Composition 

 

When all necessary input data are entered, invoke the Composition window by the View / 

Results command to see the harvest of the quantitative calculations. Results can be displayed 

in various forms. From the dropdown list Atomic %, Atomic ratio, Oxide molar %, 

Oxide molar ratio, Mass %, Mass ratio, Oxide mass % or Oxide mass ratio can be selected as 

adequate for the application of data. 

For the percentage type results, any element can be omitted from or introduced to the 100 % 

by double clicking the element symbol while for the ratio type of data the basis element can 

be selected also by double clicking the element symbol. The number of basis atoms can be set 

in the Number textbox by clicking the arrow buttons or typing the number. See chapter 

“Normalisation of the Composition Results” for details. 

If elements are present in more than one chemical state, the different states of the same 

elements can be added by selecting the Merge chemical states check box. This option is not 

available when any of the oxide result types is selected but in these cases the Oxygen balance 

is calculated and displayed in the last column of the window. The Oxygen balance is the ratio 

of the measured and calculated (required by the other elements at a given oxidation state and 

chemical formula) oxygen concentrations. 

 



99 

Various popup menus can be activated at different locations of the Composition window, as 

illustrated above. The menus are applied for copying cells, for controlling omission of 

elements from the percentage results and for controlling visibility of elements and 

experiments in the Chart window. See details in chapter “Menu Commands”. 

 

The content of the header row (chemical symbol, line assignment, chemical state, oxide 

formula) may vary, as shown above, according to the type of calculation (multiline, merged, 

oxide, etc.). 

Chart 

 

The results of the quantification can be displayed in graphical forms as well. This window 

interacts with the Composition or the Layer Thickness windows. 

X-axis is set as initially selected in the Labels tab of the Parameters window and Y-axis as 

the result type selected in the Composition or the Layer Thickness windows. When settings 

are changed in the latter windows, it will be reflected in the Chart window immediately or 

when clicking it. Data of the X-axis can be changed easily by double clicking the label 

column header (except the Sequence number; it can be preselected only in the Labels tab). 

Experiments, i.e., data points, can be omitted from the chart by double clicking the sequence 

number of the experiment or by the Visible popup menu command, activated on the sequence 

number of the experiment. The number changes to X. Elements, i.e., data series, can also be 

omitted by the Visible popup menu command, activated on the chemical symbol. Elements 

omitted from percentage calculation are also omitted from the chart even if the result type is 
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set to ratio. If only one experiment is entered instead of the line chart, a pie chart is displayed. 

No chart is shown when only one element is specified. 

A pop-up menu, activated by a right mouse click, is available to copy the content of the 

window to the clipboard in Windows Metafile format. The chart can be printed by the File / 

Print Current menu command. The chart is not spooled; it is printed immediately on a 

separate page. The pending page is printed before the chart. 

The Chart window is also applied to compare the measured and calculated relative intensity 

values at the layer thickness calculations (see chapter “Layer Calculation”). 

Model 

 

When one of the structured model types is selected in the Model tab of the Parameters 

window, the composition and other parameters of the layers must be described in the Model 

window. Assign name to the layers and the bulk in the Name row. Although the name stands 

for administrative purposes, it indicates the presence of the layer for the program. Fill the 

molecular weight and density rows. The Type row is displayed only in case of Island type 

models. Enter I or L or double click to choose the Island or Layer type.  

The next section is the atom location matrix: it shows the stoichiometry of the layers, i.e., the 

number of different atoms in a molecular unit. The 0
th

 element is the hydrogen, which is, 

obviously, not part of the quantification but can be included for the molecular weight and 

IMFP calculations. The last section is the IMFP matrix; it shows the inelastic mean free path 

values for each layer and for each kinetic energy represented by the selected lines of the 

elements. Use the measure unit selected in the Measurement unit box of the General tab of the 

Parameters window. The molecular weight and calculated IMFP data can be obtained 

automatically by the Tools / Model commands. 

When the automatic least square parameter fitting (Autofit) is used, layer thickness values can 

be fixed (kept constant during the fitting procedure) or can be linked (declared to be equal 

with another, neither fixed nor linked layer). To change the linking of the layers, double click 

the cells of the Link to row until the required notice is visible. Elements can also be omitted 

from the automatic calculation. To omit an element, double click the Omit row in the atom 

location matrix (an X appears).  

Atom location  

matrix 

matrix 

IMFP matrix 



101 

Both the link and omit condition can be removed by the DELETE key as well. 

The following figures show some examples of application of linking and fixing of layer 

thickness during automatic parameter fitting. Some erroneous combinations are also 

illustrated. 

 

  

 No link is defined.  

Each layer thickness is calculated 

independently. 

  

 

 

 

 Layer 2 is linked to Layer 1.  

The thickness of the layer B is kept 

equal to A during calculation. 

 

 Layers 1 and 2 are linked to each 

other. Cross link is not allowed. 

 

 

 

 Layers 2 and 3 are linked to Layer 1. 

The thickness of both the B and C 

layers are equal to A 

 

 Layer 3 is linked to Layer 2, which is 

linked to Layer 1. Chain is not 

allowed. 

 

 

 

 Layer 2 is fixed. The thickness of B 

will not be changed during 

calculation. 

 

 Layer 1 is linked to Layer 2, which is 

fixed. Target of a link cannot be a 

fixed layer. 
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Model Summary 

  

The Model Summary window, invoked by the Tools / Model / Test Model… command, 

shows a brief summary and the results of the consistency tests of the data describing the 

current model. The icon is varying, according to the severity of the error. Pointing to it, the 

level of error is displayed in a tooltip box, as shown in the right hand side of the figure. 

Level 1 errors include wrong numeric range of data, correspondence of composition and 

IMFP values, validity of links, etc.; while level 2 errors indicate the insufficient number of 

equations, omitted elements, etc. The tests for level 2 errors are executed only when no errors 

in level 1 are present. These tests are normally performed only at closing the Model window 

thus by the above command the model can be checked as necessary without closing and re-

opening the window. 

IMFP & Contamination of Structured Models 

 

The parameters of the IMFP calculations for the structured models are taken from the 

IMFP & Contamination window. The molecular weight and density data are the same as in 

the Model window and can be change in either of them. If Element is selected as material 

class for a layer when its density row is empty, the value is automatically extracted from the 

library. To change the material class of the layers, double click the appropriate row or enter 
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the initial letter (e, i, p). Providing of the bandgap energy and the number of the valence 

electrons are required by the Tanuma-Powell-Penn method only.  

The number of the valence electrons can be calculated automatically by the Tools / Model / 

Calculate Valence Electrons command. 

Layer Thickness 

 

The results of the layer structure calculations are summarised in the Layer Thickness window, 

invoked by the View / Results command. Layer thickness is shown in the same unit as 

selected in the Model window. The columns have double header lines showing both the type 

and number and also name of the layers. The Coverage column is displayed only when one of 

the Island type model is selected. 

Since layer thickness values are not calculated automatically the table is empty when first 

displayed. The calculated layer thickness values, unlike other results, are stored in the 

XPS MultiQuant data files. 

To invoke the layer calculation, double click the sequence number of the required experiment. 

To select an experiment for displaying in the Model Layout window, click the sequence 

number. 

When an angle dependent experiment set is calculated, results will be appear only in the first 

row; indicating that all of the experiments are handled together. Calculation can be initiated 

by double clicking any experiment of the set but the intensity results, calculated for the whole 

set, is compared to the selected experiment only. 

Popup menus, like in the Composition window, can be activated at different locations of the 

Layer Thickness window to copy cells and controlling visibility of elements and experiments 

in the Chart window. Undo command is also available to revoke the results of the latest layer 

thickness or intensity simulation calculations. See details in chapter “Menu Commands”. 
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Layer Calculation 

 

The upper part of the table shows the results of the intensity calculations. The Measured 

column shows the measured intensity ratio as described in chapter “Models for Structured 

Surfaces”. The basis element can be changed by double clicking the element symbol. When 

an element is omitted from the automatic calculation, instead its sequence number an X is 

shown in the first column. The omit state can also be changed in the Layer Calculation 

window by double clicking the sequence number of the element. 

The lower part of the table shows the actual and previously entered layer thickness and 

coverage values. When two layers are linked, they indicated by the same layer number. 

Values for the linked layers entered automatically. When a layer is fixed or the coverage not 

fitted automatically, a letter F is displayed instead of the layer number. 

After typing the layer thickness values into the entry cells of the table (press ENTER after each 

number), the results of the calculation are displayed in the first column of Calculated relative 

intensity columns. The Diff% column shows the percentage difference between the calculated 

and measured intensity. Negative Diff% value means that the calculated intensity is lower 

than the measured. Diff% is displayed only when smaller than ±100 %. The Qsum row shows 

the sum of the squares of the differences, indicating the precision of the fit. 

When all of the new layer thickness values are entered, the previously calculated intensity 

values are shifted to right, preserving the two previous sets for comparison. To minimise the 

difference between the measured and calculated intensity, the user can vary the layer 

thickness manually or can use the automatic least square fitting feature. The Coverage row is 

displayed only in case of Island type models. 

Experiment 

Selects the next or previous experiment for calculation without leaving the Layer Calculations 

window. The result of the current experiment is stored in the Layer Thickness window. This 

item is not available in case of angle dependent experiment set. 

Autofit 

Starts the automatic least square fitting procedure of model parameters. 

Cancel 

Closes the Layer Calculations window without saving last results. Long calculation can also 

be interrupted by Cancel. 

Element 

intensity 

Layer thickness & 

Coverage 
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OK 

Closes the Layer Calculations window and stores the last results into the Layer Thickness 

window.  

 

If the Chart window is displayed when the Layer Calculation window is invoked, the content 

of the Chart window is changed to a bar graph, as shown above. The graph compares the 

measured and calculated relative intensity values of the elements. This feature helps to find 

the optimum of the layer thickness and coverage values. Adjust the size and position of the 

Chart window as convenient before the Layer Calculation window is invoked. 

Model Layout 
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The Model Layout window displays the geometric scheme of the applied quantification 

model. Keep in mind that it gives a graphical representation of the results of the structured 

model calculations only and not a realistic picture of the examined sample. 

The various information represented graphically in the Model Layout window are summarised 

in the next figure. 
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The thickness of the drawn layers (d1, d2) are proportional to each other but, in case of the 

spherical or cylindrical models, the layers are oversized relative to the bulk. For the 

Homogeneous model, the thickness of the contaminant (c) is proportional to the 

contamination correction factor. In case of the Island type models, the widths of the island 

and non-island parts are proportional to the coverage (Θ). In case of the Layers-on-Nanotube 

model, the inner and outer radii of the tube (r, R) are proportional to each other (but not to the 

layer thickness). When the Layers-on-Polyhedron model is used, the total width of similar 

segments (Aα1, Aα2, Aα3 ) is approximately proportional to the geometry correction factors. 

Minor facets (with small projected area) may not be displayed in the figure. 

The window displays the recently calculated experiment. To show other experiments, click 

the sequence number of the required experiment in the Layer Thickness window. The number 

of the selected experiment is displayed in the title bar. 

A pop-up menu, activated by a right mouse click, is available to copy the content of the 

window to the clipboard as device independent bitmap and to switch on or off the colours and 

the legends of the figure. The content of the window can be printed by the File / 

Print Current menu command; it is printed immediately on a separate page. The pending 

page is printed before the figure. 
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Parameters 

Most of the parameters of the calculations are set in this window (consult chapters “Setting 

Parameters” and “Setting and Saving Default Parameters”). The whole set of Parameters 

(except Title) can be stored in the registry as default by using the File / Save Defaults 

command. Items not applicable in the current parameter set are dimmed; however, their 

values are saved. After entering or selecting data in every necessary tab, press the OK button 

to accept the actual values or the Cancel button to reject the changes. By pressing the Apply 

button, changes of parameter can be accepted without closing the window. Press the Print 

button to print the current parameter set. After printing, parameter changes cannot be rejected, 

even by pressing the Cancel button. 

The Show… buttons found on some tabs show the actual values of quantification parameters. 

Recent changes are appearing in the tables only after pressing Apply. 

Cross Section Tab 

 

Data set 

Select the cross section or sensitivity factor set. 

None no cross sections are applied, none of the library sets are looked up 

Scofield theoretical relative differential cross sections, separate sets for Mg Kα and 

Al Kα excitations 

Evans experimentally based relative differential cross sections for Mg Kα 

excitation (correction applied) 

Wagner experimentally based relative sensitivity factors for Mg Kα and Al Kα 

excitation (correction applied) 

Nefedov experimentally based relative sensitivity factors for Al Kα excitation  

Explicit user defined data, none of the library sets are looked up 
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Type 

Displays the type of the above data set (theoretical or experimental cross section, 

experimental sensitivity factor, user defined). 

Splitting 

Select the method of splitting of experimental cross sections of doublet lines into components. 

None no splitting is applied 

Theoretical data doublets are split by the ratio of the corresponding theoretical cross 

section data 

Nominal values doublets are split by the the nominal ratio values (1:2, 2:3 and 3:4 

for p, d and f lines, respectively) 

Scaling 

Select the method of scaling of the theoretical cross sections into the experimental data sets in 

case of missing experimental values. 

None no scaling is applied 

Closest line scaled by the ratio of the closest line 

Average factor scaled by the average of the ratio of all available line pairs 

Show… 

Displays the table of the original (entered) and actually applied (corrected) cross section 

values, according to Equation (7), as illustrated in the next figure. Corrections are made for 

Evans and Wagner data sets only. When no cross sections are applied, corrected values are set 

to 1. 
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IMFP Tab 

 

Method 

Select the applied inelastic mean free path correction method. 

None no IMFP correction 

Explicit exact IMFP values, given by the user, are used  

Exponential exponential approach 

Jablonski Jablonski‟s exponential approach with pre-set exponents 

Seah-Dench formula of Seah and Dench 

Tanuma-Powell-Penn TPP-2M formula of Tanuma, Powell and Penn  

Gries G-1 formula of Gries  

Cumpson-Seah CS2 formula of Cumpson and Seah (attenuation length) 

Exponent 

Enter the exponent of the Exponential approach. 

Material 

Select the material class for the Jablonski, Seah-Dench and Gries methods when the same 

values are used for all experiments. It can be Element, Inorganic or Polymer. 

Density 

Set the density of the material in g/cm
3
 for the Seah-Dench and Gries methods when the same 

values are used for all experiments. 

Mean atomic weight 

Set the mean atomic weight of the material for the Seah-Dench method when the same values 

are used for all experiments. 
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Use separate values 

Select this check box if separate material class, density and mean atomic weight values are 

specified for each experiment in the IMFP & Contamination window for the Explicit, 

Jablonski, Seah-Dench or Gries methods. Apply this feature when the experiments were 

performed on different materials or the samples were changed during measurements or 

treatments. 

Calculate mean atomic weight 

Select this check box to calculate the mean atomic weight values automatically in a two-step 

iteration for the Seah-Dench method. 

Show… 

Displays the table of the actually applied IMFP values (or numbers proportional to IMFP), as 

illustrated in the next figure. 
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Angular Tab 

 

Method 

Select the applied angular correction method. 

None no angular correction 

Reilman method of Reilman  

Reilman-Ebel method of Reilman with correction for elastic scattering 

Excitation-analyser angle 

Set the angle between the excitation source and the axis of the analyser in degrees. 

Show… 

Displays the table of the actually applied angular correction values, according to Equation 

(11), as illustrated in the next figure. 
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Transmission Tab 

 

Type 

Select the type of the transmission function. 

None no transmission correction 

FAT, CAE fixed analyser transmission or constant analyser energy mode (E
-1

) 

FRR, CRR fixed retarding ratio or constant retarding ratio mode (E
1
) 

Exponential exponential function is applied with the selected exponent (E
a
) 

File various types of functions can be applied, which are described in 

separate file 

File type  

Displays the type of the transmission function defined in the current transmission file 

(Exponential, Polynomial, Rational, Combined or Tabulated). 

Exponent 

Set the exponent for the exponential type transmission function. 

Filename 

Set the name of the transmission function file. 

Browse… 

Invokes the Open dialog box to browse and select transmission function file. 

Edit… 

Opens the current transmission function file in the internal editor (similar to Notes window). 

To create a new transmission file or save the file with different name, use Notepad or other 

simple text editor program. 
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Show… 

Displays the table of the kinetic energy and the actually applied transmission correction 

values, according to Equations (30)-(34), as illustrated in the next figure. 

 

Chart… 

Displays the transmission function, as illustrated in the next figure. 
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Structure of the Transmission Files  

The analyser transmission files of XPS MultiQuant are simple ASCII files with .mtr 

extensions. They can be created and edited with Notepad or other simple text editor programs. 

Existing files can be modified with the internal editor of XPS MultiQuant. 

The first, header line of the file must be “XPS MultiQuant Transmission”. Comment lines, 

starting with number sign (#), can be inserted after the header. The first line after the 

comments defines the type of the applied function, which can be EXP, POLY, TAB, NPL or 

UNI. The first three types allow defining separate coefficient sets for different energy ranges. 

The number of coefficient sets must be between 1 and 40. A single set of coefficients is valid 

for the whole range for the last two types of functions. In the subsequent lines of the file, give 

the coefficients of the applied function, separated with commas or semicolons and optionally 

spaces. The decimal separator must be point; digit grouping is not allowed.  

Transmission files must be carefully checked for typing errors. Although the files are 

thoroughly tested by the program, some kinds of errors cannot be detected, leading to 

unexpected results; e.g., numbers are truncated at the accidentally entered non-numeric 

characters. 

The numbers in the following example transmission files are illustrations only. 

Exponential Function 

XPS MultiQuant Transmission

#

EXP

100,   1.0, 20, -0.60

800,   1.0, 10, -0.50

1500,  1.0,  7, -0.45

 

The exponential transmission function is marked by EXP in the file. Subsequent lines of the 

file contain the kinetic energy and the list of coefficients (here 1 and 3 items). Coefficient sets 

are applied in the kinetic energy range from the given starting energy (inclusive) and 

extending up to the starting energy of the next range. 

Polynomial Function 

XPS MultiQuant Transmission

#

POLY 3

100,  2.0, -0.001, 8.5e-04, 5.0e-07

800,  2.0, -0.001, 8.5e-04, 5.0e-07

1500, 5.0, -0.003, 9.5e-04, 4.0e-07

 

The polynomial transmission function is marked by POLY n, where n is the order of the 

polynomial, which may vary between 0 and 6. Subsequent lines of the file contain the kinetic 

energy and the list of coefficients (1 and n+1 items). Coefficient sets are applied in the kinetic 

energy range from the given starting energy (inclusive) up to the starting energy of the next 

range. 
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Tabulated function 

XPS MultiQuant Transmission

#

TAB

300,  35

600,  12

900,   5

1200,  4

 

The tabulated transmission function is marked by TAB. This function is simple enumeration 

of the transmission values for the different kinetic energy values (1 and 1 items). Between the 

given energy values, transmission is calculated by linear interpolation. 

At first glance, the zero order polynomial and the tabulated functions, having the same 

coefficients, seem to be identical. 
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However, in the first case, a constant transmission is used in each energy range (“step-like” 

function), while in the second case, transmission is calculated by linear interpolation within 

the ranges. The differences are illustrated in the figure above. 

Combined (UNIFIT) Function 

XPS MultiQuant Transmission

#

UNI

0, -1.0, 1.0, 1.0, 0.1, 1.0, 0.1

 

The combined polynomial-exponential type transmission function, introduced at the 

University of Leipzig [14], is marked by UNI in the file. The coefficients of this type of 

function (a0 – a4, b1, b2) of Equation (34) must be entered in one line (7 items). Parameters of 

this kind of function can be calculated from recorded spectra by the Unifit for Windows [14] 

program. This function is valid for the whole energy scale thus no energy ranges are presented 

in the file. 
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Rational (NPL) Function 

XPS MultiQuant Transmission

#

NPL

1.4, -23, 40, 50,  60

1,   -15, 19, 18, -21

 

The fourth order rational transmission function, developed at National Physical Laboratory, 

UK [13], is marked by NPL in the file. For this function, the two sets of coefficients for the 

numerator (a0 – a4) and denominator (1, b1 – b4) of Equation (33) must be entered in two lines 

(5 items in each). The b0 coefficient, which is always one, must also be enumerated. 

Coefficients of this type of function can be determined from experimental data by the NPL 

XPS Intensity Calibration System [13] software. This function is valid for the whole energy 

scale thus no energy ranges are presented in the file. 

Extrapolation 

The applicability of the transmission functions, where energy ranges are given (Exponential, 

Polynomial, Tabulated), is extended by extrapolation. In this case the coefficients of the 

previous or next energy range are used. The range of the valid extrapolation is the same as the 

next or previous energy range in the transmission file. 
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In the example above, energy ranges 3-6 are specified in the transmission file. In range 2, 

coefficients of range 3 are used. The width of range 2 is equal with range 3. The same is 

suitable for ranges 7 and 6. In ranges 1 and 8 transmission calculation are not allowed, 

because the energy distance is too large for the reliable extrapolation. 
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Contamination Tab 

 

Method 

Select the applied contamination correction method. 

None no contamination correction 

Evans static method of Evans 

Mohai dynamic method of Mohai. Intensity data for C1s line must be present.  

Explicit factors for contamination correction are entered into the 

IMFP & Contamination window 

Contamination factor 

Set the contamination factor for the Explicit method when the same values are used for all 

experiments. 

Use separate values 

Select this check box if separate contamination factor values are specified for each experiment 

in the IMFP & Contamination window for the Explicit method. 

Show… 

Displays the table of the actually applied contamination factors and correction values, 

according to Equations (36)-(38), as illustrated in the next figure. 
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If the automatic contamination correction method (Mohai) is selected, a C1s line with empty 

State column (i.e., the contaminant) must be present in the Element window. 

When the intensity values of the adventitious carbon of some experiments are zero, no 

contamination correction is applied for those experiments. If application of the correction is 

even necessary (e.g., for test purposes), enter a negligible carbon intensity. 

Model Tab 
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Model 

Select the required model for the sample. 

Homogeneous infinitely thick homogeneous sample, optionally with surface 

contamination 

Oxide-Layer planar samples with one overlayer, containing different 

chemical states of the same element 

Layers-on-Plane planar sample with known composition covered by 1 to 5 

overlayers 

Layers-on-Sphere spheres in closest packed or single row arrangement with 

known composition (e.g., coated powder pellets) covered by  

1 to 5 overlayers 

Layers-on-Cylinder cylinders with known composition (e.g., coated fibres) covered 

by 1 to 5 overlayers 

Layers-on-

Polyhedron 

rough surface modelled as planar facets of polyhedrons covered 

by 1 to 5 overlayers 

Layers-on-Nanotube randomly piled nanotubes covered by 1 to 5 overlayers 

Islands 

Select this check box if non-continuous overlayers (islands) are present on the sample. 

Single row of Spheres 

Select this check box if the relatively large spheres of the sample are laid in one row. 

Modified tube layer 

Select this check box if the layer on the nanotube was prepared by modification of the tube 

material (i.e., the Sphere or cylinder radius is the sum of the layer thickness and the 

unchanged radius of the tube). 

Multiline approach 

Select the applied multiline calculation method for the Homogeneous model. 

None no multiline calculation 

Average simple average of raw data for all lines of each element and 

chemical state 

Ebel weighted average of raw data for all lines of each element and 

chemical state 

Main composition calculated using only the most intensive line of 

each element and chemical state 

Sphere or cylinder radius 

When the radius of the sphere or cylinder is set to zero, it means that the radius of the curved 

surfaces is much larger (1000 times or more) than the layer thickness. In this case, the 

simplified formula, Equation (56), is used for calculations. In other cases, enter the actual 

radius in the same unit used for the layer thickness and IMFP. The outer radius of the 

nanotubes must always be specified. 
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Tube inner radius 

Enter the inner radius of the nanotubes. In case of nanofibres or nanowires (where is no hole), 

enter zero. 

Multilayers 

Set the number of repetition of the layer structures defined in the Model window. 

Fit coverage automatically 

When this check box is selected, the coverage of the Island type models is refined during the 

autofit procedure. 

Angle dependent experiment set 

When this check box is selected, all experiments, recorded at various take-off angles, are 

linked and the thickness of the layers calculated together. This feature is available for the 

Layers-on-Plain and Islands-on-Plain models. 

Edit… 

Invokes the Polyhedron Editor window. Available only when the Layers-on-Polyhedron 

model is selected. 

Labels Tab 

 

Select the check boxes of labels to be displayed. Select the measure from the dropdown lists 

for the numeric type labels. Enter the name of the user definable label sets into the textboxes. 

Preselect one of the labels as X-axis value of the charts (sequence number can be selected by 

this way only). Unselected label sets cannot be chosen as X-axis. All label values entered in 

the Intensity window are stored even after deselected in this tab. 

When the Layers-on-Plane or Islands-on-Plane model is applied, tilt angle (θ) values are 

taken from the Tilt label set. 
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If both the Time and Convert time to depth check boxes are selected, time data will be 

multiplied by the Sputter rate value and, instead of time, depth is displayed temporarily in the 

Composition and Chart windows. Numeric data are not converted automatically when a 

measure is changed. 

General Tab 

 

Title 

Identify the whole calculation set. If it is not entered here, it is asked before the data file is 

saved. Title can also be edited by double clicking the status bar. 

Excitation 

Select the excitation source (energy). It can be Mg Kα, Al Kα or Other. When the latter is 

selected user must specify the source energy. 

Energy 

Set the energy of the excitation source when the Excitation is set to Other 

Measurement unit 

Select the measurement unit of the inelastic mean free path, thickness values and sphere, 

cylinder or nanotube radius (Ångström or nanometer). 

Convert units 

Select this check box to convert the previously entered IMFP and thickness values when 

changing the measure unit (Å to nm or nm to Å). The converted items are: IMFP data of the 

Homogeneous model, IMFP matrix of the structured models, results of the structured model 

calculations, radius of the sphere, cylinder or nanotube, sputter rate, temporary depth scale. 

The permanent depth scale, stored in the Other numeric label set, however, is not converted 

automatically. To convert it, repeat the Tools / Create Depth Scale command. 
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Enable library lookup 

Unselect this check box to prevent the quantification data set from overwriting by an 

accidental library lookup. If lookup is not enabled, a warning message is displayed when the 

Tools / Library Lookup command issued. 

Show Parameter Summary 

Select this check box to show the Parameter Summary window. 

Parameter Summary 

 

The Parameter Summary window summarizes the selected values of the most important 

parameters. It is useful when calculation of various experiments requires different parameter 

settings. Displaying of the Parameter Summary window can be preselected by the Show 

Parameter Summary checkbox in the General tab of the Parameters window. Although the 

window can be discarded by its close button, it reappears when a data file is loaded or the File 

/ New command is performed. The window is not shown when the Data Wizard is active or 

an example file is loaded. 

Double click anywhere in the Parameter Summary window to locate it to the upper right 

corner of the main window. 

Parameters… 

Invokes the Parameters window. 

The additional information on the model (Multilayers, Multiline, Variant) is displayed only if 

it is applicable. However, to emphasize the wrong combination of parameters, when the 

Multiline approach is off but element(s) are present with multiple lines, still the None setting 

is shown with the number of elements involved. 

 



123 

Polyhedron Editor 

 

The parameters of the sample geometry model, describing the surface by small facets at 

different angles, can be created or modified in the Polyhedron Editor window. 

User can select each tilt angle (in steps of 10°) by moving the slider and enter the 

corresponding percentage ratio of its area, projected to the base plane of the sample 

supporting the polyhedra (i.e., the geometry correction factors). 

The chart shows all the geometry correction factors as the function of tilt angles. The figure 

on the left illustrates the direction of the incoming X-ray and the ejected electron beams and 

also the angular position of the surface facets at the selected tilt angle. The Area line 

represents the projected area of the current facet. 

Tilt angle 

Shows the tilt angle selected by the slider. 

Area 

Enter the percentage of the projected area corresponding to the surface elements with the 

selected tilt angle. Numbers can be set in the textbox by clicking the arrow buttons or typing. 

Clear 

Deletes all data of the polyhedron. To recover accidentally deleted data, click the Cancel 

button immediately. 
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Normalize 

Normalize the entered area data to 100 % sum. 

Cancel 

Discards the last changes, including clearing, and closes Polyhedron Editor window. 

OK 

Keeps the last changes, normalizes data and closes Polyhedron Editor window. 

Intensity Simulation 

 

The input data (layer thickness and coverage) of the intensity simulation calculations can be 

entered into the small table of the Intensity Simulation window. If the intensity data set is not 

empty (i.e., all zero), a warning message is shown before displaying the window. 

After closing the Intensity Simulation window, results of the calculations can be revoked in 

the Intensity and then in the Layer Thickness windows by the Undo command of the pop-up 

menu. 

Model 

Displays the name of the current quantification model. 

Experiment 

Select the sequence number of experiment where the results of the simulation (intensity 

values) are stored. The status of the current experiment can be Filled if at least one intensity 

value is not zero (either manually entered experimental or simulated); can be Empty, if all 

values are zero; or temporarily Calculated, to indicate that calculation with the current data 

just has been done. 



125 

Name 

Enter the name of the simulated experiment to store in the Name label set. If it were left 

blank, the word “Simulated” is inserted. The automatic labels can be edited and other labels 

can be added later in the Intensity window. 

Noise 

Set the level of relative noise of the simulated intensity data. A random number, within the 

interval of ± Noise / 100 · Intensity, is added to each calculated intensity. The value of Noise is 

not saved between sessions. 

Show homogeneous composition 

Temporarily shows the composition results calculated by the Homogeneous model for the 

currently simulated data. When the composition is being displayed, neither the simulation can 

be continued nor the Intensity Simulation widow can be closed. 

OK 

Closes the Intensity Simulation window. 

Calculate 

Calculates intensity values with the current thickness and coverage data and stores them in the 

selected experiment. 

Print 

 

Print What 

Select the items to be printed. When File name is selected, the name of the current data file is 

printed after the header. These settings are stored in the registry when the File / Save Defaults 

command performed. 
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Options… 

Invokes the Print Options window. 

Cancel 

Closes the window without printing. 

Eject Page 

Prints of the pending (the last unfinished) page. 

Print 

Prints the select the items. Only full pages are printed using the spooling feature of the 

operating system. Unfinished pages are printed only when the Eject Page button is pressed, 

the Pending page icon is double clicked in the status bar or the File / New or File / Exit 

command is issued. 

Print Options 

 

Printer 

Select one of the installed local or network printers. Default is the Windows‟ default printer. 

Page 

Set the orientation and margins of the page. The size of the paper can be set in the Control 

Panel of the Windows operating system. Margins can be varied from 0.5 to 5 cm. 

Font 

Select or set the name and size of the font for printing. In the Name list, all fonts of the 

selected printer are shown. The font size can be selected between 4 and 36 points. An 

example of how the font will look also appears (it may be improper when no matching screen 

font is installed). 
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Cancel 

Closes the window without changing options. 

OK 

Closes the window and accepts new options. 

Split Intensity 

  

Occasionally the chemical states of two components cannot be distinguished. Typical 

example is the carbonaceous contamination on the surface of hydrocarbon containing 

polymer. When additional information are available on the sample (e.g., ratio of other related 

elements or composition measured on similar system), the recorded total intensity may be 

split between the two states. Although adding and subtracting the same value in selected cells 

of the Intensity window can be performed manually; it is more convenient to make it by the 

Split Intensity window. Consequences of intensity split can be immediately followed in the 

Composition and visually in the Chart windows. 

After closing the Split Intensity window, results of the calculations can be revoked in the 

Intensity window by the Undo command of the pop-up menu. 

Experiment 

Select experiment. 

Step size 

Set the intensity step size value. To reset its default value (calculated according to intensity of 

all experiments), double click the step number. Clicking the small arrow buttons, the step size 

is divided or multiplied by 100. 

Elements 

Select the elements to split their intensity. Normally, intensity can be moved between 

different chemical states of the same element and line. To remove this restriction, double click 

Elements. Frame around Elements and the tooltip text notify the user about the switched-off 

limitation. 

Intensity 

Shows the actual intensity of the selected elements and experiment. The middle number 

shows the total value  moved in the indicated direction.  
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Reference 

Select the reference experiment (e.g., standard material or theoretical composition). If 

reference is not available, select None. 

Q sum 

Shows the sum of the squares of the differences of compositions of calculated and reference 

experiments (Equation 52). Similarly to layer calculation, try to minimize this value. The 

trend of the change of Qsum is also indicated. For the proper results, using of Atomic % 

composition type is recommended. When the adventitious carbon is involved in intensity 

splitting, omit it from the composition results. 

Arrow buttons 

Move the intensity value specified by Step size between the selected elements in the marked 

direction. The double arrows move ten times the value of Step size. 

Reset 

Restores the original intensity values of the current elements and experiment. 

Notes 

 

Enter comments and additional information connecting to the calculations to store together 

with the XPS MultiQuant data. This window is not restricted to the main window; it can be 

kept open and remarks can be written continuously during analysis of data. Editing functions 

are available via standard or pop-up menus (see chapter “File Menu (Notes window)”). A 

similar window is applied for editing the current transmission file. 
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Data Wizard 

  

The Data Wizard window helps the unfamiliar users walking through the different phases of 

setting up an XPS MultiQuant calculation by giving step-by-step instructions. 

Starting the wizard, user should select the type of calculation. To recall this very first step 

again, restart the wizard after a File / New command. 

The upper panel shows the title of the current step, while the lower panel provides a brief 

description of the action and also an error message, if necessary.  

Follow the instructions of the wizard, enter the required data then press the Next button. When 

an error is occurred, a warning signal is displayed and, beside the standard messages of the 

program, the wizard gives the short explanation of the problem. Press the Back button and 

revise the entered data. Consult the online help or the User‟s Manual for further clues. The 

Back and Next buttons are enabled only when the previous step was completed successfully 

(however, the wizard cannot prevent from all potential errors). 

When the Always on top check box is selected, the wizard‟s window is kept on the top of all 

other windows, including other applications. This window is not restricted to the main 

window of the program; it can be positioned anywhere on the screen. Double click anywhere 

in the Data Wizard window to locate it to the upper right corner of the main window. 

The wizard can be switched off at any time by the Tools / Data Wizard command or by its 

close button. 

Start wizard automatically 

Select this check box to start Data Wizard automatically when XPS MultiQuant is started. 

Always on top 

Select this check box to keep the wizard‟s window on the top of all other windows.  
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Open – Save As 

 

This is a standard Windows dialog box for opening and saving XPS MultiQuant data files, 

template files, transmission files or XPS Reduced Data Exchange files. The default file 

extension is .mqd, .mqt, .mtr and .mqx for the data, template, transmission and exchange files, 

respectively. Select or type the proper file name or navigate in the folders as usual in 

Windows. The common Windows pop-up menu (right click) is also available for file deleting, 

renaming, etc. Files on mapped network drives can be opened only with writing permission. 

This window may look different in the various versions of the operating system. 

Status Bar 

 

The status bar, located at the bottom of the main window, shows some important information 

of the program. It is divided into four panels. The panels show: 

 The title of the calculation. To change or edit the title, double click the panel or use the 

General tab of the Parameters window. 

 The name and the path of the current data file. If the path is long and the filename cannot 

be read, double click to alter the alignment of the text. 

 The presence of a pending (unfinished) page or a pending error condition. To print the 

pending page, double click the icon or press the Eject Page button in the Print window. 

To show the category of the error, point to the icon. The cell edit mode is also indicated. 

 The status of the NUMLOCK key. Double clicking this panel, the tooltip displays the 

decimal symbol and list separator set in the operating system. 
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Keyboard Commands 

Shortcut Keys 

CTRL + N Reset XPS MultiQuant and start new calculation 

CTRL + O Open an XPS MultiQuant data file 

CTRL + S Save current calculation 

CTRL + P Print the content of the active window 

CTRL + C Copy the content of the active window to the clipboard in ASCII form 

CTRL + L Search the library for element and line data 

ALT + F4 Exit program 

F1 Invoke What’s This Help 

F2 Display context sensitive help 

Editing Keys 

DELETE Delete the content of the current cell in a table 

BACKSPACE Delete the last character of the current cell or a textbox 

ARROW keys Move the current cell in a table or the text cursor in a textbox 

ENTER Move the current cell right or to the beginning of the next row in a table 

TAB Move the current cell right or to the beginning of the next row in a table 

PAGE UP Move the current cell up by one window 

PAGE DOWN Move the current cell down by one window 

HOME Move the current cell to the beginning of the row 

END Move the current cell to the end of the row 

Menu Access Keys 

Access keys allow the user to open a menu by pressing the ALT key and then type the 

underlined letter. Once the menu is open, the user can choose a control by pressing the letter 

(the access key) assigned to it. Underlines are visible only when the menu is opened by the 

ALT key. 
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Messages 

Bad file name. 

The specified filename is invalid. 

Change or edit title of calculation. 

Change or edit the title text. Title can also be edited on the General tab of the Parameters 

window. 

Clear all data from [title] window. Are you sure? 

Confirm deleting the whole content of an input table. Data can be recovered by an immediate 

Undo command invoked in the same window. 

Coverage must be between 0 and 1. 

The entered coverage value is less than zero or larger than one. Enter the correct value. 

Data file error(s): - Erroneous block header found. Data may be corrupted. 

The length of the data block, specified in the block header, is not matching that of expected by 

the data type and indexes. Check all data and enter missing items. 

Data file error(s): - File shorter than expected. Data may be corrupted. 

The end of the data file reached before all data blocks, expected by the program, is read or the 

end mark of the file is not found. Some data items may be missing. Check all data and enter 

missing items. 

Data file error(s): - Number of parameters fewer than expected. 

The number of parameter items in the data file is fewer than the program expects. Check 

parameters and enter missing items. 

Data file error(s): - Number of parameters larger than expected.  

The number of parameter items in the data file is larger than those the program expects. 

Excess parameters will be ignored. The file might be correct, although it can be invalid as 

well. Inspect all parameters. 

Data file error(s): - Unidentified data block found. 

A syntactically valid data block with unknown identifier was found in the file. The block will 

be ignored. All other data items are presumably correct. 

Data file error(s): - Unrecognized data found. Data may be corrupted. 

Unrecognizable, damaged block structure or excess data items were found in the data file. The 

invalid data is skipped, reading is continued from the next valid block. Some data items are 

almost certainly missing. Examine data for missing items. 

Data file not found. 

The specified data file cannot be found in the current folder. Use the browsing feature of the 

Open dialog box to locate the file. 
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Division by zero occurred at fitting of parameters (N). Check model and refine initial 

data. 

An attempt was made to divide a number by zero during the least square fitting of model 

parameters. It may be caused by wrong initial data or that the model is not properly describe 

the measured data. 

Division by zero occurred at model calculation (N). 

An attempt was made to divide a number by zero during calculation of intensity of structured 

models. 

Do you want to open existing workspace? 

The Save Workspace menu command is selected while the program detected a previously 

saved workspace. Select Yes to load the data file and to restore the layout of windows; or No 

to discard it. In the latter case, the workspace file will be overwritten at exit. Obviously, the 

data file, registered in the workspace, will not be disturbed. 

Do you want to save changed Notes text? 

The text in the Notes window has been changed. Select Yes to save changes, No to discard 

changes or Cancel to continue editing. To save notes permanently, save the current 

XPS MultiQuant data file. 

Do you want to save changed Transmission file? 

The text in the transmission file editor window has been changed. Select Yes to save changes, 

No to discard changes or Cancel to continue editing. 

Do you want to save your changes? 

The content of the calculation has been changed since the last save. Select Yes to save 

changes, No to discard changes or Cancel to continue work. 

Element error(s): - Invalid line notation at element [symbol]. 

The line notation at the indicated element is either non-existing (e.g., 3z) or the shell, subshell 

and doublet items are not matching (e.g., 3f, 2p5). 

Element error(s): - N element parameter(s) out of the expected range. 

Some of the element data is out of the expected range, e.g., density is greater than 22.5 or 

atomic mass is less than 1, etc. Despite the warning calculation is continued. 

Element error(s): - Photoelectron lines - chemical states mismatch at element [symbol]. 

When more than one photoelectron lines are used to calculate the concentration of the same 

element (Multiline approach) and the chemical states are also distinguished, each state must 

be present for each line. E.g., the S2p(6+), S2p(2-), S2s(6+), S2s(2-) set is valid, while the 

S2p(6+), S2p(2-), S2s(total) set is deficient. 

Element error(s): - Photoelectron line [symbol line] duplicated with identical chemical 

state at line N. 

The same element with the same photoelectron line can be present only in different chemical 

states. Delete one of the lines in the Element window or change one of the states. 
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Element [symbol] not found. 

The specified element cannot be found in the library. Check the element symbol for typing 

errors. 

Elements or experiments have been rearranged since the last Delete Rows command. 

Do you want undo anyway? 

The elements or experiments have been rearranged since the last Delete Rows command. 

Execution of the undo command can be forced but data may be inserted into wrong positions 

because the order of rows or cells is changed. Press Yes to force the undo command, No to 

discard the undo data of this editing step or Cancel to cancel undo but keep the data. 

Enter composition before calculating IMFP. 

The Tools / Model / Calculate IMFPs command was selected before entering the composition 

data into the atom location matrix. 

Error N  [error description] 

An unexpected fatal program error occurred. The program stops. Report the error number, the 

location (window), the command used and other circumstances to the author. 

Error in XPS Reduced Data Exchange file: [filename]. Loaded data may be incorrect. 

There are one or more errors in the loaded XPS Reduced Data Exchange file. Several other 

error messages may follow this message. Consult the manufacturer of the source application, 

which generated the file. Information and software tools to analyse the invalid file are 

available at the homepage of XPS MultiQuant. 

[Error description] occurred at fitting of parameters (N). Check model and refine initial 

data. 

Unexpected program error occurred during the least square fitting at step N. Fitting is 

abandoned. 

[Error description] occurred at model calculation (N). 

Unexpected program error occurred during the calculation of model intensity. 

Estimate initial layer thickness values before Autofit. 

Guess and enter initial values for layer thickness and coverage before invoking the Autofit 

procedure. The Qsum of the initial data should be 50 or less. 

File not found. 

The specified file cannot be found in the current folder. 

 “Gries” is applied as default IMFP calculation method. 

Default setting(s) can be altered in the Parameters window. 

When user selects the Start a new layer thickness calculation item in the first step of the 

wizard and no suitable inelastic mean free path calculation method is preselected, the program 

uses the Gries method as default. This can be changed in the IMFP tab of the Parameters 

window at any time. 

Illegal exchange file header. 

The header of the specified exchange file is not valid. The file should be damaged or the file 

is not an XPS Reduced Data Exchange file even the extension is .mqx. 
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Illegal or damaged library file header. 

The header of the library is not valid. The file should be damaged or the file is not the valid 

XPS MultiQuant library file. 

Improper IMFP method selected. 

The current IMFP correction method cannot be applied for the selected quantification model. 

Incompatible data file version. 

This version of data or template file is not supported. 

Incompatible library. Library version should be N. 

The version of the library is too old. Libraries of the different versions are not compatible. 

Use the library supplied with the program. 

Incorrect dataset. Intensity values of all active elements are zero. 

The experimental intensity values are zero for all active (i.e., assigned to any layer and not 

omitted) elements for the selected experiment. Check or enter the content of the Intensity 

window. 

Intensity data set is not empty. Do you want to overwrite? 

The Intensity Simulation window was invoked but some intensity data are larger than zero 

(either measured or simulated). Simulation may overwrite the selected experiment without 

further warnings. 

Invalid procedure call (e.g., square root of negative number) occurred at fitting of 

parameters (N). Check model and refine initial data. 

The argument of the function was out of the expected range (e.g., square root of a negative 

number). It may happen when the radius of the spheres or cylinders, given in the Model tab of 

the Parameters window, are not zero (i.e., structures are relatively small) and during the 

iterations of the least square fitting one of the layer thickness values became negative. This 

error may also indicate that the model does not describe properly the measured data. To solve 

the problem, set the radius to zero; try to fit parameters; reset the radius to its correct value 

and fit parameters again. 

Invalid procedure call (e.g., square root of negative number) occurred at model 

calculation (N). 

The argument of the function was out of the expected range (e.g., square root of a negative 

number). 

“Layers-on-Plane” is applied as default model. 

Default setting(s) can be altered in the Parameters window. 

When user selects the Start a new layer thickness calculation item in the first step of the 

wizard and no suitable model type is preselected, the program uses the Layers-on-Plane 

model as default. This can be changed in the Model tab of the Parameters window at any 

time. 

Layer thickness must be non-negative. 

Negative numbers cannot be entered as layer thickness values. 
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Library access error. 

Fatal software or hardware error occurred during library lookup. 

Library disabled. 

Library lookup is not allowed. Enable searching of the library in the General tab of the 

Parameters window. 

Library not found. File XMQ.LIB must be in the application‟s folder. 

The library file cannot be found in the application‟s folder. Move the library to the correct 

location or reinstall it from the distribution media. 

Line [symbol] not found. 

The selected photoelectron line of the specified element is not included in the selected cross 

section data set. Select other line from the list of the available lines, select other cross section 

set or try the splitting and scaling features. 

Maximum number of iterations reached. 

The allowable number of iterations has been met without obtaining a solution to the accuracy 

specified in the program. Very slow convergence may be indicated. Try to invoke Autofit 

again. 

Model error(s): - Angle values must be unique for angle dependent experiments. 

At calculating angle dependent experiment set, each experiment must be recorded at different 

angle; the difference must be at least 1°. Check Tilt labels for repeated angle values. 

Model error(s): - Bulk or layer element not marked. 

When the Oxide-Layer model is used, the chemical states of the main constituent element 

must be denoted by “Me” for the bulk and by “Ox” for the layer. 

Model error(s): - Geometry correction factors of the Layers-on-Polyhedron model not 

specified. 

The Layers-on-Polyhedron model is selected but the geometry correction factors are not 

specified. Invoke the Polyhedron Editor window from the Model tab of the Parameters 

window and edit geometry data. 

Model error(s): - Inner radius of the nanotube is too large. 

The inner radius of the nanotube is equal or greater than the outer radius. 

Model error(s): - Invalid angle values in the angle dependent experiment set. 

At calculating angle dependent experiment set, the angle values must be specified and should 

be between 0° and 90°. Check Tilt labels for missing or mistyped numbers. 

Model error(s): - Layer N not defined. 

Definition (name) of the N
th

 internal layer is missing.  There is an empty column between the 

defined layers. 

Model error(s): - Link error at Layer N: chains or cross-links. 

The target of a link cannot be a linked or fixed layer, neither directly nor indirectly. Chains 

(e.g., Layer 1→Layer 2→Layer 3) or cross links (e.g., Layer 1↔Layer 2) are not allowed. 

Inspect the Link to row in the Model window. 
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Model error(s): - Missing IMFP data. 

One or more IMFP data is missing from the Model window. Apply the Tools / Model / Mark 

Unused IMFPs command and fill all unmarked cells. 

Model error(s): - Model structure not defined. 

One of the structured model types is selected but no layer structure is defined in the Model 

window. Select the Homogeneous model or define the layer structure. This message can also 

be displayed alone. 

Model error(s): - No bulk defined. 

When structured models are used at least one layer and the bulk must be specified. The Name 

field must be filled in the Model window. 

Model error(s): - No independent parameter. 

All layer thickness and coverage parameters are fixed or linked. Check the Link to line in the 

Model window and the Model tab in the Parameters window. 

Model error(s): - Only one layer allowed for the Oxide-Layer model. 

When the simple Oxide-Layer model is used, only one overlayer on the bulk can be defined. 

If more layers are necessary, use the Layers-on-Plane model. 

Model error(s): - Radius of the nanotube must be specified. 

The external radius of the nanotubes cannot be omitted as in case of spheres or cylinders. 

Model error(s): - Some parameters out of the expected range. 

Some of the layer data is out of the expected range, e.g., molecular weight is less than 1 or 

density is greater than 22.5, etc. 

Model error(s): - The composition of bulk not specified. 

The stoichiometric coefficients of the bulk material in the atom location matrix of the Model 

window are not set or all are zero. Enter the missing values. 

Model error(s): - The composition of layer [name] not specified. 

The stoichiometric coefficients of the indicated layer in the atom location matrix of the Model 

window are not set or all are zero. Enter the missing values. 

Model error(s): - The same element and line must be selected in two different chemical 

states. 

When the Oxide-Layer model is used, the selected main constituent element and its 

photoelectron line must be the same for both the bulk and the layer. 

Model error(s): - The model system is defined but too many or necessary elements 

omitted. 

The described model is defined but neglecting the elements marked as „Omit‟ in the Model 

window, it became ill-defined. Remove the omit marks until the system becomes defined 

again. 
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Model error(s): - The model system is ill-defined. Specify at least N independent 

elements. 

The described model is ill-defined. The equation system cannot be solved. Each layer and the 

bulk must have at least one independent element. For automatic fitting of the coverage, one of 

the islands must have two independent elements. 

Model error(s): - The model system is ill-defined. Supply coverage data from 

independent measurements or specify one more element in the islands. 

None of the islands has at least two independent elements. Automatic fitting of the coverage 

is not possible unless one more element is specified in one of the islands. 

Model error(s): - Tilt label set must be selected for angle dependent experiments. 

At calculating angle dependent experiment set, angle values are taken from the Tilt label set 

which must be selected in this case. 

Nanotube warning(s): - Radius of the carbon nanotube seems to be too small. 

The absolute radius of the carbon nanotube is smaller than the minimal value specified in the 

literature. This message can also be listed in Model error(s). 

Nanotube warning(s): - Thickness of the carbon nanotube wall seems to be too small. 

The absolute wall thickness of the carbon nanotube is smaller than the minimal value 

specified in the literature. This message can also be listed in Model error(s). 

No element specified. 

Some features of the program cannot be accessed before the elements are specified. Enter all 

elements first. 

Notes text is too long. Remove at least N characters. 

The text in the Notes window is longer than the allowed maximum. The window cannot be 

closed or the data file cannot be saved unless some text is deleted.  

No transmission file specified. 

The transmission type was set to File in the Transmission tab of the Parameters window but 

no file name was given in the Filename box. 

Number of elements, experiments or label sets has been changed. Do you want undo 

anyway? 

The number of elements or experiments has been changed since the last cell or table editing 

command. The undo action may not be properly performed. Execution of the undo command 

can be forced but data may be inserted into wrong cells. Press Yes to force the undo 

command, No to discard the undo data of this editing step or Cancel to cancel undo but keep 

the data. 

Number of elements or experiments has been changed since the last Delete Rows 

command. Do you want undo anyway? 

The number of elements or experiments has been changed since the last Delete Rows 

command. Execution of the undo command can be forced but data may be inserted into wrong 

positions because the order of rows or cells is changed. Press Yes to force the undo command, 

No to discard the undo data of this editing step or Cancel to cancel undo but keep the data. 
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Numeric label set is not empty. Do you want to overwrite? 

The Tools / Create Depth Scale command was selected but the target label set stores 

previously entered data. Press OK to overwrite. 

Overflow during calculating intensity ratio. Layer N seems to be too thick. 

There is enormous difference between the intensity values of one of the calculated and the 

basic elements. It is usually caused by a large layer thickness or an extreme measured 

intensity value (possibly miswritten). The second sentence is displayed only when the 

thickness of the concerned layer is at least 25 times larger than the largest IMFP value. 

Overflow during calculation. Check input data. 

Overflow was occurred during calculations. One of the input data is larger than can be stored 

in the variables of the program (larger than 3.4·10
38

). Check the contents of the input 

windows. 

Overflow. Too large number in transmission file. 

One of the coefficients of the transmission function is larger than can be stored in the 

corresponding variable. Edit the transmission file. 

Overflow occurred at fitting of parameters (N). Check model and refine initial data. 

Overflow was occurred during least square fitting of the model parameters. It may be caused 

by wrong initial data or that the model is not properly describe the measured data. 

Overflow occurred at model calculation (N). 

Overflow was occurred during calculation of intensity of structured models. 

Parameter error(s): - Invalid transmission exponent. 

The exponent of the Exponential transmission correction method is too large. Calculating the 

transmission function with this value would cause overflow. 

Parameter error(s): - No transmission file specified. 

The transmission type was set to File in the Transmission tab of the Parameters window but 

no file name was given in the Filename box. Type the filename or use the Browse button. 

Parameter error(s): - The excitation - analyser angle is invalid. 

The Reilman type angular correction was selected but the analyser-excitation angle is not set, 

smaller than 0° or larger than 360°. Enter the proper angle value of the applied spectrometer 

and save it as default. 

Parameter error(s): - The excitation energy is invalid. 

The Other excitation source was selected but the excitation energy is not set, zero or negative. 

Set the proper energy of the applied source. 

Parameter error(s): - The IMFP exponent must be between 0 and 2 . 

The Exponential type IMFP correction method was selected but the value of the exponent is 

unrealistic. Set other value (usually between 0.5 and 0.9) or select another method. 

Path not found or incorrect. 

The path specified is either not existing or containing errors. This error may also occur when 

an existing read-only file is attempted to overwrite. 
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Printer error. 

The printer is not ready, out of paper or an error is occurred during printing or spooling. 

Refine layer thickness values until Q sum is less than 50. 

The Autofit button is pressed but the Qsum value of the current parameters is greater than 50. 

Try to select other basis element. Vary the layer thickness and coverage data until Qsum is less 

than 50 then invoke Autofit again. 

Results error(s): - Adventitious carbon not found. No contamination correction. 

Mohai’s contamination correction method is selected but no C1s line with empty State field 

was found. Select different method, add C1s line or clear the State field of the adventitious 

carbon. 

Results error(s): - Invalid transmission data. No transmission used. 

Some of the coefficients in the transmission file are too large to calculate the transmission 

function or some of the calculated factors are negative or zero. Edit the transmission file to fix 

the error. 

Results error(s): - Oxygen not found in experiment N. 

One of the oxide normalisation types is selected but oxygen was not found in the N
th

 

experiment (the oxygen intensity is zero or empty; there is no oxygen among the elements). 

Some index parameters are larger than expected. 

One or more index parameters (e.g., model type, IMFP method, etc.) is larger than the 

allowed maximum. The file may be a newer version or a damaged one. The wrong value is 

replaced by the permitted largest number. 

Some of the results are out of the expected range. Refine initial data or modify the 

model. 

Although the fittings of the parameters was successful mathematically, some of them has no 

physical meaning; e.g., negative layer thickness, layer thickness greater than five times of the 

largest IMFP value, coverage less than zero or greater than one. 

Some parameters of the IMFP calculation are missing or invalid. 

Some parameters of the inelastic mean free path calculations are out of the expected range, 

e.g., the material class or is not set or the density is zero or greater than 22.5, etc. The error is 

reported only if the parameter is necessary for the selected method (e.g., bandgap energy is 

required only for the Tanuma-Powell-Penn method). 

Sputter rate not set. 

The Tools / Create Depth Scale command was selected but the sputter rate on the Labels tab 

of the Parameters window is not set or zero. Enter sputter rate first. 

Subscript out of range occurred at fitting of parameters (N). Check model and refine 

initial data. 

A reference was made to a non-existing array element during the least square fitting of model 

parameters. Check model definition in the Model window and the Model tab of the 

Parameters window. 
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Subscript out of range occurred at model calculation (N). 

A reference was made to a non-existing array element during calculation of intensity of 

structured models. 

The [symbol] line cannot be excited by the selected source. Line energy changed to give 

positive kinetic energy. 

The binding energy of the selected line is higher than the energy of the excitation source. The 

specified energy of the line was changed to excitation energy minus one to give positive 

kinetic energy value. This line cannot be present in the spectra thus delete it in the Elements 

window. 

The cosine of the angle between the function values and the columns of the Jacobian 

matrix is at tolerance. 

The cosine of the angle between the solution vector and any column of the Jacobian matrix is 

at the tolerance specified in the program in absolute value. It means possible numerical 

convergence but the precision of calculation is limited or the convergence is very slow. 

The data file is set to read-only. 

Read-only files cannot be overwritten. Save the file with different name or remove the read-

only attribute and repeat the Save command. 

The excitation energy (N eV) is not plausible. Do you want to keep this value? 

Although the value of the excitation energy is not restricted, the current value is lower (Y Mδ, 

132.3 eV) or higher (Cr Kα, 5417.0 eV) than the energy of the regular sources applied in 

XPS. Press Yes if the energy is correct; or No to alter it. Once approved, this warning will not 

be displayed again, unless the excitation energy is changed. 

The intensity values of some related multiline elements are unrealistic. 

This very rare error occurs when the Ebel method of Multiline approach is selected and the 

intensity ratio of the associated elements is far from reality (e.g., the intensity of the line 

having higher cross section is too low). Check intensity values for typing errors. 

The solution is orthogonal to the columns of the Jacobian matrix to machine precision. 

The solution vector is orthogonal to the columns of the Jacobian matrix to machine precision. 

The task cannot be solved with the present initial data. 

The thickness of the modified layer is higher than the thickness of the nanotube wall. 

The Modified tube layer feature was selected, where the thickness of the modified layer 

cannot be larger than the original wall thickness (i.e., the wall is transformed to layer). Enter 

smaller value or unselect this feature. 

The tolerance limit is reached. No further improvement in the approximate solution is 

possible. 

The relative error between two consecutive iterates is at the tolerance limit specified in the 

program, i.e., there are no further changes in the approximate solution. 

The tolerance limit is reached. No further reduction in the sum of squares is possible. 

Both the actual and predicted relative reductions in the sum of squares reached the tolerance 

limit specified in the program. 



142 

The transmission file is not found in its specified location ([path]) but found in the [data 

file / application] folder. Do you want to keep the original invalid path? 

XPS MultiQuant stores the full path of the transmission file in the data files. If the 

transmission file is not found at the given location (e.g., it was moved or the path was 

renamed), the program attempts to find a file with similar name first in the folder of the 

current data file, next in the folder of the application (usually \Program Files\XMQ). Select 

Yes to keep the original improper path, stored in the data file, or No to store the new path. 

When the transmission file is found in either of the default locations, always verify whether 

its content appropriate for the present calculations. 

The window cannot be closed while “Show homogeneous composition” is selected. 

Unselect the Show homogeneous composition checkbox before closing the Intensity 

Simulation window. 

Time data not set. 

The Tools / Create Depth Scale command was selected but the Time labels are empty. Select 

Time labels and enter data in the Intensity window. 

Title must be entered. 

No title entered in the General tab of the Parameters window. Enter the title now. 

Too many elements omitted. 

The described model is defined but with the elements marked as „Omit‟ in the Model window, 

it became ill-defined. Remove the omit marks until the system becomes defined again. 

Transmission file not found. 

The specified transmission file cannot be found. Use the Browse button to locate the file 

manually. 

Transmission function error(s): - Excess lines found in the transmission file. 

After reading the maximum number of transmission coefficient sets, extra lines are detected 

in the transmission file. Although excess lines are ignored, check the validity of the file. E.g., 

in case of tabulated transmission function, if the energy step size is too small, the number of 

data points can easily go above the allowed maximum. 

Transmission function error(s): - Invalid transmission data for line [ ]. 

The calculated transmission factor of the line is negative or zero. Test and edit the 

transmission file to correct the error. 

Transmission function error(s): - Invalid type of transmission function. 

Non-existing type of function is specified in the transmission file. Edit the transmission file to 

correct the error. Valid types are EXP, POLY n, NPL, UNI and TAB.  

Transmission function error(s): - No valid transmission coefficients for line [ ]. 

The kinetic energy of the line is out of the energy ranges specified in the transmission file. 

The energy distance is too large for extrapolation. Extend the energy ranges in the 

transmission file. 
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Transmission function error(s): - The exponent of transmission function is too large. 

The exponent of the Exponential or Combined (Unifit) type transmission function is too large 

to calculate the transmission factors. The maximum value of the exponent is 12. 

Transmission function error(s): - The order of polynomial of transmission function is 

invalid. 

The order of the polynomial for the Polynomial type transmission function is too large to 

calculate the transmission factors. The maximum order is 6. 

Transmission function error(s): - Wrong number of coefficients of transmission 

function. 

The number of coefficients of transmission function is smaller or larger than required by the 

type of function. Edit the transmission file to correct the error. 

Transmission function warnings(s): - Transmission data extrapolated for line [ ]. 

The kinetic energy of the line is out of the energy range specified in the transmission file but 

close enough for the reliable extrapolation. Although it is a warning message only, it is 

advisable extend the transmission function to the required energy. 

Undo cannot be performed because destination cells are removed from the table. 

The destination cells of the undo command are no more existing in the Intensity window, due 

to removed elements. The undo command cannot be performed and the undo data of this 

editing step are lost. 
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Error Collections 

Some of the error and warning messages are organised into “error collections”. If two or more 

errors of the same collection occur, messages are displayed together, as illustrated in the next 

figure. 

 

The following collections are defined: 

 Data file errors 

 Element errors 

 Model errors 

 Nanotube warnings 

 Parameter errors 

 Results errors 

 Transmission function errors 

 Transmission function warnings 

Pending Errors 

 

If parameters of the elements or of the IMFP and transmission calculations are missing or 

invalid, an error message is shown and the erroneous data are replaced by default values. In 

this situation the calculated results are usually incorrect, therefore indicated by a small red 

page icon on the status bar (left hand side figure above). When a pending page (right hand 

side) is also waiting for printing, the icon represents both conditions (middle). Pointing to the 

icon, the tooltip shows the category of the error. 
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Release Notes 

7.83 Different coefficients for scaling Wargner‟s sensitivity factors for Mg Kα and Al Kα 

excitations. New library version (4.1). Limits for transmission file items were 

changed. Oxygen balance calculation was refined. Erroneously written equations 

were corrected in the manual. Values of index parameters, read from data files, are 

tested. User defined (Explicit) and None cross sections are distinguished. New data 

file version (3.10). Minor bugs were corrected. 

7.82 Undo is implemented for layer thickness and intensity split calculations. The Applied 

Corrections windows are sizable. Progress bar is displayed in the Layer Calculation 

window for long calculations. Testing of experiments at thickness calculations was 

improved. Several minor bugs were corrected. 

7.81 The Split Intensity window was introduced. Several minor error correction and 

improvement were done in the following areas: data and transmission files, Data 

Wizard, data displaying and editing, report printing. 

7.80 Improved data import facility: miscellaneous delimited texts can be pasted without 

any previous modification. Testing of input data was enhanced: even less disturbing 

error messages. The program‟s workspace can be saved and restored. Checking of 

obligatory elements for island type models was corrected. New data file version (3.0) 

with new, robust structure and new file error messages. Transmission files are 

identified by header line. The cell edit mode is indicated in the status bar. Several 

minor bugs were corrected. 

7.70 The Data Wizard was enhanced; parameters of the IMFP calculations are requested, 

if necessary. The pending error condition is displayed in the status bar. Selection of 

parameters of the Seah-Dench IMFP calculation method is modified (similar to Gries 

one). In numeric cells, either dot or comma typed, always the current decimal 

separator is entered. Double clicking the State column in the Element window 

changes the standard chemical states only for the Oxide-Layer model. Direction of 

cells can be transposed during pasting. Code was reorganised to prevent redundant 

error messages. Minor bugs were corrected. 

7.60 The Islands-on-Nanotube model variant was added. The Show homogeneous 

composition feature was added to Intensity Simulation. Icons were redesigned. 

Double clicking the Line cells in the Elements window, only items of the actually 

available transitions are rotated, instead of the most frequently used ones. Testing of 

Angle dependent experiment set was improved. New messages. Minor bugs were 

corrected. 
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7.51 Minor errors of the wizard and the nanotube simulation were corrected. None of 

them disturbed the calculated results.  

7.50 The following error was corrected: at extrapolating the tabulated transmission 

function, calculated values were invalid. New transmission error messages were 

added. The actual values of the terms of the sensitivity factors can be displayed. The 

energy scale the Elements window can be temporarily switched to kinetic energy. 

Selection of parameters of the Gries IMFP calculation method is modified. Cells in 

the input windows can be edited. Several minor bugs were corrected. 

7.41 The following error was corrected: when the number of (Elements × Experiments) 

exceeds the maximum number of elements at calculating Angle dependent 

experiment set, the “Subscript out of range” error occurred. Several minor bugs were 

corrected. 

7.40 The undo features for the cell, row and table editing commands were enhanced. The 

levels of undo were increased. The order of elements or experiments can be 

rearranged by drag and drop in the Elements and Intensity windows. Elements can be 

removed from chart. All omit and visible states can be reset to default. All data file 

versions supported again. 

7.30 The Data Wizard was enhanced, a new starting window was added. Noise can be 

added to the simulated intensity values. Positioning of the Data Wizard window was 

corrected. Selection error of the initial folder of the Open... command was corrected.  

7.22 The thickness of a linked layer is entered automatically in the Layer Calculation 

window. A very infrequent window refresh error, causing program crash, was 

corrected. New chapter (Tips and Tricks) in the User‟s Manual. 

7.21 The following errors were corrected: for elemental materials the IMFP calculations 

by the Gries method may have provided erroneous values due to wrong parameter 

selection. When clicking the folder icon in the address line of the Open dialog box in 

Windows 7, the program crashed. 

7.20 The Parameter Summary window was added. Older data files (versions 1.x) are no 

more supported. New data file version (2.31): the measurement unit is stored when 

the Homogeneous model selected. Minor bugs were corrected. New application 

example. New chapters (Carbonaceous Contamination, Parameter Summary) and 

figures in the User‟s Manual. 

7.10 New feature: when the intensity of the adventitious carbon of an experiment is zero, 

no contamination correction is applied. The following error was corrected: in spite of 

changing the IMFP method of the Homogeneous model, values may be calculated 

with the originally selected one. Minor bugs of the Model Layout window were 

corrected. An erroneous library item was corrected. 

7.00 The Layers-on-Nanotube model was added, including the Modified tube layer 

variant. The single row variant of the Layers-on-Sphere model was implemented. 

Intensity simulation was implemented. The Model Layout window was enhanced; 

drawing errors were corrected. Reorganised Parameters window. Results windows 
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were renamed. New data file version (2.3). Several new messages. Minor bugs were 

corrected. New chapters in the User‟s Manual (Intensity Simulation, Layers-on-

Nanotube Model). 

6.13 The following, rare errors were corrected: when an XPS Reduced Data Exchange file 

is opened and the default model type is not Homogeneous, an error occurred. When a 

modified example file is saved, always the Save As… command invoked. 

6.12 When the Composition (former Results) window is minimized and a new line is 

inserted into the Elements or Intensity window, the program crashed. Sizing errors of 

Chart and Transmission windows were corrected. 

6.11 The following, very infrequent error was corrected: when an XPS Reduced Data 

Exchange file contains unidentifiable element entries, the sum of the percentage 

composition may exceed the 100 %. 

6.10 The Open Example… command was added. The „magic‟ of example files was 

implemented. The omit state of elements can be changed in the Layer Calculation 

window. When a line cannot be found in the library, available lines are listed in the 

error message window. Redesigned Model Summary window. The Save As… 

command offers the user‟s document folder. 

6.00 New transmission file types were implemented (NPL, Unifit, Table, Poly 0). 

Improved IMFP calculation for the Homogeneous model (Gries method, extended 

Separate options). Displaying the calculated IMFP values of the Homogeneous 

model. Redesigned Layer Calculation window. New items in Parameters window. 

New data file version (2.2). The Data Wizard can be started automatically. Minor 

bugs were corrected. 

5.04 An error of loading results of structured models (may cause crash) is corrected. 

5.03 The annoying error of the Paste Table command (inserting non-printable characters 

into cells) was corrected. The SHIFT + Copy Table command was implemented. 

5.02 A window sizing error (causing crash) was corrected. 

5.01 The improper handling of file extensions of Template files and the error in Model 

Layout window when the polyhedral model is not defined, were corrected. Enhanced 

checking of equations at island type models using Angle dependent experiments. 

5.00 The Layers-on-Polyhedron model type was added. The Multiline approach for the 

homogeneous model was added. Reorganised Parameters and Notes windows. 

Internal editing of transmission files. The Template file type was introduced. 

Improved error checking of element data. Data entry accelerator in Element window. 

Rewritten, enhanced window handling and auto/manual resizing. Enhanced HTML-

based help system. Cell copy from Composition (former Results) window. New data 

file version (2.1). Several new messages. New application examples. Minor bugs 

were corrected. New chapters in the User‟s Manual (Template Files, Multiline 

Approach, Layers-on-Polyhedron Model, Polyhedron Editor Window). 
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4.10 Reading of XPS Reduced Data Exchange File version 1.1 was implemented. 

4.00 The Oxide-Layer model type was added. New AL calculation method was added 

(Cumpson-Seah) for the structured models. The input window calculator was added. 

IMFP and thickness measure conversion was added. Enhanced selection of Autofit 

initial parameters (fewer overflow error). Reading of XPS Reduced Data Exchange 

File (version 1.0) was implemented. Extended library (version 4.0) with more line 

entries; erroneous library items were corrected. New data file version (1.43). Minor 

bugs were corrected. New application examples. New chapters in the User‟s Manual 

(Calculator in the Input Windows, Oxide-Layer Model, Contact). 

3.00 Experiments recorded at various angles of emission can be calculated together (Angle 

dependent experiments set, „ARXPS‟). New IMFP calculation methods were added 

(Tanuma-Powell-Penn, Gries) for the structured models. New data file version 

(1.42). New library version (3.0). Minor bugs were corrected. New chapters in the 

User‟s Manual (Inelastic Mean Free Path, Step by Step). 

2.10 The Model Layout window was added. The content of the Chart window can be 

copied and printed directly. New normalisation types (Oxide mass %, Oxide mass 

ratio). Minor bugs were corrected. 

2.01 Parameters error caused by data files prior to version 1.20 was corrected. Layer 

forward link data handling bug was corrected.  

2.00 The least squares fitting of the model parameters (Autofit) feature was added. New 

model types (Islands-on-Sphere, Islands-on-Cylinder). Multilayer (repeated layer 

structures) feature. Enhanced data and model checking. Several new messages. New 

data file version (1.30). Reorganised Parameters window. Colours of the program 

components are controlled by the system colours set in the Control Panel of the 

operating system.  

1.20 The Data Wizard was added to help filling the tables. Drag and drop file open. The 

start bitmap and data file icons were merged into the application file. 

1.12 The development was migrated to Visual Basic 6.0. Minor printing and window 

handling errors were corrected. The items of the atom location matrix in the Model 

window can be real numbers instead of integers. New data file version (1.20). Title 

editing feature and new messages were added. 

1.11 Pop-up menu for editing cells in input windows was added. Few minor bugs were 

corrected (found by the author‟s four-year-old son). 

1.10 The Islands-on-Plane model was added. The intensity comparison graph was 

introduced to help layer thickness calculations. User selectable source energy. 

Improved help file and manual. New data file version (1.12). Several minor bugs 

were corrected. 

1.00 This was the first release of XPS MultiQuant. It was developed using Microsoft 

Visual Basic Version 4.0 Professional Edition. 
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Predecessors 

MultiQuant 

for DOS 

A quantification program written for DOS. It could calculate 33 experiments 

with 15 elements; the results could be displayed as atomic %, atomic ratio, 

oxide ratio or mass %. Two label sets (Name and Time) could be assigned to 

the experiments. Library with three cross section sets (Evans and Scofield 

Mg Kα and Al Kα) was also included. The program could apply a few 

structured models (Layers-on-Plane and Layers-on-Sphere) with maximum 

three layers as well but only with interactive (manual) parameter fitting. It had 

no graphic capabilities and help system was not available. 

LAYERS A DOS program to calculate the intensity and intensity ratio of electrons 

excited from planar or spherical samples covered with overlayers. Maximum 

three layers with 6 elements could be calculated. 

QUANT-140 This quantification program could handle a simplified homogeneous model. It 

was an overlay program system, consisting of five programs (QUANT-140, 

WEIGHT-140, EDIT-140, FACTOR-140, ENERGY-140), written for a Texas 

Instruments TI-59 pocket calculator with magnetic card reader and printer. 

One experiment with 14 elements could be calculated; results could be 

expressed as atomic % or atomic ratio. A real gem! 

 

Why do all the other subatomic 

particles hate the electrons —  

they are so negative. 
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Specifications 

Library Specifications 

Number of element entries 103 

Number of photoelectron line entries 1,068 

Number of cross section and sensitivity factor sets 5 

Number of cross section and sensitivity factor data items 2,475 

Number of asymmetry coefficient parameter sets 2 

Number of geometry correction factor sets 3 

Program Limitations 

Number of quantification models 14 

Number of concentration result types 8 

Maximum number of elements 20 

Maximum number of experiments 40 

Maximum number of layers 5 

Maximum of multilayer factor 5 

Maximum number of transmission file coefficient sets 20 

Maximum number of tabulated transmission file items 200 

Maximum order of transmission polynomial 6 

Maximum length of label text (characters) 15 

Maximum length of title text (characters) 80 

Maximum length of notes text (characters) 32,767 

Largest integer number allowed 32,767 

Largest real number allowed 3.4·10
38 

Basic Parameter Ranges 

Asymmetry parameter -1 – 2 

Atomic weight 1 – 260 

Bandgap energy (eV) > 0 – 10 

Cross section > 0 – 100 

Density (g·cm
-3

) > 0 – 22.59 

Inelastic mean free path (nm or Å) > 0 – 

Molecular weight 1 – 

Oxygen atoms 0 – 8 

Valence electrons 1 – 

Valence 0 – 8 
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